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1 Introduction

This Manual contains information on Network Analyzer remote control and its data
communication by means of user programs written with COM/DCOM technology.

COM technology is used when a user program runs together with an external
measurement instrument program on one PC. DCOM technology is used when a user
program runs on a PC connected with the measurement instrument by LAN.
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Methods and techniques for writing of user programs are same for the both
technologies. The only difference between the technologies is that the DCOM
technology requires additional LAN setting performed by the LAN administrator.

Before reading this Manual, familiarize yourself with Analyzer Operating Manual.

2  Scope of Manual

This Manual directly applies to the S8081 model Network Analyzer and to the software
module S8081.exe.

3  Registering COM Server

To register COM server of the analyzer run the executable module from command
prompt with the /regserver keyword. To unregister COM server of the analyzer run the
executable module from command prompt with the /unregserver keyword.
Administrative rights is required to register/unregister COM server. Also user has
ability to register COM server during the software installation procedure.

Example of the COM server registration command:

S8081.exe /regserver

4 COM Technology Overview

COM stands for Component Object Model. This programming technology was
developed by Microsoft for two purposes:

= the model provides the specification for interaction of binary
modules created in different programming languages;

= the model defines the interfacing between a client application and a
server application running either on the same PC or on two different
PCs. In the latter case, the technology has DCOM abbreviation —
Distributed COM.

5 Automation Server
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The network analyzer executable module contains a built-in COM server that enables
other programs to access its functionality. The COM server was developed in
conformity with the COM automation specification. COM automation is a technology
allowing control over the COM server by the programs written in both traditional
compiling programming languages and interpreting programming languages, such as
VBScript. This enables the server applications to make their functionality accessible to
many more clients.

6 Automation Controllers

Automation controllers are client programs, which use internal functionality of COM
servers. Automation controller programs are developed by users for writing their own
add-ons for the system.

User programs can be written in different languages:

= programming languages with built-in COM support, such as Visual
Basic®, Delphi, Java;

= universal programming languages, such as C, C++;

= Microsoft Excel and Word office applications as they include built-
in programming language Visual Basic for Applications®;

= program generators, such as National Instruments LabVIEW®,
MathWorks MATLAB®.

Examples used thru this Manual are written in Visual Basic (VB). Appendix 3 contains
examples written in VB, C++, and LabView languages.

Examples\COM\VBA folder contains source codes for examples written in Visual Basic
for Applications® (Microsoft Excel files).

Examples\COM\CPP folder contains source codes for the C++ language examples.

Examples\COM\LabView folder contains source codes for the LabView language
examples.

7 Local and Remote Server

The network analyzer executable module can function either as a local server or as a
remote server of COM automation.

Local server runs on the same PC with the automation controller and each of the
programs is executed as an individual application in a separate window. COM
technology is used in this case (Figure 1).
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Remote server and the automation controller run on different PCs connected by LAN.
DCOM (Distributed COM) technology is used in this case (Figure 2). When using
DCOM it is necessary to configure the local network by means of DCOM Windows
tools.

The same automation controller is used for the both COM and DCOM technology.
Some changes to the user program may be required in operators, which establish
connection with the server. Moreover, DCOM technology requires additional settings
of the LAN performed by the LAN administrator.
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8  Structure of COM Objects

COM server contains several objects, which provide different functionality of the
server. The COM objects of the network analyzer executable module are organized in a
hierarchical structure. Figure 3 shows the main COM objects, which comprise the first
three levels of the hierarchical structure of the COM server. COM objects provide
various methods and properties, which allow access to the server functions; besides,
they allow access to the objects of the lower levels, which are not shown in Figure 3.

Application
SCPI

[ CALCulate ][ DISPlay ] [ IEEE4882 ][ INITiate ]

MMEMory] SENSe ] [ STATus [ SOURce

[ SERVice ][ HCoPy ][ OUTPut ][ TRIGer ][ SYSTem ]

Figure 3. The structure of COM objects

The Object Application is in the top of the hierarchy of the COM server. Access to the
lower level objects is implemented via higher level objects.
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Note The hierarchy of COM objects and their names are taken from
the command system used for control over the Network
Analyzers via GPIB interface. GPIB communication protocol
complies with the IEE488.2 standard. In accordance with this
standard the SCPI programming language is used. Operators in
SCPI have hierarchical chain structure, for example:

CALCulate:PARameter:DEFine S11
The same command in COM written in VB programming
language is as follows:

app.SCPI.CALCulate.PARameter.DEFine = "S11"

9  Accessing the Application Object

To establish connection with the COM server application, create an object reference in
the client program. In COM programming the object reference needs to be acquired
preliminarily, to be used later to access the object functionality. To define an object in
Visual Basic perform the following:

1) Declare a variable as an object.
2) Assign the object to this variable.

To declare a variable, use Dim operator or other declaration statement (Public, Private
or Static). The variables used for references should of the types Variant, Object, or a
type of a specific object. For example, the following three operators declare app
variable:

Dim app
Dim app as Object
Dim app as S8081.Application

Use Set operator and CreateObject (ObjectName, HostName) function to assign a
specific object to a variable.

ObjectName Object name is always equal to “S8081.Applcation”

HostName Network name of the PC hosting the COM server. This parameter is not
specified in case of a local server.

For example, the following operators create Application object and assign it to app
variable:
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Set app = CreateObject("'S8081.Applcation™)
Set app = CreateObject("S8081.Applcation”, "Host_Name")
Set app = CreateObject(*S8081.Applcation”, "192.168.1.149")

Note The first form of the operator is used to create the reference to
the local COM server, the second and third forms are used to
create the reference to the remote DCOM server.

To allow access to the objects of a lower level of the hierarchy, these objects are
specified after the reference to the higher level object and separated from it by a dot.
For example:

Dim SystObj
Set SystObj = app.SCPI.SYSTem

COM obijects can have indices. For example, CALCulate, INITiate, SENSe, SOURce
objects represent various aspects of the 16 measurement channels of the Analyzer.
Therefore, it is necessary to write the channel index from 1 to 16 to acquire the data of
these objects. For example:

Set SensObj1 = app.SCPIL.SENSe(1)
Set SensObj2 = app.SCPI1.SENSe(2)

Visual Basic allows omitting of such indices; in this case the indices are considered as
equal to 1. For example, the following VB operators are equivalent:

Set SensObj = app.SCPI.SENSe(1)
Set SensObj = app.SCPI.SENSe

10  Object Methods

Objects have methods. Methods are actions that can be applied to objects. The object
methods are specified after the object name and separated from it by a dot.

The following example shows the PRESet method of SYSTem object. This method
performs setting of the Analyzer to the preset condition:

app.SCPI.SYSTem.PRESet
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11 Object Properties

Along with methods, objects have properties. Properties are object characteristics that
can be set or read out. The object properties are specified after the object name and
separated from it by a dot.

To modify an object characteristic, write the value of the corresponding property. To
define an object characteristic, read out the value of its property. The following
example show the setting of the POINts property of SWEep object, i.e. the number of
sweep points:

app.SCPI.SENSe.SWEp.POINts = 201

Note Some object properties cannot be written, and some object
properties cannot be read. In such cases, the properties are
indicated as “read only” or “write only”.

12 Error Handling

You can use different approaches to error handling in VB program:

= check the value of Err.Number variable after execution of VB
operator, which contains the call to the COM server object;

= use On Error goto VB operator.

These approaches are represented in the examples below. The following operator
causes an error in VB program as "S13" value of the DEFine property is incorrect.

app.SCPI.PARameter.DEFine = "S13"

In the first example, the value of the Err.Number variable is checked after execution of
the VB operator, which contains the call to the COM server object. On Error Resume
Next directive instructs VB not to interrupt the program execution when the error is
detected but to pass control to the next operator in natural order.
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Dim app

Public Sub HandleError1()

Set app = CreateObject("'S8081.Application")

On Error Resume Next

app.SCPI.PARameter.DEFine = "S13"

If Err.Number <> 0 Then
Msg = "Error # " & Str(Err.Number) & " was generated by " &
Err.Source & Chr(13) & Err.Description
MsgBox Msg,,"Error"

End If

End Sub

In the second example, On Error GoTo ErrHandler directive instructs VB to interrupt
the program execution when the error is detected and to pass control to ErrHandler
label.

Dim app

Public Sub HandleError2()

Set app = CreateObject(""S8081.Applcation™)
On Error GoTo ErrHandler
app.SCPI.PARameter.DEFine = "S13"

Exit Sub

ErrHandler:
Msg = "Error # " & Str(Err.Number) & " was generated by " &
Err.Source & Chr(13) & Err.Description
MsgBox Msg,,"Error"

End Sub

13 COM Automation Data Types

In COM automation, there are the following data types, which can be used for client-to-
server communication:

Long 32-bit signed integer, value range from —2147483648 to 2147483647
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Double

Boolean

String

Variant

64-bit  double-precision floating point, value range from
-1.79769313486232E308 to —4.94065645841247E-324 for negative
values, and from 4.94065645841247E-324 to 1.79769313486232E308
for positive values

16-bit integer, two values 0 — false, 1 — true

Variable-length string

Can be either a value of arbitrary type or an array of values of arbitrary
type. In this case, the term “arbitrary type” means any allowed type of
COM automation. A variable contains information about its type and
array size (if it is an array). It is used for communication of data arrays
between a client and a server.

14 Measurement Data Arrays

Measurement data can be either complex values or real values. This depends on the
format selected by the user. For example, the data is real in logarithmic magnitude
format and the data is complex in polar format.

The measurement data is transferred in a Variant type variable, which represents an
array of Double type. To transfer one complex measurement, two adjacent array cells
are used. To transfer one real measurement two adjacent array cells are used as well but
the second cell is always equal to 0. Thus, measurement data array size is a double
number of the measurement points.

Measurement 1

Measurement 2 Measurement N

Real Imag

Real Imag Real Imag

Measurement 1

Figure 4. Array of complex measurements

Measurement 2 Measurement N

Value 0

Value 0 Value 0
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Figure 5. Array of real measurements

15 COM Server Commands

NAME
Object Type Property (read only)
Data Type String
- Instrument information string. String format: manufacturer, model, serial
DeSCFIptIOh . . .
number, number of firmware version and number of software version.
Range up to 40 characters
Dim ID As String
Syntax
ID = app.NAME
Equivalent Softkeys None

READy

Object Type Property (read only)
Data Type Boolean

Ready state of the instrument. Reads out the True value after successful
Description completion of the boot process (about 10 sec). The analyzer must be connected

to PC by a USB cable.

Dim State as Boolean
Syntax

State = app.READy
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Equivalent Softkeys None
SCPI.ABORt
Object Type Method
Aborts the sweep and switches the triggers of all the channels to Hold. The
Description channels in Continuous trigger mode switch to waiting for a trigger. If the
trigger source is set to Internal, the channel from waiting for a trigger turns to a
new sweep.
Syntax app.SCP1.ABORt
Equivalent Softkeys Stimulus > Trigger > Restart

SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT (Pt).

USER.FILename

Object Type Property (read/write)
Data Type String
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-2 (see Table 2 on page 25)
Description De-embedding function file name (*.s2p). The file contains the circuit S—
parameters in Touchstone format.
Range up to 256 characters

Preset Value

Syntax

Dim File As String

File =

app.SCPI.CALCulate(Ch).FSIMulator.SENDed. DEEMbed.PORT(Pt).USER.FILename
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).USER.FILename =

"network.s2p"

Notes

If the full path to the file is not specified, the \FixtureSim subdirectory of the
main directory will be searched for the file.

Version 1.2 — Oct.

17,2013 20




Equivalent Softkeys

Analysis > Fixture Simulator > De-Embedding > User File

Table 1. Ch: Channel Number

Data Type Long

Description Channel number.

Range from1to 16

Out of Range An error occurs. Error code: 201.

Notes If the channel number is not specified, it is taken as equal to 1.

Table 2. Pt: Port Number

Data Type Long

Description Port number.

Range from1to 4

Out of Range An error occurs. Error code: 221.

Notes If the port number is not specified, it is taken as equal to 1.

SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe

Object Type

Property (read/write)

Data Type

Boolean

Port Pt of channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-2 (see Table 2 on page 25)
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Description

The ON/OFF state of the e-embedding s2p function of specified port.

Allowable Values

True: De-embedding function ON
False: De-embedding function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed. DEEMbed.PORT(Pt).STATe
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True

Equivalent Softkeys

Analysis > Fixture Simulator > De-Embedding > Port n
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SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.STATe

Object Type Property (read/write)
Data Type Boolean
Port Pt of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-2 (see Table 2 on page 25)
Description The ON/OFF state of the e-embedding s2p function.

Allowable Values

True: De-embedding function ON
False: De-embedding function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).FSIMulator. SENDed.DEEMbed.STATe
app.SCPI.CALCulate(Ch).FSIMulator. SENDed. DEEMbed.STATe = True

Equivalent Softkeys

Analysis > Fixture Simulator > De-Embedding > De-Embedding

SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit. PORT(Pt).

USER.FlLename

Object Type Property (read/write)
Data Type String

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt: port number 1-2 (see Table 2 on page 25)
- Embedding function file name (*.s2p). The file contains the circuit S—

Description .

parameters in Touchstone format.
Range up to 256 characters
Preset Value "
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Dim File As String
File =

Syntax app.SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit. PORT(Pt).USER.FILename
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit. PORT(Pt).USER.FlLename =
"network.s2p"
If the full path to the file is not specified, the \FixtureSim subdirectory of the
Notes

main directory will be searched for the file.

Equivalent Softkeys

Analysis > Fixture Simulator > Embedding > User File

SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit. PORT(Pt).STATe

Object Type Property (read/write)
Data Type Boolean
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-2 (see Table 2 on page 25)
Description The ON/OFF state of the embedding s2p function of specified port.

Allowable Values

True: Embedding function ON
False: Embedding function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True

Equivalent Softkeys

Analysis > Fixture Simulator > Embedding > Port n
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SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.STATe

Object Type Property (read/write)

Data Type Boolean

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-2 (see Table 2 on page 25)

Description The ON/OFF state of the embedding s2p function.

True: Embedding function ON
False: Embedding function OFF

Allowable Values

Preset Value False

Dim Status As Boolean
Syntax Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed. DEEMbed.PORT(Pt).STATe
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True

Equivalent Softkeys Analysis > Fixture Simulator > Embedding > Embedding

SCPI.CALCulate(Ch).FSIMulator.SENDed. ZCONversion.PORT(Pt).Z0.R

Object Type Property (read/write)

Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-2 (see Table 2 on page 25)

Description The value of the impedance for port impedance conversion function.
Range from 1le—6 to 1e6

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 50
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Unit Q (Ohm)

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R = 50

Equivalent Softkeys Analysis > Fixture Simulator > Port Z Conversion > Port n Z0

SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe

Object Type Property (read/write)
Data Type Boolean

Channel Ch,
Target

Ch:  channel number 1-16 (see Table 1 on page 25)

Description The ON/OFF state of the port impedance conversion function.

True: Port Z conversion function ON

Allowable Values . .
False: Port Z conversion function OFF

Preset Value False

Dim Status As Boolean
Syntax Status = app.SCPI1.CALCulate(Ch).FSIMulator. SENDed.ZCONversion.STATe
app.SCPI.CALCulate(Ch).FSIMulator. SENDed.ZCONversion.STATe = True

Equivalent Softkeys Analysis > Fixture Simulator > Port Z Conversion > Port Z Conversion
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SCPI.CALCulate(Ch).FSIMulator.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the fixture simulator function of specified channel.

Allowable Values

True: fixture simulator function ON
False: fixture simulator function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPIL.CALCulate(Ch).FSIMulator.STATe
app.SCPI.CALCulate(Ch).FSIMulator.STATe = True

Equivalent Softkeys

Analysis > Fixture Simulator > Fixture Simulator

SCPI.CALCulate(Ch).PARameter. COUNt

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The number of traces in the channel.
Range from1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value
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Syntax

Dim TraceNum As Long
TraceNum = app.SCPI.CALCulate(Ch).PARameter. COUNt
app.SCPI.CALCulate(Ch).PARameter. COUNt = 2

Equivalent Softkeys

Display > Num of Traces

SCPI.CALCulate(Ch).PARameter(Tr).DEFine

Object Type Property (read/write)
Data Type String
Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)
Description The measurement parameter of the trace.

Allowable Values

”Sll”, ”812", "813", "814",
"S21", "S22", "S23", "S24",
”831", ”832", IIS33II, IIS34II’

"S41", "S42", "S43", "S44" . S — parameter
“T1, T2, "T3", "T4" : Test receiver
"R1", "R2", "R3", "R4" : Reference receiver

Out of Range

An error occurs. Error code: 208.

Preset Value

Depends on the trace number.

Related Commands

SCPI.CALCulate(Ch).PARameter(Tr).SPORt

Syntax

Dim Meas As String
Meas = app.SCPI.CALCulate(Ch).PARameter(Tr).DEFine
app.SCPIL.CALCulate(Ch).PARameter(Tr).DEFine = "S11"

Equivalent Softkeys

Measurement > S-parameter > S11|S12 | ... S44
Measurement > Test Receiver > T1(1) | T1(2) | ... T4(4)

Measurement > Reference Receiver > R1(1) | R1(2) | ... R4(4)
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Table 3. Tr: Trace Number

Data Type Long
Description Trace number
Range from1to 16
Out of Range An error occurs. Error code: 202.
Notes If the trace number is not specified, it is taken as equal to 1.
SCPI.CALCulate(Ch).PARameter(Tr).SELect
Object Type Method
Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)
Description Sets the active channel and trace.
Syntax app.SCPI.CALCulate(Ch).PARameter(Tr).SELect

Notes

If the channel number is greater than the number of the channels displayed, an
error occurs and the command is ignored. If the trace number is greater than the
number of the traces displayed in the channel, an error occurs and the
command is ignored.

Equivalent Softkeys

Display > Active Trace/Channel > Active Channel
Display > Active Trace/Channel > Active Trace

SCPI.CALCulate(Ch).PARameter(Tr).SPORt

Object Type

Property (read/write)

Data Type

Long

Version 1.2 — Oct. 17, 2013 29




Trace Tr of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)

Description The number of the source port for absolute measurements.

Range from1lto 4

Out of Range An error occurs. Error code: 208.

Preset Value

Syntax

Dim StimPort As Long
StimPort = app.SCPI.CALCulate(Ch).PARameter(Tr).SPORt
app.SCPI1.CALCulate(Ch).PARameter(Tr).SPORt = 1

Equivalent Softkeys

Measurement > Test Receiver > T1(1) | T1(2) | ... T4(4)

Measurement > Reference Receiver > R1(1) | R1(2) | ... R4(4)

SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion

Object Type Property (read/write)

Data Type String

Target The active trace of channel Ch,

Ch: channel number 1-16 (see Table 1 on page 25)

Description The S—parameter conversion function type.
"ZREFlection" : Reflection equivalent impedance
"ZTRansmit" : Transmission equivalent impedance
"YREFlection" : Reflection equivalent admittance
"YTRansmit" : Transmission equivalent admittance

R .

ange "INVersion" . Inverse S—parameter

"ZTSHunt" : Shunt equivalent impedance
"YTSHunt" : Shunt equivalent admittance
"CONJugation" : S—parameter conjugate
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Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

An error occurs. Error code: 217.

Preset Value

"ZREF"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion
app.SCPIL.CALCulate(Ch).SELected.CONVersion.FUNCtion = "ZTR"

Equivalent Softkeys

Analysis > Conversion > Zr | Zt | Yr | Yt| 1/S| Z Trans-Shunt |
Y Trans-Shunt | Conjugation

SCPI.CALCulate(Ch).SELected.CONVersion.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the S-parameter conversion function.

Allowable Values

True: S—parameter conversion function ON
False: S—parameter conversion function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.CALCulate(Ch).SELected.CONVersion.STATe
app.SCPIL.CALCulate(Ch).SELected.CONVersion.STATe = true

Equivalent Softkeys

Analysis > Conversion > Conversion

SCPI.CALCulate(Ch).SELected. CORRection.EDELay. TIME

Object Type

Property (read/write)
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Data Type

Double

The active trace of channel Ch,

Target Ch: channel number 1-16 (see Table 1 on page 25)
Description The value of the electrical delay.
Range from-10to 10
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. CORRection.EDELay. TIME

app.SCPI.CALCulate(Ch).SELected. CORRection.EDELay.TIME = 1e-9

Equivalent Softkeys

Scale > Electrical Delay

SCPI.CALCulate(Ch).SELected. CORRection.OFFSet.PHASe

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The value of the phase offset.
Range from —360 to 360
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit ° (degree)
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Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. CORRection.OFFSet.PHASe
app.SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe = 360

Equivalent Softkeys Scale > Phase Offset

SCPI.CALCulate(Ch).SELected.DATA.FDATa

Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The formatted data array. The array elements contain measurements in the
current format, for example, in logarithmic magnitude format (Log Mag). Also,
see section “Measurement Data Arrays” on page 20.
The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Description ] .
Data(2n-2) real number in rectangular format, real part in polar and
Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar and Smith
chart formats.
The index of the array starts from 0.
Dim Data As Variant
Syntax
Data = app.SCPI.CALCulate(Ch).SELected. DATA.FDATa
Equivalent Softkeys None
SCPI.CALCulate(Ch).SELected. DATA.FMEMory
Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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The formatted memory array. The array elements contain saved measurements
in the current format, for example, in logarithmic magnitude format (Log Mag).
Also, see section “Measurement Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n—th point, where n from 1 to N:

Description
Data(2n-2) real number in rectangular format, real part in polar and
Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar and Smith
chart formats.
The index of the array starts from 0.
Dim Data As Variant
Syntax

Data = app.SCPI.CAL Culate(Ch).SELected. DATA.FMEMory

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.DATA.SDATa

Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The corrected data array. The corrected measurements are complex numbers.
Also, see section “Measurement Data Arrays” on page 20.
The array size is 2N, where N is the number of measurement points.
Description For the n-th point, where n from 1 to N:
Data(2n-2) the real part of corrected measurement;
Data(2n-1) the imaginary part of corrected measurement.
The index of the array starts from 0.
Dim Data As Variant
Syntax
Data = app.SCPI.CAL Culate(Ch).SELected. DATA.SDATa
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.DATA.SMEMory

Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The corrected memory array. The corrected measurements are complex
numbers. Also, see section “Measurement Data Arrays” on page 20.
The array size is 2N, where N is the number of measurement points.
Description For the n-th point, where n from 1 to N:
Data(2n-2) the real part of corrected measurement memory;
Data(2n-1) the imaginary part of corrected measurement memory.
The index of the array starts from 0.
Dim Data As Variant
Syntax
Data = app.SCPI.CALCulate(Ch).SELected. DATA.SMEMory
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.DATA.XAXis

Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The active trace X axis data array. The array size is N, where N is the number
of measurement points.
Description For the n—th point, where n from 0 to N-1:
Data(n) the X axis value;
The index of the array starts from 0.
Dim Data As Variant
Syntax

Data = app.SCPI.CALCulate(Ch).SELected. DATA. XAXis

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.FILTer. GATE.TIME.CENTer

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
Description The gate center value of the gating function.
Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)
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Syntax

Dim Value As Double
Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer
app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer = 1e-8

Equivalent Softkeys

Analysis > Gating > Center

SCPI.CALCulate(Ch).SELected.FILTer. GATE. TIME.SHAPe

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The gate shape of the gating function.

"MAXimum" : Maximum shape

"WIDE" . Wide shape
Range "NORMal" : Normal shape

"MINimum" : Minimum shape

Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

An error occurs. Error code: 218.

Preset Value

"NORM"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected.FILTer. GATE.TIME.SHAPe
app.SCPI.CALCulate(Ch).SELected.FILTer. GATE. TIME.SHAPe = "MAX"

Equivalent Softkeys

Analysis > Gating > Shape > Maximum | Wide | Normal | Minimum

SCPI.CALCulate(Ch).SELected.FILTer.GATE. TIME.SPAN
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Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The gate span value of the gating function.
Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 2e-8
Unit s (second)

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN = 1e-8

Equivalent Softkeys

Analysis > Gating > Span

SCPI.CALCulate(Ch).SELected.FILTer.GATE. TIME.STARt

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The gate start value of the gating function.
Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value ~le-8
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Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FILTer. GATE.TIME.STARt

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt = 1e—7

Equivalent Softkeys

Analysis > Gating > Start

SCPI.CALCulate(Ch).SELected.FILTer. GATE. TIME.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
’ Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the gating function.

Allowable Values

True: Gating function ON
False: Gating function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe
app.SCPI.CALCulate(Ch).SELected.FILTer. GATE.TIME.STATe = Status

Equivalent Softkeys

Analysis > Gating > Gating

SCPI.CALCulate(Ch).SELected.FILTer.GATE. TIME.STOP

Object Type

Property (read/write)

Data Type

Double
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The active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)
Description The gate stop value of the gating function.
Range Varies depending on the frequency span and the number of points.

Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value le-8
Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE. TIME.STOP = 1e-7

Equivalent Softkeys

Analysis > Gating > Stop

SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE

Object Type Property (read/write)
Data Type Stri ng
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The gate type of the gating function.
"BPASs" : Bandpass type
Range "NOTCh" : Notch type
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range An error occurs. Error code: 219.
Preset Value "BPAS"
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Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected.FILTer. GATE.TIME.TYPE
app.SCPI1.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE = "bpas"

Equivalent Softkeys

Analysis > Gating > Type

SCPI.CALCulate(Ch).SELected. FORMat

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Data format.
"MLOGarithmic" : Logarithmic magnitude
"PHASe" : Phase
"GDELay" : Group delay time
"SLINear" : Smith chart format (Lin)
"SLOGarithmic" : Smith chart format (Log)
"SCOMplex" : Smith chart format (Real/Imag)
"SMITh" : Smith chart format (R + jX)
Range "SADMittance" : Smith chart format (G + jB)
‘ "PLINear" : Polar format (Lin)
"PLOGarithmic" : Polar format (Log)
"POLar" : Polar format (Real/Imag)
"MLINear" : Linear magnitude
"SWR" : Voltage standing wave ratio
"REAL" : Real part
"IMAGinary" : Imaginary part
"UPHase" : Expanded phase
The short format of the parameter is indicated by upper case letters. There is no
N distinction between upper and lower case letters when the property is written.
otes . .. .
When the property is read out, the short format is indicated by upper case
letters.
Out of Range An error occurs. Error code: 209.
Preset Value "MLOG"
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Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. FORMat
app.SCPI.CALCulate(Ch).SELected.FORMat = "PHAS"

Equivalent Softkeys

Format > Log Mag | Phase | Group Delay | Lin Mag | SWR | Real | Imag | Phase > 180
Format > Smith > Log/Phase | Lin/Phase | Real/Imag | R+jX | G+jB

Format > Polar > Log/Phase | Ling/Phase | Real/Imag

SCPI.CALCulate(Ch).SELected.FUNCtion.DATA

Object Type

Property (read only)

Data Type

Variant (array of double)

Target

The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The data array of analysis executed by the
SCPI.CALCulate(Ch).SELected. FUNCtion.EXECute method.

The array size is 2N, where N is the number of points defined by the
SCPI.CALCulate(Ch).SELected. FUNCtion.POINts property.

For the n-th point, where n from 1 to N:
Data(2n-2) the response value in the n—th measurement point;

Data(2n-1) the stimulus value in the n—th measurement point. Always
set to O for the analysis of mean value, standard deviation,
and peak-to—peak value.

The index of the array starts from 0.

Syntax

Dim Data As Variant
Data = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DATA

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPIe

Object Type

Property (read/write)
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Data Type Boolean

All traces of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

The ON/OFF coupling state of the analysis range for the

Description .
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.

True: Coupling state ON
False: Coupling state OFF

Allowable Values

Preset Value True

Dim Status As Boolean
Syntax Status = app.SCPI1.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPIle
app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPIe = Status

Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt

Object Type Property (read/write)
Data Type Double
All traces of channel Ch (if the coupling is set to OFF by the
SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle property), the active trace
Target . .
of channel Ch (if otherwise),
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The start value of the analysis range set by the
SCPI.CALCulate(Ch).SELected. FUNCtion.EXECute method.
Range From the stimulus current start value to the stimulus current stop value.
Out of Range No limitation
Preset Value 0
Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt)
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Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt
app.SCPI1.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt = 1e9

Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe

Object Type Property (read/write)

Data Type Boolean

All traces of channel Ch (if the coupling is set to OFF by the
SCPI.CALCulate(Ch).SELected. FUNCtion.DOMain.COUPle property), the active trace

Target of channel Ch (if otherwise),
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the arbitrary range when executing the analysis by the

SCPI.CALCulate(Ch).SELected. FUNCtion.EXECute method.

True: Arbitrary range ON

llowable Val . .
Allowable Values False: Arbitrary range OFF (entire sweep range)

Preset Value False

Dim Status As Boolean
Syntax Status = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe
app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe = true

Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP

Object Type Property (read/write)

Data Type Double
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All traces of channel Ch (if the coupling is set to OFF by the
SCPI.CALCulate(Ch).SELected. FUNCtion.DOMain.COUPle property), the active trace

Target . -
e of channel Ch (if otherwise),
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The stop value of the analysis range set by the
SCPIL.CALCulate(Ch).SELected. FUNCtion.EXECute method.
Range From the stimulus current start value to the stimulus current stop value.
Out of Range No limitation
Preset Value 0

Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP

app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP = 2e9

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute

Object Type Method
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Executes the analysis specified with the

Description SCPI.CALCulate(Ch).SELected.FUNCtion. TYPE property.
The analysis result can then be read out with the
SCPI.CALCulate(Ch).SELected. FUNCtion.DATA property.

Syntax app.SCPI1.CALCulate(Ch).SELected.FUNCtion.EXECute

Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion

Object Type

Property (read/write)
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Data Type

Double

The active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

Description The lower limit for the peak excursion_ value when executing the peak search
by the SCPI.CALCulate(Ch).SELected. FUNCtion.EXECute method.

Range Varies depending on the trace format.

Out of Range No limitation

Preset Value 3

Unit dB (decibel) | ° (degree) | s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion

app.SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion = 1.5

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.FUNCtion.POINts

Object Type Property (read only)

Data Type Long

Target The active trace of channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
The number of points (data pairs) of the analysis result by the
SCPI.CALCulate(Ch).SELected. FUNCtion.EXECute method.

Description Always equal to 1, when the search is executed for the maximum, minimum,
mean, standard deviation, peak, and peak—to—peak values. The actual number
of points is read out, when the search is executed for all peaks or all targets.
Dim Value As Long

Syntax
Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.POINts

Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The polarity selection when performing the peak search by the
SCPIL.CALCulate(Ch).SELected. FUNCtion.EXECute method.
"POSitive" . Positive peaks
Range "NEGative" . Negative peaks
"BOTH" . Both positive peaks and negative peaks
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.
Preset Value "POS"
Dim Param As String
Syntax Param = app.SCPI.CALCulate(Ch).SELected. FUNCtion.PPOLarity
app.SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity = "NEG"
Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion. TARGet

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The target level when performing the search for the trace and the target level
crosspoints by the SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.
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Range Varies depending on the trace format.

Out of Range No limitation
Preset Value 0
Unit dB (decibel) | ° (degree) | s (second)

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion. TARGet
app.SCPI.CALCulate(Ch).SELected.FUNCtion. TARGet = —-10

Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion. TTRansition

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The transition type selection when performing the search for the trace and the
Description target level crosspoints by the SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute
method.
"POSitive" . Positive peaks
Range "NEGative" . Negative peaks
"BOTH" . Both positive peaks and negative peaks
The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
Notes . ...
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.
Preset Value "POS"
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Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition
app.SCPI.CALCulate(Ch).SELected.FUNCtion. TTRansition = "both"

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.FUNCtion. TYPE

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The selection of the type of analysis executed by the
SCPI.CALCulate(Ch).SELected. FUNCtion.EXECute method.
"PTPeak" . Peak-to—peak (difference between the maximum value and
the minimum value)
"STDEV" . Standard deviation
"MEAN" . Mean value
"MAXimum" : Maximum value
Range
"MINimum" : Minimum value
"PEAK" . Search for the peak
"APEak" . Search for all the peaks
"ATARget" . Search for all targets
The short format of the parameter is indicated by upper case letters. There is no
N distinction between upper and lower case letters when the property is written.
otes . .. .
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.

Preset Value

IIPTPII
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Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion. TYPE
app.SCPI.CALCulate(Ch).SELected. FUNCtion. TYPE = "STDEV"

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.LIMit.DATA

Object Type Property (read/write)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The data array, which is the limit line in the limit test function. The array size is
1+ 5N, where N is the number of measuring points.
For the n-th point, where n from 1 to N:
Data(0) The number of limit line segments N is from 0 to 100.
Setting O clears the limit line;
Data(5n—4) type of the n—th limit line segment;
o 0: OFF
Description
1: Upper limit
2: Lower limit
Data(5n-3) the stimulus value in the start point of the n—th segment;
Data(5n-2) the stimulus value in the end point of the n-th segment;
Data(5n-1) the response value in the start point of the n—th segment;
Data(5n-0) the response value in the end point of the n—th segment.
If the array size is not 1 + 5N, where N is Data(0), an error occurs (error code
214). If Data(5n — 4) is less than 0 or more than 2, an error occurs (error code
Notes 214). When Data(5n-3), Data(5n-2), Data(5n-1) and Data(5n-0) elements are
out of allowable range, the value is set to the limit, which is closer to the
specified value.
Dim Data As Variant
Syntax Data = app.SCPI.CALCulate(Ch).SELected.LIMit. DATA
app.SCPI.CALCulate(Ch).SELected.LIMit.DATA = Array(1,2,800,900,-10,-10)
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Equivalent Softkeys

Analysis > Limit Test > Edit Limit Line

SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the limit line display of the limit test function.

Allowable Values

True: Limit line display ON
False: Limit line display OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe
app.SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe = true

Equivalent Softkeys

Analysis > Limit Test > Limit Line

SCPI.CALCulate(Ch).SELected.LIMit.FAIL

Object Type Property (read only)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The limit test result.

Allowable Values

True: Fail
False: Pass
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Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.LIMit.FAIL

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.LIMit. OFFSet. AMPL.itude

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The value of the limit line offset along Y—axis.
Range Varies depending on the trace format.
Out of Range No limitation
Preset Value 0

Unit dB (decibel) | ° (degree) | s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet. AMPL.itude

app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet. AMPL.itude = -10

Equivalent Softkeys

Analysis > Limit Test > Limit Line Offsets > Response Offset

SCPI.CALCulate(Ch).SELected.LIMit. OFFSet. MARKer

Object Type

Method

Target

The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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Description

Sets the value of the limit line offset along Y-axis to the active marker value.

Syntax

app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet. MARKer

Equivalent Softkeys

Analysis > Limit Test > Limit Line Offsets > Marker > Response Ofs

SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The value of the limit line offset along X-axis.
Range From the stimulus current start value to the stimulus current stop value.
Out of Range No limitation
Preset Value 0

Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus

app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus = 1e6

Equivalent Softkeys

Analysis > Limit Test > Limit Lines Offsets > Stimulus Offset

SCPI.CALCulate(Ch).SELected.LIMit.REPort. ALL

Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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The data array, which is the limit test results. The array size is 4N, where N is
the number of measurement points.

For the n-th point, where n from 1 to N:
Data(4n-3) the stimulus value in the n—th point
Data(4n-2) the limit test result in the n—th point

Description -1 N(.) limit
0: Fail
1. Pass
Data(4n-1) the upper limit value in the n—th point (0 — if there is no
limit)
Data(4n-0) the lower limit value in the n—th point (0 — if there is no
limit)
Dim Data As Variant
Syntax
Data = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort. ALL
Equivalent Softkeys None
SCPI.CALCulate(Ch).SELected.LIMit.REPort.DATA
Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The data array, which is the stimulus values at all the measurement points that
Description failed the limit test. The array size is defined by the
SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts property.
Dim Data As Variant
Syntax

Data = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort. DATA

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts

Object Type

Property (read only)
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Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the measurement points that failed the limit test.
Description The array of stimulus values of the points can be read out by the
SCPI.CALCulate(Ch).SELected.LIMit.REPort. DATA property.
Dim Cnt As Long
Syntax

Cnt = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.LIMIit.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the limit test function.

Allowable Values

True: Limit test function ON
False: Limit test function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.CALCulate(Ch).SELected.LIMit.STATe
app.SCPI.CALCulate(Ch).SELected.LIMit.STATe = true

Equivalent Softkeys

Analysis > Limit Test > Limit Test

SCPI.CALCulate(Ch).SELected. MARKer(Mk).ACTivate
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Object Type

Method

Marker Mk of the active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

T
aroet Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)
Sets the active marker. If a marker is OFF this function will turn it ON.
Descriotion Turning ON a marker with the number from 1 to 15 will turn ON all the
P markers of smaller numbers. Turning ON the reference marker with number 16
does not turn ON the markers with the numbers from 1 to 15, but switches
these markers to the relative measurement mode.
Syntax app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).ACTivate

Equivalent Softkeys

Markers > Select > Marker n

Markers > Reference Marker

Table 4. Mk: Marker Number

Data Type Long
- Marker number. Numbers from 1 to 15 are for regular markers, number 16 is
Description
for the reference marker.
Range from1to 16
Out of Range An error occurs. Error code: 203.

Notes

If the marker number is not specified, it is taken as equal to 1.

SCPI.CALCulate(Ch).SELected. MARKer(MKk).BWIDth.DATA

Object Type

Property (read only)

Data Type

Variant (array of double)
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Target

Marker Mk of the active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)

Description

The bandwidth search result. The bandwidth search can be performed relatively
to the marker MK, or relatively to the absolute maximum value of the trace (in
this case the marker number is ignored), what is set by the
SCPI.CALCulate(Ch).SELected. MARKer(Mk).BWIDth.REFerence property.

The array contains 4 elements:
Data(0) Bandwidth;
Data(1) Center frequency;
Data(2) Q value;
Data(3) Loss.

Notes

If the bandwidth search is impossible, all the read out values are 0. If the search
is performed relatively to a maker, which is OFF, an error occurs (error code
204).

Syntax

Dim Data As Variant
Data = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).BWIDth.DATA

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected. MARKer.BWIDth.REFerence

Object Type Property (read/write)
Data Type Stri ng
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- The selection of the reference point for the bandwidth search function:

Description .

reference marker or absolute maximum value of the trace.

"MARKer" : Bandwidth search relative to the reference marker
Range "MAXimum" : Bandwidth search relative to the absolute maximum of the

trace
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Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

The value is ignored.

Preset Value

"MAX"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. MARKer.BWIDth.REFerence
app.SCPIL.CALCulate(Ch).SELected. MARKer.BWIDth.REFerence = "marker"

Equivalent Softkeys

Markers > Marker Math > Bandwidth Search > Search Ref To

SCPI.CALCulate(Ch).SELected. MARKer.BWIDth.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the bandwidth search function.

Allowable Values

True: Bandwidth search function ON
False: Bandwidth search function OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.CALCulate(Ch).SELected. MARKer.BWIDth.STATe
app.SCPIL.CALCulate(Ch).SELected. MARKer.BWIDth.STATe = true

Equivalent Softkeys

Markers > Marker Math > Bandwidth Search > Bandwidth Search

SCPI.CALCulate(Ch).SELected. MARKer.BWIDth. THReshold

Version 1.2 — Oct. 17, 2013 58




Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The bandwidth definition value.
Range Varies depending on the trace format.
Out of Range No limitation
Preset Value -3

Unit dB (decibel) | ° (degree) | s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).BWIDth. THReshold

app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).BWIDth.THReshold = —6.0

Equivalent Softkeys

Markers > Marker Math > Bandwidth Search > Bandwidth Value

SCPI.CALCulate(Ch).SELected. MARKer.BWIDth. TYPE

Object Type Property (read/write)
Data Type Stri ng
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The type of the bandwidth search function.
"BPASs" : Bandpass
Range "NOTCh" :Notch
The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
Notes . ..
When the property is read out, the short format is indicated by upper case
letters.
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Out of Range

The value is ignored.

Preset Value

"BPAS"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. MARKer.BWIDth. TYPE
app.SCPIL.CALCulate(Ch).SELected. MARKer.BWIDth.TYPE = "notc"

Equivalent Softkeys

Markers > Marker Math > Bandwidth Search > Type

SCPI.CALCulate(Ch).SELected. MARKer.COUPIe

Object Type Property (read/write)
Data Type Boolean
Target All traces of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the marker coupling function.

Allowable Values

True: Marker coupling ON
False: Marker coupling OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected. MARKer.COUPIle
app.SCPI1.CALCulate(Ch).SELected. MARKer.COUPIe = false

Equivalent Softkeys

Marker > Properties > Marker Couple
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SCPI.CALCulate(Ch).SELected. MARKer.COUNt

Object Type Property (read/write)
Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The number of the turned ON markers.
Range from0to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim MarkerCnt As Long
MarkerCnt = app.SCPI1.CALCulate(Ch).SELected. MARKer.COUNt
app.SCPI1.CALCulate(Ch).SELected. MARKer.COUNt = 5

Equivalent Softkeys

None
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SCPI.CALCulate(Ch).SELected. MARKer(MKk).Y

Object Type

Property (read only)

Data Type

Variant (array of double)

Target

Marker Mk of the active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)

Description

The response and stimulus value of the marker. If the reference marker is
turned ON, the values of the markers from 1 to 15 are read out as relative
values to the reference marker.

The array includes 3 elements:

Data(0) real number in rectangular format, real part in polar and
Smith chart formats;

Data(1) 0 in rectangular format, imaginary part in polar and Smith
chart formats.

Data(2) Stimulus value at the marker position.

Syntax

Dim Data As Variant
Data = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).DATA

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.COUPIle

Object Type Property (read/write)
Data Type Boolean
Target All traces of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the marker search range coupling for different traces.
True: Marker search range coupling ON
Alloviable Values False: Marker search range coupling OFF
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Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.COUPIle
app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.COUPIe = false

Equivalent Softkeys

Markers > Marker Search > Couple
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SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STARt

Object Type Property (read/write)
Data Type Double
All traces of channel Ch (if the marker search range coupling is set to OFF by
the  SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle property), the active
Target . .
trace of channel Ch (if otherwise),
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The start value of the marker search range.
Range From the stimulus current start value to the stimulus current stop value.
Out of Range No limitation
Preset Value 3eb
Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STARt

app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STARt = 1e6

Equivalent Softkeys

Markers > Marker Search > Search Start

SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STATe

Object Type Property (read/write)
Data Type Boolean
All traces of channel Ch (if the marker search range coupling is set to OFF by
the SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.COUPIe property), the
Target . . .
active trace of channel Ch (if otherwise),
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the arbitrary range when executing the marker search.
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Allowable Values

True: Marker search range ON
False: Marker search range OFF (entire sweep range)

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STATe
app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STATe = true

Equivalent Softkeys

Markers > Marker Search > Search Range

SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STOP

Object Type Property (read/write)
Data Type Double
All traces of channel Ch (if the marker search range coupling is set to OFF by
the SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.COUPIe property), the
Target . . .
active trace of channel Ch (if otherwise),
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The stop value of the marker search range.
Range From the stimulus current start value to the stimulus current stop value.
Out of Range No limitation
Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STOP

app.SCPI.CALCulate(Ch).SELected. MARKer.FUNCtion.DOMain.STOP = 1e6

Equivalent Softkeys

Markers > Marker Search > Search Stop

SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.EXECute
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Object Type

Method

Marker Mk of the active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

T
aroet Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)
Executes the marker search according to the specified criterion. The type of the
Description marker search is set by the
SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TYPE property.
Syntax app.SCPIL.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute

Equivalent Softkeys

Markers > Marker Search > Maximum | Minimum

Markers > Marker Search > Peak > Search Peak | Search Max Peak | Search Peak Left |
Search Peak Right

Markers > Marker Search > Target > Search Target | Search Target Left | Search Target
Right

SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PEXCursion

Object Type Property (read/write)

Data Type Double
Marker Mk of the active trace of channel Ch,

Tardet Ch:  channel number 1-16 (see Table 1 on page 25)

g Mk:  marker number 1-15, or reference marker number 16 (see Table

4 on page 78)

Description The peak excursion value, when the marker search for peak is performed by the
SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.EXECute method.

Range Varies depending on the trace format.

Out of Range No limitation

Preset Value 1

Unit

dB (decibel) | ° (degree) | s (second)
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Syntax

Dim Value As Double
Value = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PEXCursion
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PEXCursion = 3.0

Equivalent Softkeys

Markers > Marker Search > Peak > Peak Excursion

SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PPOLarity

Object Type

Property (read/write)

Data Type

String

Target

Marker Mk of the active trace of channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)

Description

The peak polarity selection, when the marker search for peak is performed by
the SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.EXECute method.

Range

"POSitive"  : Positive polarity
"NEGative" : Negative polarity
"BOTH" . Both positive polarity and negative polarity

Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

The value is ignored.

Preset Value

"POS"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PPOLarity
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PPOLarity = "neg"

Equivalent Softkeys

Markers > Marker Search > Peak > Peak Polarity > Positive | Negative | Both

SCPI.CALCulate(Ch).SELected. MARKer(MK).FUNCtion. TARGet
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Object Type Property (read/write)

Data Type Double
Marker Mk of the active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

g Mk:  marker number 1-15, or reference marker number 16 (see Table

4 on page 78)

Descriotion The target value, when the marker search for target is performed by the

P SCPIL.CALCulate(Ch).SELected. MARKer(MKk).FUNCtion.EXECute method.

Range Varies depending on the trace format.

Out of Range No limitation

Preset Value 0

Unit dB (decibel) | ° (degree) | s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.TARGet

app.SCPI1.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.TARGet = -10

Equivalent Softkeys

Markers > Marker Search > Target > Target Value

SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TRACking

Object Type Property (read/write)
Data Type Boolean
Marker Mk of the active trace of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)
Description The ON/OFF state of the marker search tracking function.

Allowable Values

True: Marker search tracking ON
False: Marker search tracking OFF

Preset Value

False
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Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TRACKking
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TRACKking = true

Equivalent Softkeys

Markers > Marker Search > Tracking

SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TTRansition

Object Type Property (read/write)

Data Type String
Marker Mk of the active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

g Mk:  marker number 1-15, or reference marker number 16 (see Table

4 on page 78)
The selection of the type of the target transition, when the marker search for

Description transition is performed by the
SCPI.CALCulate(Ch).SELected. MARKer(MK).FUNCtion.EXECute method.
"POSitive"  : Positive target transition

Range "NEGative" : Negative target transition
"BOTH" . Both positive target transition and negative target transition
The short format of the parameter is indicated by upper case letters. There is no

Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range The value is ignored.

Preset Value "POS"
Dim Param As String

Syntax Param = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.TTRansition
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.TTRansition = "neg"

Equivalent Softkeys Marker > Marker Search > Target > Target Transition
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SCPI.CAL Culate(Ch).SELected. MARKer(MK).FUNCtion. TYPE

Object Type Property (read/write)
Data Type String
Marker Mk of the active trace of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
g Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)
Descriotion The selection of the type of the marker search, which is performed by the
P SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.EXECute method.
"MAXimum" . Maximum value search
"MINimum" : Minimum value search
"PEAK" . Peak search
"LPEak" . Peak search to the left from the marker
Range "RPEak" . Peak search to the right from the marker
"TARGet" . Target search
"LTARget" . Target search to the left from the marker
"RTARget" . Target search to the right from the marker
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.

Preset Value

n MAX"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TYPE
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion. TYPE = "MIN"

Equivalent Softkeys

Markers > Marker Search > Maximum | Minimum

Markers > Marker Search > Peak > Search Peak | Search Max Peak | Search Peak Left |
Search Peak Right

Markers > Marker Search > Target > Search Target | Search Target Left| Search Target
Right

SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATNess.DATA
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Object Type

Property (read only)

Data Type

Variant (array of double)

Target

The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The FLATNESS function data array. The FLATNESS function is applied

within the range determined by two markers (see
SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATness.DOMain.STARt and

SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATness.DOMain.STOP properties).
The array includes 4 elements:

Data(0) Span;

Data(1) Gain;

Data(2) Slope;

Data(3) Flatness.

Syntax

Dim Data As Variant
Data = app.SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATness.DATA

Equivalent Softkeys

None
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SCPI.CALCulate(Ch).SELected. MARKer.MATH.FLATness.DOMain.STARt

Object Type Property (read/write)
Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Descriotion The number of the marker, which specifies the start frequency of the
P FLATNESS function range.
Range from1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim MkrNum As Long

MKkrNum =

app.SCPI.CALCulate(Ch).SELected. MARKer.MATH.FLATness.DOMain.STARt
app.SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATness.DOMain.STARt = 1

Equivalent Softkeys

Markers > Marker Math > Flatness > Flatness Start
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SCPI.CALCulate(Ch).SELected. MARKer.MATH.FLATness.DOMain.STOP

Object Type Property (read/write)
Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Descriotion The number of the marker, which specifies the stop frequency of the
P FLATNESS function range.
Range from1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim MkrNum As Long

MKkrNum =
app.SCPI1.CALCulate(Ch).SELected. MARKer. MATH.FLATness.DOMain.STOP
app.SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATNess.DOMain.STOP =1

Equivalent Softkeys

Markers > Marker Math > Flatness > Flatness Stop
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SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATNess.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the FLATNESS function.

Allowable Values

True: FLATNESS function ON
False: FLATNESS function OFF

Preset Value

False

Syntax

Dim Status As Boolean

Status =
app.SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATness.STATe
app.SCPI.CALCulate(Ch).SELected. MARKer. MATH.FLATNess.STATe = true

Equivalent Softkeys

Markers > Marker Math > Flatness > Flatness
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SCPI.CALCulate(Ch).SELected. MARKer.REFerence.STATe

Object Type Property (read/write)

Data Type Boolean

The active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

The ON/OFF state of the reference marker. When the reference marker is

Description .
P turned ON, all the values of the other markers turn to relative values.

True: Reference marker ON

Allowable Values
False: Reference marker OFF

Preset Value False

Dim Status As Boolean
Syntax Status = app.SCPI.CALCulate(Ch).SELected. MARKer.REFerence.STATe
app.SCPI.CALCulate(Ch).SELected. MARKer.REFerence.STATe = true

Equivalent Softkeys Markers > Reference Marker

SCPI.CALCulate(Ch).SELected. MARKer(Mk).SET

Object Type Property (write only)

Data Type String

Marker Mk of the active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Target Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)
Description The setting of the value of the specified item to the value of the position of the

marker.
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Range

"STARt" : Sweep start value set to the stimulus value of the marker position.
"STOP" : Sweep stop value set to the stimulus value of the marker position.

"CENTer" : Sweep center value set to the stimulus value of the marker
position.

"RLEVel" : Reference value set to the response value of the marker position.
"DELay" : Delay value set to the response value of the marker position.

Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

The value is ignored.

Syntax

app.SCPI.CAL Culate(Ch).SELected. MARKer(MK)._SET = "STOP"

Equivalent Softkeys

Markers > Marker Functions > Marker—>Start | Marker—>Stop |
Marker —>Center | Marker—>Ref Value | Marker—>Delay

SCPI.CALCulate(Ch).SELected. MARKer(Mk).STATe

Object Type Property (read/write)
Data Type Boolean
Marker Mk of the active trace of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Mk: marker number 1-15, or reference marker number 16 (see Table
4 on page 78)
The ON/OFF state of a marker. Turning ON a marker with the number from 1
to 15 will turn ON all the markers of smaller numbers. Turning OFF a marker
Description with the number from 1 to 15 will turn OFF all the markers of greater numbers

(except for the reference marker). Turning ON/OFF the reference marker with
number 16 does not turn ON/OFF the markers with the numbers from 1 to 15,
but switches these markers to the relative measurement mode.

Allowable Values

True: Marker ON
False: Marker OFF

Preset Value

False
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Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).STATe
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).STATe = true

Equivalent Softkeys

Markers > Add Marker | Remove Marker

Markers > Reference Marker

SCPI.CALCulate(Ch).SELected. MARKer(Mk).X

Object Type Property (read/write)

Data Type Double
Marker Mk of the active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

g Mk:  marker number 1-15, or reference marker number 16 (see Table

4 on page 78)

Description The stimulus value of the marker.

Range From the stimulus current start value to the stimulus current stop value.

Out of Value Sets the value of the limit, which is closer to the specified value.

Preset Value

Stimulus center value

Unit Hz (Hertz) | s (second) | dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).X

app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).X = 1e9

Equivalent Softkeys

Markers > Edit Stimulus

SCPI.CALCulate(Ch).SELected. MARKer(MKk).Y

Object Type

Property (read only)
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Data Type

Variant (array of double)

Target

Marker Mk of the active trace of channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Mk:  marker number 1-15, or reference marker number 16 (see Table
4 on page 78)

Description

The response value of the marker. If the reference marker is turned ON, the
values of the markers from 1 to 15 are read out as relative values to the
reference marker.

The array includes 2 elements:

Data(0) real number in rectangular format, real part in polar and
Smith chart formats;

Data(1) 0 in rectangular format, imaginary part in polar and Smith
chart formats.

Syntax

Dim Data As Variant
Data = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).Y

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected. MATH.FUNCtion

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The selection of the math operation between the measurement data and the
Description memory trace data. The math result replaces the data trace. If the data trace is
not saved, the command is ignored.
"DIVide" . Division Data/Mem.
"MULTiply" : Multiplication Datax Mem.
Range "IADD.I : Addition Data+ Mem.
"SUBTract" : Subtraction Data — Mem.
"NORMal" : No math
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Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

An error occurs. Error code 210.

Preset Value

"NORM"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. MATH.FUNCtion
app.SCPI.CALCulate(Ch).SELected. MATH.FUNCtion= "DIV"

Equivalent Softkeys

Display > Data Math > Data/Mem | Data*Mem | Data+Mem | Data—Mem | OFF

SCPI.CALCulate(Ch).SELected. MATH.MEMorize

Object Type Method
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- Saves the measurement data to the memory trace. Automatically turns on the
Description .
display of the memory trace.
Syntax app.SCPI.CALCulate(Ch).SELected. MATH.MEMorize
Equivalent Softkeys Display > Data—>Memory

SCPI.CALCulate(Ch).SELected.MSTatistics. DATA

Object Type Property (read only)
Data Type Variant (array of double)
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Version 1.2 — Oct. 17, 2013 79




The math statistics data array. The statistics function is applied either over the
whole range (for all the trace), or within the range specified by the
SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.STATe property (the range limits
are determined by two markers).

The array includes 3 elements:

Description
Data(0) Mean value;
Data(1) Standard deviation;
Data(2) Peak—to—peak (difference between the maximum value
and the minimum value).
Dim Data As Variant
Syntax

Data = app.SCPI.CALCulate(Ch).SELected.MSTatistics. DATA

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.MSTatistics. DOMain.MARKer.STARt

Object Type Property (read/write)
Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The number of the marker, which specifies the start frequency of the math
statistics range.
Range from 1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim MkrNum As Long
MkrNum = app.SCPI.CALCulate(Ch).SELected. MSTatistics. DOMain.MARKer.STARt
app.SCPI.CALCulate(Ch).SELected. MSTatistics. DOMain.MARKer.STARt = 3

Equivalent Softkeys

Markers > Marker Math > Statistics > Statistics Start
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SCPI.CALCulate(Ch).SELected.MSTatistics. DOMain.MARKer.STOP

Object Type Property (read/write)
Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The number of the marker, which specifies the stop frequency of the math
statistics range.
Range from 1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim MarkerNum As Long

MarkerNum =

app.SCPIL.CALCulate(Ch).SELected. MSTatistics.DOMain.MARKer.STOP
app.SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.MARKer.STOP =4

Equivalent Softkeys

Markers > Marker Math > Statistics > Statistics Stop

SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the math statistics range.

Allowable Values

True: Statistics range ON
False: Statistics range OFF

Preset Value

False
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Syntax

Dim Status As Boolean
Status = app.SCPI.CAL Culate(Ch).SELected. MSTatistics. DOMain.STATe
app.SCPI1.CALCulate(Ch).SELected. MSTatistics. DOMain.STATe = true

Equivalent Softkeys

Markers > Marker Math > Statistics > Statistics Range

SCPI.CALCulate(Ch).SELected.MSTatistics.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the math statistics display.

Allowable Values

True: Statistics display ON
False: Statistics display OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.MSTatistics.STATe
app.SCPI1.CALCulate(Ch).SELected.MSTatistics.STATe = true

Equivalent Softkeys

Markers > Marker Math > Statistics > Statistics

SCPI.CALCulate(Ch).SELected. RLIMit. DATA

Object Type Property (read/write)
Data Type Variant (array of double)

The active trace of channel Ch,
Target

Ch:  channel number 1-16 (see Table 1 on page 25)
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The data array, which is the limit line for the ripple limit function. The array
size is 1 + 4N, where N is the number of limit line segments.

For the n-th point, where n from 1 to N:

Data(0) the number of limit line segments N is the integer from 0
to 12. Setting O clears the limit line;
Data(4n-3) type of the n—th limit line segment;

Description

0: Off
1: On
Data(4n-2) the stimulus value in the beginning point of the n-th
segment;
Data(4n-2) the stimulus value in the end point of the n-th segment;
Data(4n-0) the ripple limit value of the n—th segment.
If the array size is not 1 + 4N, where N is Data(0), an error occurs (error code
214). If Data(4n — 3) is less than 0 or more than 1, an error occurs (error code
Notes 214). When Data(4n-2), Data(4n-1), and Data(4n-0) elements are out of
allowable range, the value is set to the limit, which is closer to the specified
value.

Dim Data As Variant
Syntax Data = app.SCPI.CALCulate(Ch).SELected.RLIMit.DATA
app.SCPI.CALCulate(Ch).SELected.RLIMIit.DATA = Array(1,1,800,900,10)

Equivalent Softkeys Analysis > Ripple Limit > Edit Ripple Limit

SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE

Object Type Property (read/write)

Data Type Boolean

The active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

Description The ON/OFF state of the ripple limit line display.

True: Ripple limit line ON
False: Ripple limit line OFF

Allowable Values

Preset Value False
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Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE
app.SCPI1.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE = true

Equivalent Softkeys

Analysis > Ripple Limit > Ripple Limit

SCPI.CALCulate(Ch).SELected.RLIMIit.DISPlay.SELect

Object Type Property (read/write)
Data Type Long
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The number of the ripple limit test band selected for the ripple value display.
Range from 1to 12
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim Value As Long
Value = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.SELect
app.SCPI1.CALCulate(Ch).SELected.RLIMit.DISPlay.SELect = 2

Equivalent Softkeys

Analysis > Ripple Limit > Ripple Value Band

SCPI.CALCulate(Ch).SELected.RLIMIit.DISPlay.VALue

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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Description The selection of the display type of the ripple value in the specified band.
"OFF" . Ripple value display OFF
"ABSolute” : Absolute value
Range
"MARgin" : Margin (difference between the ripple limit and the absolute
value)
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.

Preset Value

lloFFll

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.VALue
app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.VALue = "ABS"

Equivalent Softkeys

Analysis > Ripple Limit > Ripple Value

SCPI.CALCulate(Ch).SELected.RLIMit.FAIL

Object Type Property (read only)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Ripple limit test result.

Allowable Values

True: Fail
False: Pass

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.FAIL

Equivalent Softkeys

None
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SCPI.CALCulate(Ch).SELected.RLIMIit.REPort.DATA

Object Type

Property (read only)

Data Type

Variant (array of double)

Target

The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The data array, which is the ripple limit test results. The array size is 1+3N,
where N is the number of ripple limit bands.

For the n-th point, where n from 1 to N:
Data(0) N total number of the bands;
Data(3n-2) n number of the band;
Data(3n-1) Ripple value in the n-th band;

Data(3n-0) Ripple limit test result in the n—th band:
0: Pass
1: Fail

Syntax

Dim Data As Variant
Data = app.SCPI.CALCulate(Ch).SELected.RLIMit.REPort. DATA

Equivalent Softkeys

None

SCPI.CALCulate(Ch).SELected.RLIMIit.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the ripple limit test.

Allowable Values

True: Ripple limit test ON
False: Ripple limit test OFF

Preset Value

False
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Dim Status As Boolean
Syntax Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.STATe
app.SCPI.CALCulate(Ch).SELected.RLIMit.STATe = true

Equivalent Softkeys Analysis > Ripple Limit > Ripple Test

SCPI.CALCulate(Ch).SELected.SMOothing. APERture

Object Type Property (read/write)

Data Type Double

The active trace of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)
Description The smoothing aperture for the smoothing function.

Range from 0.01 to 20

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1

Unit %

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected.SMOothing. APERture
app.SCPI1.CALCulate(Ch).SELected.SMOothing. APERture = 1.5

Equivalent Softkeys Average > Smo Aperture

SCPI.CALCulate(Ch).SELected.SMOothing.STATe

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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Description

The ON/OFF state of the trace smoothing function.

Allowable Values

True: Trace smoothing ON
False: Trace smoothing OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.CALCulate(Ch).SELected.SMOothing.STATe
app.SCPIL.CALCulate(Ch).SELected.SMOothing.STATe = true

Equivalent Softkeys

Average > Smoothing

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.CENTer

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- Ehe time domain center value, when the time domain transformation function

Description .

is turned ON.
Range Varies depending on the specified frequency range and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.CENTer

app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.CENTer = 1e-8

Equivalent Softkeys

Analysis > Time Domain > Center
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SCPI.CALCulate(Ch).SELected. TRANsform. TIME.IMPulse. WIDTh

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The impulse width (time domain transformation resolution), coupled with the
Description Kaiser—Bessel window shape B parameter. The impulse width setting changes
the B parameter, and setting of B parameter changes the impulse width.
Range Varies depending on the specified frequency range and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value None
Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.IMPulse. WIDTh

app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.IMPulse. WIDTh = 1e-8

Equivalent Softkeys

Analysis > Time Domain > Window > Impulse Width (when the transformation type is set to
Bandpass or Lowpass Impulse)

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.KBESsel

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The B parameter, which controls the Kaiser—Bessel window shape, when
performing time domain transformation.
Range from 0 to 13
Out of Range Sets the value of the limit, which is closer to the specified value.
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Preset Value

Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.KBESsel

app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.KBESsel = 13

Equivalent Softkeys

Analysis > Time Domain > Window > Kaiser Beta

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.LPFRequency

Object Type Method
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Changes the frequency range to match with the lowpass type of the time
domain transformation function.
Syntax app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.LPFRequency
Equivalent Softkeys Analysis > Time Domain > Set Frequency Low Pass

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.SPAN

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- The time domain span value, when the time domain transformation function is
Description
turned ON.
Range Varies depending on the specified frequency range and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
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Preset Value

2e-8

Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.SPAN

app. SCPIL.CALCulate(Ch).SELected. TRANsform. TIME.SPAN = 1e-8

Equivalent Softkeys

Analysis > Time Domain > Span

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STARt

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- The start value used for the transformation function of the time domain

Description .

function.
Range Varies depending on the specified frequency range and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value -1e-8
Unit s (second)

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STARt

app.SCPIL.CALCulate(Ch).SELected. TRANsform. TIME.STARt = 1e-8

Equivalent Softkeys

Analysis > Time Domain > Start

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STATe

Object Type

Property (read/write)
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Data Type Boolean
Target The active trace of channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the time domain transformation function.

Allowable Values

True: Time domain transformation ON
False: Time domain transformation OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.CALCulate(Ch).SELected. TRANsform. TIME.STATe
app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STATe = true

Equivalent Softkeys

Analysis > Time Domain > Time Domain

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STEP.RTIMe

Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The rise time of the step signal (time domain transformation resolution),
Description coupled with the Kaiser—Bessel window shape 3 parameter. The impulse width
setting changes the  parameter, and setting of  parameter changes the impulse
width.
Range Varies depending on the specified frequency range and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value None
Unit s (second)
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Syntax

Dim Value As Double
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.IMPulse. WIDTh
app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.IMPulse.WIDTh = 1e-8

Equivalent Softkeys

Analysis > Time Domain > Window > Impulse Width (when the transformation type is set to
Lowpass Step)

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STIMulus

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The selection of the stimulus type for the time domain transformation function:
impulse or step.
"IMPulse" Impulse
Range "STEP" Step
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.

Preset Value

"IMP"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STIMulus
app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STIMulus = "STEP"

Equivalent Softkeys

Analysis > Time Domain > Type > Bandpass | Lowpass Step | Lowpass Impulse

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STOP
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Object Type Property (read/write)
Data Type Double
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- The time domain stop value, when the time domain transformation function is

Description

turned ON.
Range Varies depending on the specified frequency range and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value le-8
Unit s (second)

Dim Value As Double
Syntax Value = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.STOP

app.SCPI1.CALCulate(Ch).SELected. TRANsform. TIME.STOP = 2e-8

Equivalent Softkeys

Analysis > Time Domain > Stop

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.TYPE

Object Type Property (read/write)
Data Type String
Target The active trace of channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The selection of the transformation type for the time domain transformation
function: bandpass response or direct current circuit.
"BPASs" Bandpass
Range "LPASs" Lowpass
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Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

The value is ignored.

Preset Value

"BPASs"

Syntax

Dim Param As String
Param = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.TYPE
app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.TYPE = "STEP"

Equivalent Softkeys

Analysis > Time Domain > Type > Bandpass | Lowpass Step | Lowpass Impulse

SCPI.CALCulate(Ch). TRACe(Tr).DATA.FDATa

Object Type Property (read only)
Data Type Variant (array of double)
The specified trace Tr of channel Ch,
Target Tr: trace number 1-16 (see Table 3 on page 36)
Ch:  channel number 1-16 (see Table 1 on page 25)
The formatted data array. The array elements contain measurements in the
current format, for example, in logarithmic magnitude format (Log Mag). Also,
see section “Measurement Data Arrays” on page 20.
The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Description A .
Data(2n-2) real number in rectangular format, real part in polar and
Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar and Smith
chart formats.
The index of the array starts from 0.
Dim Data As Variant
Syntax

Data = app.SCPI.CALCulate(Ch).Trace(Tr).DATA.FDATa

Equivalent Softkeys

None
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.FMEMory

Object Type Property (read only)

Data Type Variant (array of double)

The specified trace Tr of channel Ch,
Target Tr:  trace number 1-16 (see Table 3 on page 36)
Ch:  channel number 1-16 (see Table 1 on page 25)

The formatted memory array. The array elements contain saved measurements
in the current format, for example, in logarithmic magnitude format (Log Mag).
Also, see section “Measurement Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Description i .
Data(2n-2) real number in rectangular format, real part in polar and
Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar and Smith
chart formats.
The index of the array starts from 0.
Dim Data As Variant
Syntax
Data = app.SCPI.CALCulate(Ch). Trace(Tr).DATA.FMEMory
Equivalent Softkeys None
SCPI.CALCulate(Ch). TRACe(Tr).DATA.SDATa
Object Type Property (read only)
Data Type Variant (array of double)

The specified trace Tr of channel Ch,
Target Tr: trace number 1-16 (see Table 3 on page 36)
Ch:  channel number 1-16 (see Table 1 on page 25)
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The corrected data array. The corrected measurements are complex numbers.
Also, see section “Measurement Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.

For the n-th point, where n from 1 to N:

Description
Data(2n-2) the real part of corrected measurement;
Data(2n-1) the imaginary part of corrected measurement.
The index of the array starts from 0.
Dim Data As Variant
Syntax

Data = app.SCPI.CALCulate(Ch). Trace(Tr).DATA.SDATa

Equivalent Softkeys

None

SCPI.CALCulate(Ch). TRACe(Tr).DATA.SMEMory

Object Type

Property (read only)

Data Type

Variant (array of double)

Target

The specified trace Tr of channel Ch,
Tr: trace number 1-16 (see Table 1 on page 32)
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The corrected memory array. The corrected measurements are complex
numbers. Also, see section “Measurement Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.

For the n-th point, where n from 1 to N:
Data(2n-2) the real part of corrected measurement memory;
Data(2n-1) the imaginary part of corrected measurement memory.

The index of the array starts from 0.

Syntax

Dim Data As Variant
Data = app.SCPIL.CALCulate(Ch). Trace(Tr).DATA.SMEMory

Equivalent Softkeys

None
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.XAXis

Object Type Property (read only)

Data Type Variant (array of double)

The specified trace Tr of channel Ch,
Target Tr:  trace number 1-16 (see Table 1 on page 32)
Ch:  channel number 1-16 (see Table 1 on page 25)

The specified trace X axis data array. The array size is N, where N is the
number of measurement points.

Description .
For the n-th point, where n from 0 to N-1:
Data(n) the X axis value;
Dim Data As Variant
Syntax
Data = app.SCPIL.CALCulate(Ch). Trace(Tr).DATA.XAXis
Equivalent Softkeys None
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SCPI.DISPlay.COLor.BACK

Object Type Property (read/write)
Data Type Variant (array of long)
Target Instrument
The background color for trace display.
The array contains 3 elements:
Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Range For all the array elements from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

0,0,0

Syntax

Dim Data As Variant
Data = app.SCPI.DISPlay.COLor.BACK
app.SCPI.DISPlay.COLor.BACK = Array(0, 0, 0)

Equivalent Softkeys

Display > Properties > Color > Background > Red | Green | Blue

SCPI.DISPlay.COLor.GRATiIcule

Object Type Property (read/write)
Data Type Variant (array of long)
Target Instrument
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The grid and the graticule label color for trace display.
The array contains 3 elements:

Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Range For all array elements from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Data(0) 160;
Data(1) 160;
Data(2) 164.

Syntax

Dim Data As Variant
Data = app.SCPI.DISPlay.COLor.GRATIcule
app.SCPI.DISPlay.COLor. GRATIcule = Array(128, 128, 128)

Equivalent Softkeys

Display > Properties > Color > Grid > Red | Green | Blue

SCPI.DISPlay.COLor.RESet

Object Type Method

Target Instrument

Description Restores the display settings to the default values.
Syntax app.SCPI.DISPlay.COLor.RESet

Equivalent Softkeys

Display > Properties > Set Defaults

SCPI.DISPlay.COLor.TRACe(Tr).DATA

Object Type

Property (read/write)
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Data Type Variant (array of long)

Trace number Tr in all channels,

Target Tr: trace number 1-16 (see Table 3 on page 36)
The data trace color.
The array contains 3 elements:
Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Range For all array elements from 0 to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Varies depending on the trace number.

Dim Data As Variant
Syntax Data = app.SCPIL.DISPlay.COLor. TRACe(Tr).DATA
app.SCPI.DISPlay.COLor. TRACe(Tr).DATA = Array(255, 255, 0)

Equivalent Softkeys Display > Properties > Color > Data Trace > Red | Green | Blue

SCPI.DISPlay.COLor. TRACe(Tr).MEMory

Object Type Property (read/write)
Data Type Variant (array of long)
Target Trace number Tr in all channels
Tr: trace number 1-16 (see Table 3 on page 36)
The memory trace color.
The array contains 3 elements:
Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Range For all array elements from 0 to 255.

Version 1.2 — Oct. 17, 2013

101




Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the trace number.

Syntax

Dim Data As Variant
Data = app.SCPI1.DISPlay.COLor. TRACe(Tr).MEMory
app.SCPI.DISPlay.COLor. TRACe(Tr). MEMory = Array(255, 255, 0)

Equivalent Softkeys

Display > Properties > Color > Data Trace > Red | Green | Blue

SCPI1.DISPlay.ENABIe

Object Type Property (read/write)

Data Type Boolean

Target Instrument

Description The ON/OFF state of the display update function.

Allowable Values

True: Display update ON
False: Display update OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay.ENABIe
app.SCPI.DISPlay.ENABIe = true

Equivalent Softkeys

Display > Update

SCPI.DISPlay.FSIGn

Object Type Property (read/write)
Data Type Boolean
Target Instrument
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Description

The ON/OFF state of the Fail sign display, when performing limit test or ripple
limit test.

Allowable Values

True: Fail sign display ON
False: Fail sign display OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay.FSIGn
app.SCPI.DISPlay.FSIGn = true

Equivalent Softkeys

Analysis > Limit Test > Fail Sign
Analysis > Ripple Limit > Fail Sign

SCPIL.DISPlay.IMAGe

Object Type Property (read/write)
Data Type String
Target Instrument
Description The inverted color display of the data traces.
"NORMal" : Normal display
R .
ange "INVert" . Inverted color display
The short format of the parameter is indicated by upper case letters. There is no
N distinction between upper and lower case letters when the property is written.
otes . .. .
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.

Preset Value

"NORM"

Syntax

Dim Param As String
Param = app.SCPI.DISPlay.IMAGe
app.SCPI.DISPlay.IMAGe = "INV"
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Planar 808/1

COM/DCOM Programming manual

Equivalent Softkeys

Display > Properties > Invert Color
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SCPIL.DISPlay.MAXimize

Object Type Property (read/write)

Data Type Boolean

Target The active channel window

Description The ON/OFF state of the maximization the active channel window.

Allowable Values

True: maximization ON
False: maximization OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay.MAXimize
app.SCPI.DISPlay.MAXimize = true

Equivalent Softkeys

Display > Active Trace/Channel > Maximize Channel

SCPI.DISPlay.SPLit

Object Type Property (read/write)
Data Type Long
Target Instrument

- The number and layout of the channel windows on the screen. The channel
Description . ..

window layout is in Table 5 below.

Range from 1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value
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Syntax

Dim Value As Long
Value = app.SCPI.DISPlay.SPL.it
app.SCPI.DISPlay.SPLit =2

Equivalent Softkeys

Display > Allocate channels

Table 5. Channel Window Layout on the Screen
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SCPI.DISPlay.UPDate.IMMediate

Object Type Method

Target Instrument

Description Updates the display once, when the display update is set to OFF
(SCPI.DISPlay.ENABIe property is set to False).

Syntax app.SCPI.DISPlay._UPDate.IMMediate

Equivalent Softkeys

None

SCPI1.DISPlay.WINDow(Ch).ACTivate

Object Type

Method

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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Description Sets the active channel.

Notes The channel window must be displayed. At attempt to set to the active channel
the channel, which is not displayed, an error occurs.

Syntax app.SCPI.DISPlay.WINDow(Ch).ACTivate

Equivalent Softkeys

Display > Active Trace / Channel > Active Channel

SCPIL.DISPlay.WINDow(Ch).ANNotation.MARKer. ALIGN.TYPE

Object Type Property (read/write)
Data Type String
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The alignment mode of the marker display position of each trace, when the
Description only active trace display feature is turned OFF
(SCP1.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe property is set to
False).
"VERTical" : Vertical alignment
Range "HORizontal" : Horizontal alignment
"NONE" : No alignment
The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
Notes . ...
When the property is read out, the short format is indicated by upper case
letters.
Out of Range The value is ignored.
Preset Value "NONE"
Dim Param As String
Syntax Param = app.SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGn.TYPE
app.SCPI1.DISPlay.WINDow(Ch).ANNotation. MARKer.ALIGn. TYPE = "VERT"
Equivalent Softkeys Markers > Properties > Align > Vertical | Horizontal | OFF
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SCPIL.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the marker display for the active trace only.

Allowable Values

True: Only active trace markers display ON
False: Only active trace markers display OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI SCPI.DISPlay. WINDow(Ch).ANNotation.MARKer.SINGle.STATe
app.SCPI1 SCPI1.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe = true

Equivalent Softkeys

Markers > Properties > Active Only
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SCPI.DISPlay.WINDow(Ch).MAXimize

Object Type Property (read/write)
Data Type Boolean
Target The active trace of channel Ch,
Ch: channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the maximization the active trace

Allowable Values

True: maximization ON
False: maximization OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay. WINDow(Ch).MAXimize
app.SCPI1.DISPlay.WINDow(Ch).MAXimize = true

Equivalent Softkeys

Display > Active Trace/Channel > Maximize Trace

SCPI.DISPlay.WINDow(Ch).SPLit

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
- The code of the graph layout of channels. The channel window layout is in

Description

Table 5 on page 148.
Range from 1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value
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Notes

This property does not define the number of traces in the channel window, the
number of traces is defined by the SCPI1.CALCulate(Ch).PARameter. COUNt property.

Syntax

Dim Value As Long
Value = app.SCPI.DISPlay.WINDow(Ch).SPL.it
app.SCPI.DISPlay.WINDow(Ch).SPLit = 2

Equivalent Softkeys

Display > Allocate Traces

SCPI1.DISPlay.WINDow(Ch). TITLe.DATA

Object Type Property (read/write)
Data Type String
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The channel title label.
Range up to 254 characters

Preset Value

Syntax

Dim Text As String
Text =app.SCPI.DISPlay.WINDow(Ch).TITLe.DATA
app.SCPI.DISPlay.WINDow(Ch).TITLe.DATA = "Examplel"

Equivalent Softkeys

Display > Edit Title Label

SCPI.DISPlay.WINDow(Ch).TITLe.STATe

Object Type Property (read/write)
Data Type Boolean

Channel Ch,
Target

Ch:  channel number 1-16 (see Table 1 on page 25)
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Description

The ON/OFF state of the title label display.

Allowable Values

True: Title label display ON
False: Title label display OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay. WINDow(Ch).TITLe.STATe
app.SCPIL.DISPlay.WINDow(Ch).TITLe.STATe = true

Equivalent Softkeys

Display > Title Label

SCPI.DISPlay.WINDow(Ch). TRACe(Tr).ANNotation.MARKer.POSition.X

Object Type Property (read/write)
Data Type Double

Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Tr: trace number 1-16 (see Table 3 on page 36)
- The display position of the marker value on the X-axis by a percentage of the

Description . .

display width.
Range from 0 to 100
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit %

Dim Value As Double
Syntax Value = app.SCPI.DISPlay. WINDow(Ch). TRACe(Tr).ANNotation.MARKer.POSition.X

app.SCPI1.DISPlay.WINDow(Ch). TRACe(Tr).ANNotation.MARKer.POSition.X = 50

Equivalent Softkeys

Markers > Properties > Data X Position
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SCPI.DISPlay.WINDow(Ch). TRACe(Tr).ANNotation.MARKer.POSition.Y

Object Type Property (read/write)

Data Type Double

Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)

The display position of the marker value on the Y-axis by a percentage of the

Description display height.

Range from 0 to 100

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0

Unit %

Dim Value As Double
Syntax Value = app.SCPI.DISPlay. WINDow(Ch). TRACe(Tr).ANNotation. MARKer.POSition.Y
app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).ANNotation.MARKer.POSition.Y =50

Equivalent Softkeys Markers > Properties > Data Y Position

SCPI.DISPlay.WINDow(Ch). TRACe(Tr).MEMory. STATe

Object Type Property (read/write)

Data Type Boolean

Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)

Description The ON/OFF state of the memory trace display.

True: Memory trace display ON
False: Memory trace display OFF

Allowable Values
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Preset Value

False

Notes

If the memory is empty, an error occurs and the object is ignored.

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).MEMory.STATe
app.SCPIL.DISPlay.WINDow(Ch). TRACe(Tr).MEMory.STATe = true

Equivalent Softkeys

Display > Display > Memory | Data & Memory (ON)
Display > Display > Data | OFF (OFF)

SCPI1.DISPlay.WINDow(Ch). TRACe(Tr).STATe

Object Type Property (read/write)
Data Type Boolean
Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)
Description The ON/OFF state of the data trace display.

Allowable Values

True: Data trace display ON
False: Data trace display OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).STATe
app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).STATe = false

Equivalent Softkeys

Display > Display > Data | Data & Memory (ON)
Display > Display > Memory | OFF (OFF)

SCPI.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe. AUTO

Object Type

Method
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Trace Tr of channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)

Description Executes the auto scale function for the trace.

Syntax app.SCPI.DISPlay. WINDow(Ch). TRACe(Tr).Y.SCALe.AUTO

Equivalent Softkeys

Scale > Auto Scale

SCPIL.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.PDIVision

Object Type Property (read/write)
Data Type Double
Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)
The trace scale. Sets the scale per division, when the data format is the
Description rectangular format. Sets the full scale value, when the data format is the Smith
chart format or the polar format.
Range from 10E-18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the format.
Logarithmic Magnitude: 10 dB/Div
Phase: 40 °/Div

Expand Phase: 100 °/Div

Group Delay: 10e-9 s/Div

Smith Chart, Polar, SWR: 1 /Div
Linear Magnitude: 0.1 /Div

Real part, Imaginary part: 0.2 /Div

dB/Div (decibel per division), °/Div (degree per division), s/Div (second per

Unit o
" division)
Dim Value As Double
Syntax Value = app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.PDIVision

app.SCPIL.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.PDIVision = 20

Version 1.2 — Oct.

17,2013 114




Equivalent Softkeys Scale > Scale

SCPI1.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.RLEVel

Object Type Property (read/write)

Data Type Double

Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)

The value of the reference line (response value on the reference line). For the

Description rectangular format only.

Range from —1E-18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0 (except for SWR: 1)

Unit dB (decibel) | ° (degree) | s (second)

Dim Value As Double
Syntax Value = app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.RLEVel
app.SCPIL.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.RLEVel = 10

Equivalent Softkeys Scale > Ref Value

SCPI1.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.RPOSition

Object Type Property (read/write)

Data Type Long

Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)

Description The position of the reference line. For the rectangular format only.
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Range

From 0 to the number of the scale divisions (set by the
SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions property, 10 by default).

Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

5 (except for SWR: 0)

Syntax

Dim Value As Long
Value = app.SCPI.DISPlay. WINDow(Ch). TRACe(Tr).Y.SCALe.RPOSition
app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).Y.SCALe.RPOSition = 10

Equivalent Softkeys

Scale > Ref Position

SCPI.DISPlay.WINDow(Ch).X.SPACing

Object Type Property (read/write)

Data Type String

Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25).

Description The selection of the display method of the graph horizontal axis for the
segment sweep.
"LINear" : Frequency base (linear frequency axis)

R . . .

ange "OBASe" : Order base (linear axis of the point numbers)

The short format of the parameter is indicated by upper case letters. There is no

Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range The value is ignored.

Preset Value "LIN"
Dim Param As String

Syntax Param = app.SCPI.DISPlay.WINDow(Ch).X.SPACing
app.SCPI.DISPlay.WINDow(Ch).X.SPACing = "OBAS"

Equivalent Softkeys Stimulus > Segment Table > Segment Display
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SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25).
Description The number of the vertical scale divisions. For the rectangular format only.
Range from 4 to 30
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

10
Resolution 2
Dim Value As Long
Syntax Value = app.SCPI.DISPlay. WINDow(Ch).Y.SCALe.DIVisions

app.SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions = 12

Equivalent Softkeys

Scale > Divisions

SCPI.HCOPy.ABORt

Object Type Method

Target Instrument

Description Aborts the printout.
Syntax app.SCP1.HCOPy.ABORt

Equivalent Softkeys

None
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SCPI.HCOPy.DATE.STAMp

Object Type Property (read/write)

Data Type Boolean

Target Instrument

Description The ON/OFF state of the current date and time printout in the upper right

corner.

Allowable Values

True: Date & time printout ON
False: Date & time printout OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.HCOPyY.DATE.STAMp
app.SCP1.HCOPY.DATE.STAMp = False

Equivalent Softkeys

System > Print > Print Date & Time

SCPI.HCOPy.IMAGe

Object Type Property (read/write)

Data Type String

Target Instrument

Description The inverted color image printout.
"NORMal" : Normal printout

R .

ange "INVert" . Inverted color printout
The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.

Notes . ..
When the property is read out, the short format is indicated by upper case
letters.

Out of Range The value is ignored.
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Preset Value

"NORM"

Syntax

Dim Param As String
Param = app.SCPI.HCOPy.IMAGe
app.SCPI.HCOPy.IMAGe = "INV"

Equivalent Softkeys

System > Print > Invert Image

SCPI1.HCOPy.IMMediate

Object Type Method

Target Instrument

Description Prints out the image displayed on the screen without previewing.
Syntax app.SCPI.HCOPy.IMMediate

Equivalent Softkeys System > Print > Print Embedded

SCPI.HCOPy.PAINt

Object Type Property (read/write)
Data Type String
Target Instrument
Description The color chart for the image printout.
"COLor" . Color printout
Range "GRAY" : Grayscale printout
"BW" . Black&white printout
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
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Out of Range

The value is ignored.

Preset Value

IIBWII

Syntax

Dim Param As String
Param = app.SCPI.HCOPy.PAINt
app.SCPI.HCOPy.PAINt = "COL"

Equivalent Softkeys

System > Print > Print Color

SCPI.IEEE4882.CLS

Object Type

Method

Target

Status Reporting System

Description

Clears the following:

* Error Queue

* Status Byte Register

» Standard Event Status Register

* Operation Status Event Register

* Questionable Status Event Register

* Questionable Limit Status Event Register

* Questionable Limit Channel Status Event Register

Syntax

app.SCPI.IEEE4882.CLS

Equivalent Softkeys

None

SCPI.IEEE4882.IDN

Object Type Property (read only)

Data Type String

Target Instrument

Description The instrument information string. The string format: "{manufacturer},

{model}, {serial number}, {software version/firmware version}".
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Range

up to 40 characters

Syntax

Dim ID As String
ID = app.NAME

Equivalent Softkeys

None
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SCPI.IEEE4882.0PC

Object Type Property (read/write)

Data Type Long

Target Status Reporting System
Read 1 when all pending operations are complete. Note: since COM
server executes commands sequentially and any operation is complete
before COM server returns control the OPC read command doesn't wait

Description anythmg'
Write form of the command sets 1 the OPC bit (bit 0) of the Standard
Event Status Register when all of pending operations complete. In the
COM programming this is dummy operation.
Value = app.SCPI.IEEE4882.0PC

Syntax

app.SCPI.IEEE4882.0PC = Dummy

Equivalent Softkeys None
SCPI.IEEE4882.RST
Object Type Method
Target Instrument
Restores the default settings of the instrument. There is difference from
Description presetting the instrument with the SCP1.SYSTem.PRESet method — in this case the
trigger mode is set to Hold.
Syntax app.SCPI.IEEE4882.RST

Equivalent Softkeys

None

SCPI.IEEE4882.TRG
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Object Type Method

Target Instrument
If the trigger source is set to GPIB/LAN (SCPI.TRIGger.SEQuence.SOURce property
is set to "BUS" ), triggers a sweep.

Description If the trigger source is not set to the bus (SCPI.TRIGger.SEQuence.SOURce property
IS not set to "BUS" ) or the instrument is not waiting for a trigger, the method is
ignored.

Syntax app.SCPI.IEEE4882.TRG

Related Commands

SCPL.TRIGger.SEQuence.SOURce
SCPI.INITiate(Ch).CONTinuous
SCPLINITiate(Ch).IMMediate

Equivalent Softkeys None
SCPI.IEEE4882.WAI
Object Type Method
Target Instrument
Waits for the execution of all commands sent before this command.
Description Note: since COM server executes commands sequentially and any
operation is complete before COM server returns control the WAI
command doesn't wait anything.
Syntax app.SCPI.IEEE4882.WAI
Equivalent Softkeys None
SCPI.INITiate(Ch).CONTinuous
Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
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Description

The ON/OFF state of the continuous trigger initiation mode. If the continuous
trigger initiation mode is set to OFF, the channel turns to the hold state.

Allowable Values

True: Continuous trigger initiation mode ON
False: Continuous trigger initiation mode OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPL.INITiate(Ch).CONTinuous
app.SCPLINITiate(Ch).CONTinuous = False

Notes

The sweep start in continuous trigger initiation mode depends on the trigger
source. If the trigger is set to internal, the sweeps will go immediately one after
another. If the trigger is set otherwise, the sweep will start when the trigger
signal is received.

Equivalent Softkeys

Stimulus > Trigger > Continuous
Stimulus > Trigger > Hold

SCPI.INITiate(Ch).IMMediate

Object Type Method
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Sets the channel to the single trigger mode. Before this method is called, the
channel must be in hold state, otherwise an error occurs (error code 213) and
the method is ignored.
Description . ]
On completion of the sweep, the channel goes back into the hold state.
The method returns control before the end of the sweep.
Syntax app.SCPLINITiate(Ch).IMMediate

Notes

The sweep start in the single trigger mode depends on the trigger source. If the
trigger is set to internal, the sweep will start immediately after the method is
called. If the trigger is set otherwise, the sweep will start when the trigger
signal is received.

Equivalent Softkeys

Stimulus > Trigger > Single
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SCPI.MMEMory.CATalog(Dir)

Object Type Property (read only)
Data Type String
This command reads out the following information on the hard drive:
e Space in use
e Available space
o Name and size of all files (including directories) in the specified
directory
Format:
("{A}{B},{Name 1}, {Size 1} {Name 2}, {Size 2}, ... {Name
Description N}”{Size N}")
Where N is the number of all files in the specified directory and n is an
integer between 1 and N.
{A}: Space in use of the hard drive (byte).
{B}: Available space of the hard drive (byte).
{Name n}: Name of the n-th file (directory).
{Size n}: Size (byte) of the n-th file (directory). Always 0 for
directories.
Parameter Dir — Directory name whose information you want to read out
Dim Cat as String
Syntax

Cat = app.SCPI.MMEMory.CATalog("\.")

Equivalent Softkeys

None
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SCP1.MMEMory.COPY(Src, Dst)

Object Type Method
Target Instrument
Description Copies afile.
Syntax app.SCPI.MMEMory.COPY/(Src, Dst)
Src — Source file name. String data type.
Parameter

Dst — Destination file name. String data type.

Equivalent Softkeys None
SCPI.MMEMory.DELete(File)
Object Type Method
Target Instrument
Description Deletes a file.
Syntax app.SCPI.MMEMory.DELete(File)
Parameter File — File name. String data type.

Equivalent Softkeys

None

SCPI.MMEMory.LOAD.CHANnNel.STATe

Object Type

Property (write only)
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Data Type String

Target Active channel

Description Recalls the instrument state for the active channel, saved in one of the four
memory registers by the SCPI.MMEMory.STORe.CHANnel.STATe property.
"A" . Recall from register A
"B" . Recall from register B

R .

ange "c" . Recall from register C

"D" . Recall from register D

Out of Range The value is ignored.

Syntax app.SCPI.MMEMory.LOAD.CHANnNel.STATe = "A"

Equivalent Softkeys Save/Recall > Recall Channel > State A|B|C|D

SCPI.MMEMory.LOAD.CKIT(CK)

Object Type Property (write only)
Data Type String
Target Calibration kit CKk,
Ck:  calibration kit number 1-11 (see Table 6 on page 179)
Description Recalls the definition file for the calibration kit. The file must be saved by the
SCPI.MMEMory.STORe.CKIT(Ck) property.
Range up to 254 characters
Syntax app.SCPI.MMEMory.LOAD.CKIT(Ck) = File
If the full path to the file is not specified, the \CalKit subdirectory of the main
Notes directory will be searched for the file. The calibration kit definition file has
*.ckd extension by default.
Equivalent Softkeys None
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Table 6. Ck: Calibration Kit Number

Data Type Long
Description Calibration kit number.
Range from1lto 1l
Out of Range An error occurs. Error code: 114.
Notes If the calibration kit number is not specified, it is taken as equal to 1.
SCPI.MMEMory.LOAD.LIMit
Object Type Property (write only)
Data Type String
Target Active trace of the active channel.
Descriotion Recalls the specified limit table file. The file must be saved by the
P SCPI.MMEMory.STORe.LIMit property.
Range up to 254 characters
Syntax app.SCPI.MMEMory.LOAD.LIMit = File
If the full path to the file is not specified, the \Limit subdirectory of the main
Notes directory will be searched for the file. The limit table files have *.lim extension

by default.

Equivalent Softkeys

Analysis > Limit Test > Edit Limit Line > Restore Limit Table

SCP1.MMEMory.LOAD.PLOSs(Pt)

Object Type

Property (write only)

Data Type

String
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Port Pt of the active channel,

T
aroet Pt: port number 1-2 (see Table 2 on page 25).
Descriotion Recalls the specified loss compensation table file. The file must be saved by the
P SCPI.MMEMory.STORe.PLOSs(Pt) property.
Range up to 254 characters
Syntax app.SCPI.MMEMory.LOAD.PLOSs(Pt) = File
If the full path to the file is not specified, the \CalKit subdirectory of the main
Notes directory will be searched for the file. The loss compensation file has *.lct

extension by default.

Equivalent Softkeys

Calibration > Power Calibration > Loss Compen > Import Loss Table

SCPI.MMEMory.LOAD.RLIMit

Object Type Property (write only)

Data Type String

Target Active trace of the active channel.

Description Recalls the ripple Iimi'F table file. The file must be saved by the
SCP1.MMEMory.STORe.RLIMit property.

Range up to 254 characters

Syntax app.SCPI.MMEMory.LOAD.RLIMit = File
If the full path to the file is not specified, the \Limit subdirectory of the main

Notes directory will be searched for the file. The ripple limit files have *.rIm

extension by default.

Equivalent Softkeys

Analysis > Ripple Limit > Edit Ripple Limit > Restore Ripple Limit Table

SCPI.MMEMory.LOAD.SEGMent

Object Type

Property (write only)

Data Type

String
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Target Active channel

Description Recalls the segment table file. The file must be saved by the
SCP1.MMEMory.STORe.SEGMent property.

Range up to 254 characters

Syntax app.SCPI.MMEMory.LOAD.SEGMent = File
If the full path to the file is not specified, the \Segment subdirectory of the main

Notes directory will be searched for the file. The segment files have *.seg extension
by default.

Equivalent Softkeys Stimulus > Segment Table > Recall...
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SCPI.MMEMory.LOAD.SNP.DATA

Object Type Property (write only)

Data Type String

Target Active channel
Loads the Touchstone file with the specified name to the measured S-—

o parameters of the active channel. The Touchstone file types slp, s2p, s3p and

Description s4p are supported. On completion of the command, the channel goes to the
hold state.

Range up to 254 characters

Syntax app.SCPI.MMEMory.LOAD.SNP.DATA = File

Equivalent Softkeys

Save/Recall > Load Data From Touchstone File > To S-parameters...
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SCPI.MMEMory.LOAD.SNP.TRACe(Tr).MEMory

Object Type Property (write only)
Data Type String
The specified memory trace Tr of active channel,
Target Tr: trace number 1-16 (see Table 3 on page 36)
Active channel set by command SCPI.DISPlay.WINDow(Ch).ACTivate
Loads the Touchstone file with the specified name to the memory trace. The
Description Touchstone file types slp, s2p, s3p and s4p are supported. After successful
load the display of memory trace is automatically switched on.
Range up to 254 characters
Syntax app.SCPI.MMEMory.LOAD.SNP.TRACe(Tr).MEMory = File
Equivalent Softkeys Save/Recall > Load Data From Touchstone File > To Active Trace...

SCPI.MMEMory.LOAD.STATe

Object Type Property (write only)

Data Type String

Target Instrument

Description Recalls the specified instrument state file. The file must be saved by the
SCPI.MMEMory.STORe.STATe property.

Range up to 254 characters

Syntax app.SCPI.MMEMory.LOAD.STATe = File
If the full path to the file is not specified, the \State subdirectory of the main

Notes directory will be searched for the file. The instrument state files have *.sta
extension by default.

Equivalent Softkeys Save/Recall > Recall State > State...
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SCPI.MMEMory.MDIRectory

Object Type Property (write only)
Data Type String
Target Instrument

- Creates a new directory (folder). Contains the full path to the folder being
Description

created.

Range up to 254 characters
Syntax app.SCPI.MMEMory.MDIRectory = Path

Equivalent Softkeys

None

SCPI.MMEMory.STORe.CHANnNel.CLEar

Object Type Method

Target Instrument

Description Clears the memory of the channel state saved by the
SCPI.MMEMory.STORe.CHANnNel.STATe property.

Syntax app.SCPI.MMEMory.STORe.CHANnNel.CLEar

Equivalent Softkeys

Save/Recall > Save Channel > Clear States
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SCPI.MMEMory.STORe.CHANnNel.STATe

Object Type Property (write only)
Data Type String
Target Active channel
Description Saves the instrument state of the items set for the active channel into one of the
four memory registers.
"A" . Save to register A
"B" . Save to register B
R .
ange "C" : Save to register C
"D" . Save to register D
Out of Range The value is ignored.
Syntax app.SCPI.MMEMory.STORe.CHANnNel.STATe = "A"
Equivalent Softkeys Save/Recall > Save Channel > State A|B|C|D

SCPI.MMEMory.STORe.CKIT(CK)

Object Type Property (write only)
Data Type String
Target Calibration kit Ck_, _ _
Ck:  calibration kit number 1-11 (see Table 6 on page 179)
Description Saves the definition file for the calibration kit parameters.
Range up to 254 characters
Syntax app.SCPI.MMEMory.STORe.CKIT(Ck) = File
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Notes

If the full path to the file is not specified, the file will be saved to the \CalKit
subdirectory of the main directory. The calibration kit definition file has *.ckd
extension by default.

Equivalent Softkeys

None

SCPI.MMEMory.STORe.FDATa

Object Type Property (write only)

Data Type String

Target Active trace of the active channel
Description Saves the CSV formatted data into a file.
Range up to 254 characters

Syntax app.SCPI.MMEMory.STORe.FDATa = File

Notes

If the full path to the file is not specified, the file will be saved to the \CSV
subdirectory of the main directory. The files have *.csv extension by default.

Equivalent Softkeys

Save/Recall > Save Trace Data

SCPI.MMEMory.STORe.IMAGe

Object Type Property (write only)

Data Type String

Target Instrument

Description Saves the display image in BMP or PNG format into a file.
Range up to 254 characters

Syntax app.SCPI.MMEMory.STORe.IMAGe = File

Notes

If the full path to the file is not specified, the file will be saved to the \Image
subdirectory of the main directory. If the file has *.png extension, the file has
PNG format, in all the other cases the file has BMP format.
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Equivalent Softkeys

System > Print > Print Windows > Save as...

SCPI.MMEMory.STORe.LIMit

Object Type Property (write only)
Data Type String
Target Active trace of the active channel
Description Saves the limit table into a file with the specified name.
Range up to 254 characters
Syntax app.SCPI.MMEMory.STORe.LIMit = File
If the full path to the file is not specified, the file will be saved to the \Limit
Notes subdirectory of the main directory. The files have *.lim extension by default.

Equivalent Softkeys

Analysis > Limit Test > Edit Limit Line > Save Limit Table

SCPI.MMEMory.STORe.PLOSs(Pt)

Object Type Property (write only)
Data Type String
Target Port Pt of the active channel,
Pt: port number 1-4 (see Table 2 on page 25)

Description Saves the loss compensation table into a file with the specified name.
Range up to 254 characters
Syntax app.SCPI.MMEMory.STORe.PLOSs(Pt) = File

If the full path to the file is not specified, the file will be saved to the \CalKit
Notes subdirectory of the main directory. The loss compensation files have *.lct

extension by default.
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Equivalent Softkeys

Calibration > Power Calibration > Loss Compen > Export Loss Table

SCPI.MMEMory.STORe.RLIMit

Object Type Property (write only)
Data Type String
Target Active trace of the active channel
Description Saves the ripple limit table into a file with the specified name.
Range up to 254 characters
Syntax app.SCPI.MMEMory.STORe.RLIMit = File
If the full path to the file is not specified, the file will be saved to the \Limit
Notes subdirectory of the main directory. The ripple limit files have *.rIm extension

by default.

Equivalent Softkeys

Analysis > Ripple Limit > Edit Ripple Limit > Save Ripple Limit Table

SCPI.MMEMory.STORe.SEGMent

Object Type Property (write only)
Data Type String
Target Active channel
Description Saves the segment table in a file with the specified name.
Range up to 254 characters
Syntax app.SCPI.MMEMory.STORe.SEGMent = File
If the full path to the file is not specified, the file will be saved to the \Segment
Notes subdirectory of the main directory. The segment files have *.seg extension by

default.
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Equivalent Softkeys

Stimulus > Segment Table > Save...

SCPI.MMEMory.STORe.SNP.DATA

Object Type Property (write only)
Data Type String
Target Active channel
Saves the measured S—parameters of the active channel into a Touchstone file
Description with the specified name. The file type (slp, s2p, s3p or s4p) is set by the
SCPI.MMEMory.STORe.SNP.TYPE.SIP  t0  SCPI.MMEMory.STORe.SNP.TYPE.S4P
properties.
Range up to 254 characters
Syntax app.SCPI.MMEMory.STORe.SNP.DATA = File
If the full path to the file is not specified, the file will be saved to the
Notes . . . . X
\FixtureSim subdirectory of the main directory.
Equivalent Softkeys Save/Recall > Save Data to Touchstone File > Save File...

SCPI1.MMEMory.STORe.SNP.FORMat

Object Type Property (read/write)
Data Type String
Target Active channel
Descriotion The data format for the S—parameters saving by the
P SCP1.MMEMory.STORe.SNP.DATA property.
" MA" . Logarithmic Magnitude / Angle format
Range " DB" . Linear Magnitude / Angle format
"RI" : Real part /Imaginary part format
Out of Range The value is ignored.
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Preset Value

IIRIII

Syntax

Dim Param As String
Param = app.SCPI.MMEMory.STORe.SNP.FORMat
app.SCPI.MMEMory.STORe.SNP.FORMat = "DB"

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Format

SCPI.MMEMory.STORe.SNP.TYPE.S1P

Object Type Property (read/write)

Data Type Long

Target Active channel
Selects slp save type and sets port numbers (selects S11, S22, S33 or S44

Description parameter) when saving the measured S-parameters by the
SCPI.MMEMory.STORe.SNP.DATA property.

Range from1to 4

Out of Range An error occurs. Error code 222.

Preset Value

Syntax

Dim Value As Long
Value = app.SCPI.MMEMory.STORe.SNP.TYPE.S1P
app.SCPI.MMEMory.STORe.SNP.TYPE.S1P = 2

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Type > 1-Port (s1p)

Save/Recall > Save Data to Touchstone File > Select Port (s1p)

SCPI.MMEMory.STORe.SNP.TYPE.S2P

Object Type

Property (read/write)

Data Type

Variant (array of long)
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Target Active channel

Selects s2p save type and sets port numbers when saving the measured
S-parameters by the SCPI.MMEMory.STORe.SNP.DATA property.

Description The array contains 2 elements:
Data(0) First port number;
Data(1) Second port number.

Dim Data As Variant
Syntax Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S2P
app.SCPI.MMEMory.STORe.SNP.TYPE.S2P = Array(1, 2)

Save/Recall > Save Data to Touchstone File > Type > 2—Port (s2p)

Equivalent Softk .
quivaient Sorteys Save/Recall > Save Data to Touchstone File > Select Ports (s2p)
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SCPI.MMEMory.STORe.SNP.TYPE.S3P

Object Type Property (read/write)
Data Type Variant (array of long)
Target Active channel
Selects s3p save type and sets port numbers when saving the measured
S-parameters by the SCPI.MMEMory.STORe.SNP.DATA property.
The array contains 3 elements:
D ipti .
escription Data(0) First port number;
Data(1) Second port number;
Data(2) Third port number.
Dim Data As Variant
Syntax Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S3P

app.SCP1.MMEMory.STORe.SNP.TYPE.S3P = Array(1, 2, 3)

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Type > 2—Port (s3p)
Save/Recall > Save Data to Touchstone File > Select Ports (s3p)

Version 1.2 — Oct. 17, 2013 141




SCPI.MMEMory.STORe.SNP.TYPE.S4P

Object Type

Property (read/write)

Data Type

Variant (array of long)

Target

Active channel

Description

Selects s4p save type and sets port numbers when saving the measured
S-parameters by the SCPI.MMEMory.STORe.SNP.DATA property.

The array contains 3 elements:
Data(0) First port number;
Data(1) Second port number;
Data(2) Third port number;
Data(3) Forth port number.

Syntax

Dim Data As Variant
Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S4P
app.SCPI.MMEMory.STORe.SNP.TYPE.S4P = Array(1, 2, 3, 4)

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Type > 2—Port (s4p)

SCPI.MMEMory.STORe.STATe

Object Type Property (write only)

Data Type String

Target Instrument

Description Saves the instrument state into a file with the specified name.
Range up to 254 characters

Syntax app.SCPI.MMEMory.STORe.STATe = File
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Notes

If the full path to the file is not specified, the file will be saved to the \State
subdirectory of the main directory. The state files have *.sta extension by
default.

Equivalent Softkeys

Save/Recall > Save State > State...

SCPI.MMEMory.STORe.STYPe

Object Type Property (read/write)

Data Type String

Target Instrument

Description Selects the type of the instrument or channel state saving by the
SCPI.MMEMory.STORe.STATe OF SCPI.MMEMory.STORe.CHANnel.STATe property.
"STATe" . Measurement conditions
"CSTate" : Measurement conditions and calibration tables

R .-

ange "DSTate" : Measurement conditions and data traces

"CDSTate" : Measurement conditions, calibration tables and data traces
The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.

Notes . T
When the property is read out, the short format is indicated by upper case
letters.

Out of Range An error occurs. Error code 205.

Preset Value "CST"
Dim Param As String

Syntax Param = app.SCPI.MMEMory.STORe.STYPe
app.SCPI.MMEMory.STORe.STYPe = "STATe"

Equivalent Softkeys Save/Recall > Save Type

SCPI.OUTPuUt.STATe

Object Type

Property (read/write)
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Data Type Boolean
Target Instrument
Description Sets the ON/OFF state of the stimulus signal output. Measurements cannot be

performed when the stimulus signal output is set to OFF.

Allowable Values

True: Stimulus signal output ON
False: Stimulus signal output OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.OUTPut.STATe
app.SCPI.OUTPut.STATe = False

Equivalent Softkeys

Stimulus > Power > RF Out

SCPI.SENSe(Ch).AVERage.CLEar

Object Type Method
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
Description Resets the averaging data count to 0. Restarts the averaging process.
Syntax app.SCPI1.SENSe(Ch).AVERage.CLEar

Equivalent Softkeys

None

SCPI.SENSe(Ch).AVERage.COUNt

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The averaging factor, when the averaging function is set to ON by the

SCPI1.SENSe(Ch).AVERage.STATe property.
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Range

from 1 to 999

Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

10

Syntax

Dim Value As Long
Value = app.SCPI.SENSe(Ch).AVERage. COUNt
app.SCPI.SENSe(Ch).AVERage.COUNt = 2

Equivalent Softkeys

Average > Avg Factor

SCPI.SENSe(Ch).AVERage.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the averaging function.

Allowable Values

True: Averaging ON
False: Averaging OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.SENSe(Ch).AVERage.STATe
app.SCPI.SENSe(Ch).AVERage.STATe = False

Equivalent Softkeys

Average > Averaging

SCPI1.SENSe(Ch).BANDwidth.RESolution

Object Type

Property (read/write)
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Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The IF bandwidth value.
Range from 1 to 30000
Resolution Instepsof1,15,2,3,5,7.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 10000
Unit Hz (Hertz)

Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).BANDwidth.RESolution

app.SCPI.SENSe(Ch).BANDwidth.RESolution = 100

Equivalent Softkeys

Average > IF Bandwidth

SCPI1.SENSe(Ch).CORRection.CLEar

Object Type Method
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Clears the calibration coefficient table.
Syntax app.SCPI.SENSe(Ch).CORRection.CLEar

Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COEFficient. DATA(Str, Pt_r, Pt s)

Object Type

Property (read/write)
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Data Type Variant (array of double)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The calibration coefficient data array set by the type of the corrected error Str,
the number of the receiver port Pt_r and the number of the source port Pt_s,
Str : error type (see below)
Pt r : the number of the receiver port 1-4 (see Table 2 on page 25)
Descrin Pt s : the number of the source port 1-4 (see Table 2 on page 25)
eSCI’IptIOﬂ
The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Data(2n-2) real part of the calibration coefficients
Data(2n-1) imaginary part of the calibration coefficients
String Str — corrected error type:
"ES": Source match
"ER": Reflection tracking
"ED": Directivity
"EL": Load match
Parameter "ET": Transmission tracking
"EX": lIsolation
When ES, ER, or ED is used, the numbers of the ports Pt_r and Pt_s must be
the same. When EL, ET, or EX is used, the numbers of the ports Pt_r and Pt_s
must be different.
Dim Data As Variant
Syntax Data = app.SCPI1.SENSe(Ch).CORRection.COEFficient. DATA (Str, Pt_r, Pt_s)

app.SCPI.SENSe(Ch).CORRection.COEFficient. DATA (Str, Pt_r, Pt_s) = Data

Notes

The written calibration coefficients become effective only after the
SCPI.SENSe(Ch).CORRection.COEFficient. SAVE method is invoked.

Equivalent Softkeys

None
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SCPI1.SENSe(Ch).CORRection.COEFficient. METHod.ERESponse

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port numbers and sets the 1-path 2—port calibration type, when the
written  calibration  coefficients are made effective by the
SCPI1.SENSe(Ch).CORRection.COEFficient. SAVE method.
D ipti .
eseription The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Dim Ports As Variant
Syntax Ports = Array(2, 1)
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.ERESponse = Ports
Equivalent Softkeys None

SCPI1.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.OPEN

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the response calibration (Open) type, when the written
Description calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient. SAVE method.
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Range from1lto 4

Out of Range An error occurs. Error code: 222.
Dim Port As Long

Syntax Port =1

app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.OPEN = Port

Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.SHORt

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the response calibration (Short) type, when the written
Description calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient. SAVE method.
Range from1to 4
Out of Range An error occurs. Error code: 222.
Dim Port As Long
Syntax Port =1

app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.SHORt = Port

Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse. THRU

Object Type

Property (write only)

Data Type

Variant (array of long)
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Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the ports and sets the response calibration (Thru) type, when the
written  calibration  coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient. SAVE method.
Descripti .
eseripien The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Dim Ports As Variant
Syntax Ports = Array(2, 1)
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse. THRU = Ports
Equivalent Softkeys None

SCPI1.SENSe(Ch).CORRection.COEFficientt METHo0d.SOLT1

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the full 1—port calibration type, when the written
Description calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient. SAVE method.
Range from1to 4
Out of Range An error occurs. Error code: 222.
Dim Port As Long
Syntax Port =1
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT1= Port
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Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COEFficient. METH0d.SOLT2

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the ports and sets the full 2—port calibration type, when the written
calibration coefficients are made effective by the
SCPI1.SENSe(Ch).CORRection.COEFficient. SAVE method.
Description The array contains 2 elements:
Data(0) specifies a port for full 2-port calibration;
Data(1) specifies a port for full 2-port calibration.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Dim Ports As Variant
Syntax Ports = Array(1,2)

app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2 = Ports

Equivalent Softkeys

None
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SCPI1.SENSe(Ch).CORRection.COEFficient METHo0d.SOLT3

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the ports and sets the full 3—port calibration type, when the written
calibration coefficients are made effective by the
SCPI1.SENSe(Ch).CORRection.COEFficient. SAVE method.
o The array contains 3 elements:
Description
Data(0) specifies a port for full 3-port calibration;
Data(1) specifies a port for full 3-port calibration;
Data(2) specifies a port for full 3-port calibration.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Dim Ports As Variant
Syntax Ports = Array(1,2,4)

app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2 = Ports

Equivalent Softkeys

None
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SCPI1.SENSe(Ch).CORRection.COEFficient METHod.SOLT4

Object Type

Property (write only)

Data Type

Variant (array of long)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

Selects the ports and sets the full 4—port calibration type, when the written
calibration coefficients are made effective by the
SCPI1.SENSe(Ch).CORRection.COEFficient. SAVE method.

The array contains 4 elements:
Data(0) specifies a port for full 4-port calibration;
Data(1) specifies a port for full 4-port calibration;
Data(2) specifies a port for full 4-port calibration;
Data(3) specifies a port for full 4-port calibration.

Range

Port number is 1 to 4. The array elements can not contain the same port
numbers.

Out of Range

If an incorrect port number is specified, an error occurs (error code: 222). If the
same port numbers are specified, an error occurs (error code: 220).

Syntax

Dim Ports As Variant
Ports = Array(1,2,3,4)
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2 = Ports

Equivalent Softkeys

None

SCPIL.SENSe(Ch).CORRection.COEFficient.SAVE

Object Type

Method

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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Enables the written calibration coefficients depending on the selected
calibration type.

On completion of the method the written calibration coefficients are cleared,

Descripti ) .
eseription the error correction automatically turns ON.
At the attempt to execute this method before all the needed calibration
coefficients are written, an error occurs and the method is ignored.
Syntax app.SCPI.SENSe(Ch).CORRection.COEFficient.SAVE

Related Commands

Calibration type selection:

SCPI1.SENSe(Ch).CORRection.COEFficient. METHod.ERESponse
SCPI1.SENSe(Ch).CORRection.COEFficient METHod.RESPonse.OPEN
SCPI1.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.SHORt
SCPI1.SENSeg(Ch).CORRection.COEFficient. METHod.RESPonse. THRU
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT1
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2
SCPI.SENSe(Ch).CORRection.COEFficient. METHo0d.SOLT3
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT4

Calibration coefficient writing:
SCPI1.SENSe(Ch).CORRection.COEFficient. DATA (Str, Pt_r, Pt_s)

Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.ISOLation

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the isolation calibration data between the source port and the receiver
port.
Description The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Range Port number is 1 to 4 The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range g
same port numbers are specified, an error occurs (error code: 220).
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Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.ISOLation = Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > Response (Thru) > Isolation (Optional)

Calibration > Calibrate > One Path 2—Port Cal > Isolation (Optional)
Calibration > Calibrate > 2—Port SOLT Cal > Port x-y Isol (Optional)
Calibration > Calibrate > 3—Port SOLT Cal > Port x-y Isol (Optional)

Calibration > Calibrate > 4-Port SOLT Cal > Port x-y Isol (Optional)

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.LOAD

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Measures the calibration data of the load standard for the specified port.
Range Port number is 1 to 4.
Out of Range An error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.COL Lect. ACQuire.LOAD =1

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.
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Equivalent Softkeys

Calibration > Calibrate > Response (Open) > Load (Optional)
Calibration > Calibrate > Response (Short) > Load (Optional)
Calibration > Calibrate > 1-Port SOL Cal > Load

Calibration > Calibrate > One Path 2—Port Cal > Load

Calibration > Calibrate > 2—Port SOLT Cal > Port n Load

Calibration > Calibrate > 3—Port SOLT Cal > Reflection Port n > Load

Calibration > Calibrate > 4—Port SOLT Cal > Reflection Port n > Load

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.OPEN

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description Measures the calibration data of the open standard for the specified port.
Range Port number is 1 to 4.
Out of Range An error occurs (error code: 222).
Syntax app.SCP1.SENSe(Ch).CORRection.COLLect. ACQuire.OPEN= 1

The property writing starts the measurement for the channel independently of
Notes the trigger initiation and trigger source settings. The function of the property

writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > Response (Open) > Open

Calibration > Calibrate > 1-Port SOL Cal > Open

Calibration > Calibrate > One Path 2—Port Cal > Open

Calibration > Calibrate > 2—Port SOLT Cal > Port n Open

Calibration > Calibrate > 3—Port SOLT Cal > Reflection Port n > Open

Calibration > Calibrate > 4-Port SOLT Cal > Reflection Port n > Open
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SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.SHORt

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Measures the calibration data of the short standard for the specified port.
Range Port number is 1 to 4.
Out of Range An error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.COL Lect. ACQuire.SHORt = 1

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > Response (Short) > Short

Calibration > Calibrate > 1-Port SOL Cal > Short

Calibration > Calibrate > One Path 2—Port Cal > Short

Calibration > Calibrate > 2—Port SOLT Cal > Port n Short

Calibration > Calibrate > 3—Port SOLT Cal > Reflection Port n > Short

Calibration > Calibrate > 4—Port SOLT Cal > Reflection Port n > Short
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SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.SUBClass

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The subclass number which is used for the calibration of the selected channel
(Ch). For example, if two different subclasses are set in advance, say Thru 1 &
Description Thru 2, which are visible at the calibration softkey, this command can select
either Thrul or Thru2. When performing Thru cal, either Thru 1 or Thru 2 set
with this command is used for the calibration.
Range 1to 8.
app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.SUBClass = 2
Syntax
Subclass = app.SCP1.SENSe(Ch).CORRection.COLLect. ACQuire.SUBClass
Equivalent Softkeys None

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. THRU

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the calibration data of the thru standard between the source port and
the receiver port.
Description The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
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Out of Range

If an incorrect port number is specified, an error occurs (error code: 222). If the
same port numbers are specified, an error occurs (error code: 220).

Syntax

app.SCPI1.SENSe(Ch).CORRection.COL Lect. ACQuire. THRU= Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > Response (Thru) > Thru
Calibration > Calibrate > One Path 2—-Port Cal > Thru
Calibration > Calibrate > 2—Port SOLT Cal > Port x-y Thru
Calibration > Calibrate > 3—Port SOLT Cal >x-y Thru

Calibration > Calibrate > 4—-Port SOLT Cal > Transmission > x-y Thru
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SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. TRLLIine

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the calibration data of the TRL Line/Match standard between the
source port and the receiver port.
Description The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire. TRLLine= Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > 2—Port TRL Cal > x-y Line/Match
Calibration > Calibrate > 3—Port TRL Cal > Line/Match > x-y Line/Match

Calibration > Calibrate > 4-Port TRL Cal > Line/Match > x-y Line/Match
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SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. TRLReflect

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Measures the calibration data of the TRL Reflect standard for the specified port.
Range Port number is 1 to 4.
Out of Range An error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.COL Lect. ACQuire. TRLReflect = 1

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > 2—Port TRL Cal > Port x Reflect

Calibration > Calibrate > 3—Port TRL Cal > Reflect > Port x

Calibration > Calibrate > 4—Port TRL Cal > Reflect > Port x
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SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. TRLThru

Object Type

Property (write only)

Data Type

Variant (array of long)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

Measures the calibration data of the TRL Thru/Line standard between the
source port and the receiver port.

The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.

Range

Port number is 1 to 4. The array elements can not contain the same port
numbers.

Out of Range

If an incorrect port number is specified, an error occurs (error code: 222). If the
same port numbers are specified, an error occurs (error code: 220).

Syntax

app.SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. TRLThru= Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > 2—Port TRL Cal >x-y Thru/Line
Calibration > Calibrate > 3—Port TRL Cal > Thru/Line > x-y Thru/Line

Calibration > Calibrate > 4-Port TRL Cal > Thru/Line > x-y Thru/Line

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel

Object Type Property (read/write)
Data Type String
Tarcet Calibration kit, selected for channel Ch,
g Ch:  channel number 1-16 (see Table 1 on page 25)
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Description

The calibration kit label.

Range

up to 254 characters

Preset Value

Varies depending on the number of the calibration kit.

Syntax

Dim Lab As String
Lab = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel
app.SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.LABel ="Userl"

Equivalent Softkeys

Calibration > Cal Kit > Label

SCPIL.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer.LOAD(Pt)

Object Type Property (read/write)
Data Type Long
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the calibration standard of the load type, used for the
Description measurement of the specified port Pt,
Pt: port number 1-4 (see Table 1 on page 25)
Range From 1 to the number of standards in the calibration Kit.
If the specified standard number is greater than the number of standards in the
Out of Range Kit, an error occurs (error code: 222). If the specified standard number is not the
load standard number, an error occurs (error code: 220).
Dim Num As Long
Syntax Num = app.SCPIL.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.LOAD(Pt)

app.SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer.LOAD(Pt) = 1

Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > Load Port n (Row)

SCPI1.SENSe(Ch).CORRection.COLLect. CKIT.ORDer.OPEN(Pt)

Object Type

Property (read/write)
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Data Type Long
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the calibration standard of the open type, used for the
Description measurement of the specified port Pt,
Pt: port number 1-4 (see Table 1 on page 25)
Range From 1 to the number of standards in the calibration Kit.
If the specified standard number is greater than the number of standards in the
Out of Range Kit, an error occurs (error code: 222). If the specified standard number is not the
open standard number, an error occurs (error code: 220).
Dim Num As Long
Syntax Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.OPEN(PY)
app.SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer.OPEN(Pt) = 1
Equivalent Softkeys Calibration > Cal Kit > Specify CLSs > Open Port x (Row)

SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SELect

Object Type Property (read/write)
Data Type Long
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The subclass used to specify classes of calbration standards by the commands
SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. XXXX.
Range 1to 8.
If the specified standard number is greater than the number of standards in the
Out of Range kit, an error occurs (error code: 222). If the specified standard number is not the
short standard number, an error occurs (error code: 220).
Dim Num As Long
Syntax Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SELect
app.SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer.SELect = 1
Equivalent Softkeys Calibration > Cal Kit > Specify CLSs > Subclass n (Column)
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SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SHORt(Pt)

Object Type Property (read/write)

Data Type Long

Calibration kit, selected for channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

The number of the calibration standard of the short type, used for the
Description measurement of the specified port Pt,
Pt: port number 1-4 (see Table 1 on page 25)

Range From 1 to the number of standards in the calibration Kkit.

If the specified standard number is greater than the number of standards in the
Out of Range kit, an error occurs (error code: 222). If the specified standard number is not the
short standard number, an error occurs (error code: 220).

Dim Num As Long
Syntax Num = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SHORt(Pt)
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SHORt(Pt) = 1

Equivalent Softkeys Calibration > Cal Kit > Specify CLSs > Short Port x (Row)

SCPIL.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer. THRU(Pt_m, Pt_n)

Object Type Property (read/write)

Data Type Long

Calibration kit, selected for channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the calibration standard of the thru type, used for the
Description measurement between the Pt_m and Pt_n ports,
Pt_m: port number 1-4 (see Table 2 on page 25)
Pt_n: port number 1-4 (see Table 2 on page 25)
Range From 1 to the number of standards in the calibration Kit.
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If the specified standard number is greater than the number of standards in the
Out of Range kit, an error occurs (error code: 222). If the specified standard number is not
the thru standard number, an error occurs (error code: 220).

Dim Num As Long
Num = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. THRU(Z, 2)
app.SCPI.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer. THRU(1, 2) = 1

Syntax

Equivalent Softkeys Calibration > Cal Kit > Specify CLSs > Thru Port x-y (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLLine(Pt_m, Pt n)

Object Type Property (read/write)
Data Type Long
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the calibration standard of the TRL Line/Match type, used for
Description the measurement between the Pt_m and Pt_n ports,
Pt_m: port number 1-4 (see Table 2 on page 25)
Pt_n: port number 1-4 (see Table 2 on page 25)
Range From 1 to the number of standards in the calibration Kit.
If the specified standard number is greater than the number of standards in the
Out of Range Kit, an error occurs (error code: 222). If the specified standard number is not
the thru standard number, an error occurs (error code: 220).
Dim Num As Long
Num =
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLLine(1, 2)
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLLine(1,2) =1

Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > TRL Line/Match Port x-y (Row)
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SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.ORDer. TRLReflect(Pt)

Object Type Property (read/write)
Data Type Long
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the calibration standard of the TRL Reflect type, used for the
Description measurement of the specified port Pt,
Pt: port number 1-4 (see Table 1 on page 25)
Range From 1 to the number of standards in the calibration Kit.
If the specified standard number is greater than the number of standards in the
Out of Range kit, an error occurs (error code: 222). If the specified standard number is not the
short standard number, an error occurs (error code: 220).
Dim Num As Long
Num =
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLReflect(Pt)
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLReflect (Pt) = 1

Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > TRL Reflect Port x (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLThru(Pt_m, Pt_n)

Object Type Property (read/write)
Data Type Long
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The number of the calibration standard of the TRL Thru type, used for the
Description measurement between the Pt_m and Pt_n ports,
Pt_m: port number 1-4 (see Table 2 on page 25)
Pt_n: port number 1-4 (see Table 2 on page 25)
Range From 1 to the number of standards in the calibration Kit.
If the specified standard number is greater than the number of standards in the
Out of Range Kit, an error occurs (error code: 222). If the specified standard number is not
the thru standard number, an error occurs (error code: 220).
Dim Num As Long
Num =
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer. TRLThru(1, 2)
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLThru(1, 2) =1

Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > TRL Thru Port x-y (Row)

SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.RESet

Object Type Method
Target Calibration kit, selected for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Resets the calibration kit to the factory settings.
Syntax app.SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.RESet

Equivalent Softkeys

Calibration > Cal Kit > Restore Cal Kit
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The selected calibration kit for the channel.
Range from 1 to 50
Out of Range An error occurs. Error code: 222.

Preset Value

Syntax

Dim Value As Long
Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.SELect = 3

Equivalent Softkeys

Calibration > Cal Kit > Select
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SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).ARBitrary

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The value of the arbitrary impedance for the load standard.
Range from —1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

50 or 75, depending on the selected calibration Kit.

Unit

Q (Ohm)

Syntax

Dim Value As Double
Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).ARBitrary
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).ARBitrary = 50

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Terminal Impedance

Table 7. Std: Calibration Standard Number

Data Type Long
Description The number of the standard.
Range Varies depending on the number of the standards in the calibration kit.
If the specified standard number is greater than the number of standards in the
Out of Range

kit, an error occurs (error code: 222).
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Notes

If the standard number is not specified, it is taken as equal to 1.

SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).CO

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The CO value of the open calibration standard.
Range from-1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit 1E-15 F (Farad)
Dim Value As Double
Syntax Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).CO

app.SCPI.SENSe(Ch).CORRection.COL Lect. CKIT.STAN(Std).CO = 100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > C0 10 °F

SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).C1

Object Type Property (read/write)
Data Type Double
Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)
Description The C1 value of the open calibration standard.
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Range

from —1E18 to 1E18

Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit 1E-27 F/Hz (Farad/Hertz)
Dim Value As Double
Syntax Value = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1 = 100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > C1 10°%' F/Hz

SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).C2

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The C2 value of the open calibration standard.
Range from —1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit

1E-36 F/HZ? (Farad/Hertz?)

Syntax

Dim Value As Double
Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2 = 100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > C2 107 F/HZ?
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3

Object Type Property (read/write)

Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)

Description The C3 value of the open calibration standard.

Range from —1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Varies depending on the selected calibration kit and the standard.
Unit 1E-45 F/HZ® (Farad/Hertz®)

Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).CORRection.COL Lect. CKIT.STAN(Std).C3
app.SCP1.SENSe(Ch).CORRection.COL Lect. CKIT.STAN(Std).C3 = 100

Equivalent Softkeys Calibration > Cal Kit > Define STDs > C3 10 F/HZ®

SCPI.SENSe(Ch).CORRection.COL Lect. CKIT.STAN(Std).DELay

Object Type Property (read/write)

Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)

Description The offset delay value of the calibration standard.

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Varies depending on the selected calibration kit and the standard.
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Unit s (second)
Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay

app.SCPI.SENSe(Ch).CORRection.COL Lect.CKIT.STAN(Std). DELay = 93E—12

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Offset Delay
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SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMAXimum

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The maximum value of the calibration standard.
Range from 0 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 999GHz
Unit Hz (Hertz)

Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMAXimum
app.SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).FMAXimum = 3E9

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Frequency max
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SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMINimum

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The minimum value of the calibration standard.
Range from 0 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0 Hz
Unit Hz (Hertz)

Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMINimum
app.SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).FMINimum = 3E9

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Frequency min

SCPI1.SENSe(Ch).CORRection.COL Lect.CKIT.STAN(Std).LO

Object Type Property (read/write)
Data Type Double
Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)
Description The LO value of the short calibration standard.
Range from —1E18 to 1E18
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Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit 1E-12 H (Henry)
Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LO
app.SCPI1.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).LO = 100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > L0 102 H

SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The L1 value of the short calibration standard.
Range from —1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit 1E-24 H/Hz (Henry/Hertz)
Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1 =100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > L1 10 H/Hz

SCPI.SENSe(Ch).CORRection.COL Lect.CKIT.STAN(Std).L2
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Object Type Property (read/write)
Data Type Double
Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)
Description The L2 value of the short calibration standard.
Range from -1E18 to 1E18

Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit 1E-33 H/HZ? (Henry/Hertz?)
Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).CORRection.COL Lect. CKIT.STAN(Std).L2

app.SCPI.SENSe(Ch).CORRection.COL Lect. CKIT.STAN(Std).L2 = 100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > L2 10 H/HZ?

SCPIL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The L3 value of the short calibration standard.
Range from —-1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Varies depending on the selected calibration kit and the standard.
Unit 1E-42 H/HZ® (Henry/Hertz?)
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Syntax

Dim Value As Double
Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3
app.SCPI1.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).L3 = 100

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > L3 10" H/HZ®

SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel

Object Type Property (read/write)
Data Type String
Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)
Description The label of the calibration standard.
Range up to 254 characters

Preset Value

Varies depending on the selected calibration kit and the standard.

Syntax

Dim Lab As String
Lab =app.SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).LABel
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel = "Open"

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Standard Label

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS

Object Type Property (read/write)
Data Type Double
Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)
Description The offset loss value of the calibration standard.
Range from -1E18 to 1E18

Version 1.2 — Oct.

17,2013 180




Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the selected calibration kit and the standard.

Unit Q/s (Ohm/second)
Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS
app.SCPI1.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std).LOSS = 700E6

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Offset Loss

SCPI.SENSe(Ch).CORRection.COLLect. CKIT.STAN(Std). TYPE

Object Type Property (read/write)
Data Type String
Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Std:  standard number (see Table 7 on page 239)
Description The type of the calibration standard.
"OPEN" : Open
"SHORLt" : Short
"LOAD" . Load
"THRU" . Thru
Range "UTHRu" : Unknown Thru
"SLID" . Sliding load
"DATA" . Data based standard
"NONE" . Not defined
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range An error occurs. Error code: 216.
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Preset Value

Varies depending on the selected calibration kit and the standard.

Syntax

Dim Param As String
Param = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std). TYPE
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).TYPE = "OPEN"

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Standard Type

SCPIL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0

Object Type Property (read/write)
Data Type Double

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Std:  standard number (see Table 7 on page 239)

Description The offset Z0 value of the calibration standard.
Range from O to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

50 or 75, depending on the selected calibration Kit.

Unit Q (Ohm)
Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0
app.SCPI1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0 = 50

Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Offset Z0

SCPI.SENSe(Ch).CORRection.COLLect.CLEar

Object Type

Method
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Channel Ch,

T

aroet Ch:  channel number 1-16 (see Table 1 on page 25)
Description Clears the measurement values of the calibration standards.
Syntax app.SCPI.SENSe(Ch).CORRection.COL Lect.CLEar

Equivalent Softkeys

Calibration > Calibrate >
Response (Open) |
Response (Short) |
Response (Thru) |
One Path 2—Port Cal |
1-Port SOL Cal |
2-Port SOLT Cal |
3-Port SOLT Cal |
4-Port SOLT Cal |
2-Port TRL Cal |
3-Port TRL Cal |
4-Port TRL Cal |

> Cancel > OK

SCPIL.SENSe(Ch).CORRection.COL Lect.DATA.ISOLation(Pt_r, Pt_s)

Object Type

Property (read/write)

Data Type

Variant (array of double)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The array of the isolation calibration measurements performed between the
receiver port Pt_r and the source port Pt_s,
Pt r: the number of the receiver port 1-4 (see Table 2 on page 25)
Pt_s: the number of the source port 1-4 (see Table 2 on page 25)

The array elements are complex numbers. Also see section “Measurement
Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Data(2n-2) real part of the measurement;

Data(2n-1) imaginary part of the measurement.
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Dim Data As Variant
Syntax Data = app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.ISOLation(Pt_r, Pt_s)
app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.ISOLation(Pt_r, Pt_s) = Data

Related Commands SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.ISOLation

Equivalent Softkeys None

SCPI1.SENSe(Ch).CORRection.COLLect. DATA.LOAD(PY)

Object Type Property (read/write)
Data Type Variant (array of double)
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

The array of the load calibration standard measurements for the port Pt,
Pt:  port number 1-4 (see Table 2 on page 25)

The array elements are complex numbers. Also see section “Measurement
Data Arrays” on page 20.

Description .
The array size is 2N, where N is the number of measurement points.

For the n-th point, where n from 1 to N:
Data(2n-2) real part of the measurement;

Data(2n-1) imaginary part of the measurement.

Dim Data As Variant
Syntax Data = app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.LOAD(Pt)
app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.LOAD(Pt) = Data

Related Commands SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.LOAD

Equivalent Softkeys None

SCPI.SENSe(Ch).CORRection.COL Lect. DATA.OPEN(Pt)

Object Type Property (read/write)

Data Type Variant (array of double)
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Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The array of the open calibration standard measurements for the port Pt,
Pt: port number 1-4 (see Table 2 on page 25)

The array elements are complex numbers. Also see section ‘“Measurement
Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Data(2n-2) real part of the measurement;
Data(2n-1) imaginary part of the measurement.

Syntax

Dim Data As Variant
Data = app.SCP1.SENSe(Ch).CORRection.COLLect. DATA.OPEN(Pt)
app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.OPEN(Pt) = Data

Related Commands

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.OPEN

Equivalent Softkeys

None

SCPI.SENSe(Ch).CORRection.COLLect. DATA.SHORt(Pt)

Object Type

Property (read/write)

Data Type

Variant (array of double)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The array of the short calibration standard measurements for the port Pt,
Pt: port number 1-4 (see Table 2 on page 25)

The array elements are complex numbers. Also see section “Measurement
Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Data(2n-2) real part of the measurement;

Data(2n-1) imaginary part of the measurement.

Syntax

Dim Data As Variant
Data = app.SCPI1.SENSe(Ch).CORRection.COLLect. DATA.SHORt(Pt)
app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.SHORt(Pt) = Data
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Related Commands

SCPI1.SENSe(Ch).CORRection.COL Lect. ACQuire.SHORt

Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COLLect.DATA.THRU.MATCh(Pt_r,Pt_s)

Object Type

Property (read/write)

Data Type

Variant (array of double)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The array of the reflection measurements of the thru standard connected
between the receiver port Pt_r and the source port Pt_s,
Pt_r: the number of the receiver port 1-4 (see Table 2 on page 25)
Pt s: the number of the source port 1-4 (see Table 2 on page 25)

The array elements are complex numbers. Also see section “Measurement
Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:

Data(2n-2) real part of the measurement;

Data(2n-1) imaginary part of the measurement.

Syntax

Dim Data As Variant
Data = app.SCPI1.SENSe(Ch).CORRection.COLLect. DATA.THRU.MATCh(Pt_r, Pt_s)
app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.THRU.MATCh(Pt_r, Pt_s) = Data

Related Commands

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. THRU

Equivalent Softkeys

None

SCPI.SENSe(Ch).CORRection.COLLect. DATA.THRU.

TRANsmission(Pt_r, Pt_s)

Object Type

Property (read/write)

Data Type

Variant (array of double)
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Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

The array of the transmission measurements performed between the receiver
port Pt_r and the source port Pt_s, using the thru standard,
Pt r: the number of the receiver port 1-4 (see Table 2 on page 25)
Pt_s: the number of the source port 1-4 (see Table 2 on page 25)

The array elements are complex numbers. Also see section “Measurement
Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n—th point, where n from 1 to N:

Data(2n-2) real part of the measurement;

Data(2n-1) imaginary part of the measurement.

Syntax

Dim Data As Variant

Data =

app.SCPI1.SENSe(Ch).CORRection.COLLect. DATA. THRU.TRANsmission(Pt_r, Pt_s)
app.SCPI.SENSe(Ch).CORRection.COLLect. DATA. THRU.TRANsmission(Pt_r, Pt_s) = Data

Related Commands

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. THRU

Equivalent Softkeys

None

SCPI.SENSe(Ch).CORRection.COLLect. ECAL.INFormation

Object Type

Property (read only)

Data Type

String

Target

AutoCal module (Ch — arbitrary number 1 to 16)

Description

Gets information about the AutoCal Module connected to the Network
Analyzer in a string with comma separated fields.
Autocal Module Information:

Model Name,

Serial Number,

Current Temperature of AutoCal Module,
Selected Characterization Information:

Characterization Name,

Characterization Date and Time,

Min Frequency,

Max Frequency,

Number of Points,

Characterization Temperature,
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PortA Connector,
PortB Connector,
PortA Adapter,
PortB Adapter,
Analyzer,
Location,
Operator.

Syntax

Dim ID As String
ID = app.SCPI.SENSe(Ch).CORRection.COLLect. ECAL.INFormation

Equivalent Softkeys

Calibration > AutoCal > Characterization Info...
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SCPI1.SENSe(Ch).CORRection.COLLect.ECAL.ORIenation.STATe

Object Type Property (read/write)
Data Type Boolean
Target AutoCal (Ch — arbitrary number 1 to 16)

The ON/OFF state of the Auto-Orientation function used when executing
AutoCal.

Description

True: Auto-Orientation function ON

Allowable Val i i i
owable Values False: Auto-Orientation function OFF

Preset Value False

Dim Status As Boolean
Syntax Status = app.SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.ORIentation.STATe
app.SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.ORIentation.STATe = False

Equivalent Softkeys Calibration > AutoCal > Orientation > Auto-Orientation
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SCPI.SENSe(Ch).CORRection.COLLect. ECAL.PATH(Pt)

Object Type Property (read/write)

Data Type Long

Target AutoCal (Ch — arbitrary number 1 to 16)

Description Sets or reads out the AutoCal module port number which is connected to a

selected Network Analyzer port (Pt).

Allowable Values

1: Port A of AutoCal Module
2: Port B of AutoCal Module
3: Port C of AutoCal Module (4 port AutoCal module only)
4: Port D of AutoCal Module (4 port AutoCal module only)

Syntax

Dim Value As Long
Value = app.SCPI.SENSe(Ch).CORRection.COLLect. ECAL.PATH(Pt)
app.SCPI.SENSe(Ch).CORRection.COLLect. ECAL.PATH(Pt) = 2

Equivalent Softkeys

Calibration > AutoCal > Orientation > Port x
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SCPI.SENSe(Ch).CORRection.COLLect. ECAL.SOLT1

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Descrii Executes 1-port calibration of the specified port of selected channel (Ch) using
eSCI’IptIOﬂ

the AutoCal module.

Dim Port As Long
Syntax

app.SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.SOLT1 = Port

Equivalent Softkeys

Calibration > AutoCal > 1-Port Cal > Port x

SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.SOLT?2

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Executes full 2-port calibration between the specified 2 ports of selected
channel (Ch) using the AutoCal module.
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. ECAL.SOLT2 = Array(2, 1)

Equivalent Softkeys

Calibration > AutoCal > 2-Port Cal > Port x-y
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SCPI1.SENSe(Ch).CORRection.COLLect.ECAL.UCHar

Object Type Property (read/write)
Data Type String
Target AutoCal (Ch — arbitrary number 1 to 16)
Descriotion Sets or reads out the Characteristic used when executing AutoCal (factory or
P user characterization)..
"CHAROQ" . Factory characterization
"CHAR1" . User characterization 1
Range "CHAR2" . User characterization 2
"CHAR3" . User characterization 3
Preset Value CHARO

Syntax

Dim Param As String
Param = app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.UCHar
app.SCPI.SENSe(Ch).CORRection.COLLect. ECAL.UCHar = "CHARO"

Equivalent Softkeys

Calibration > AutoCal > Characterization
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SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.UTHRuU.STATe

Object Type Property (read/write)

Data Type Boolean

Target AutoCal (Ch — arbitrary number 1 to 16)

Description The ON/OFF state of the Unknown Thru feature used when executing AutoCal.

Allowable Values

True: Unknown Thru feature ON
False: Unknown Thru feature OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.UTHRuU.STATe
app.SCPI1.SENSe(Ch).CORRection.COLLect. ECAL.UTHRuU.STATe = False

Equivalent Softkeys

Calibration > AutoCal > Unkn Thru
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SCPI1.SENSe(Ch).CORRection.COLLect. METHod.ERESponse

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the ports and sets the one path 2—port calibration type for the
calculation of the calibration coefficients on completion of the calibration
executed by the SCPI1.SENSe(Ch).CORRection.COLLect.SAVE method.
D ipti .
eseription The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.ERESponse = Array(2, 1)
Equivalent Softkeys Calibration > Calibrate > One Path 2—Port Cal > Select Ports

SCPI1.SENSe(Ch).CORRection.COLLect. METHod.RESPonse.OPEN

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the response calibration (Open) type for the
Description calculation of the calibration coefficients on completion of the calibration
executed by the SCPI1.SENSe(Ch).CORRection.COLLect.SAVE method.
Range from1to 4
Out of Range An error occurs. Error code: 222.
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Syntax

app.SCPI1.SENSe(Ch).CORRection.COLLect. METHod.RESPonse.OPEN = 1

Equivalent Softkeys

Calibration > Calibrate > Response (Open) > Select Port

SCPI1.SENSe(Ch).CORRection.COLLect. METHod.RESPonse.SHORt

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the response calibration (Short) type for the
Description calculation of the calibration coefficients on completion of the calibration
executed by the SCPI1.SENSe(Ch).CORRection.COLLect.SAVE method.
Range from1lto4
Out of Range An error occurs. Error code: 222.
Syntax app.SCP1.SENSe(Ch).CORRection.COL Lect. METHod.RESPonse.SHORt = 1
Equivalent Softkeys Calibration > Calibrate > Response (Short) > Select Port

SCPI1.SENSe(Ch).CORRection.COLLect. METHod.RESPonse. THRU

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the ports and sets the response calibration (Thru) type for the
calculation of the calibration coefficients on completion of the calibration
executed by the SCPI1.SENSe(Ch).CORRection.COLLect.SAVE method.
Description .
The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Version 1.2 — Oct. 17, 2013 195




Range Port number is 1 to 4. Array elements can not contain the same port numbers.

Out of Range If an incorrect port number _is_specified, an error occurs (error code: 222). If the
same port numbers are specified, an error occurs (error code: 220).

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.RESPonse. THRU = Array(2, 1)

Equivalent Softkeys Calibration > Calibrate > Response (Thru) > Select Ports

SCPI.SENSe(Ch).CORRection.COLLect. METH0d.SOLT1

Object Type Property (write only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the full 1—port calibration type for the calculation of
Description the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.
Range from1lto4
Out of Range An error occurs. Error code: 222.
Syntax app.SCP1.SENSe(Ch).CORRection.COLLect. METHod.SOLT1 =1
Equivalent Softkeys Calibration > Calibrate > 1-Port SOL Cal > Select Port

SCPI.SENSe(Ch).CORRection.COLLect. METHo0d.SOLT?2

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
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Selects the port and sets the full 2—port calibration type for the calculation of
the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Description The array contains 2 elements:
Data(0) specifies a port for full 2-port calibration;
Data(1) specifies a port for full 2-port calibration.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT2 = Array(1, 2)

Equivalent Softkeys

Calibration > Calibrate > 2—Port SOLT Cal > Select Ports
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SCPI.SENSe(Ch).CORRection.COL Lect. METHod.SOLT3

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Selects the port and sets the full 3—port calibration type for the calculation of
the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.

The array contains 3 elements:

Description
Data(0) specifies a port for full 3-port calibration;
Data(1) specifies a port for full 3-port calibration;
Data(2) specifies a port for full 3-port calibration.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222). If the
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT3 = Array(1, 2, 4)
Equivalent Softkeys Calibration > Calibrate > 3—Port SOLT Cal > Select Ports
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SCPI1.SENSe(Ch).CORRection.COLLect. METHo0d.SOLT4

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Selects the port and sets the full 4—port calibration type for the calculation of
the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.

The array contains 4 elements:

Description Data(0) specifies a port for full 3-port calibration;
Data(1) specifies a port for full 3-port calibration;
Data(2) specifies a port for full 3-port calibration;
Data(3) specifies a port for full 3-port calibration.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.

If an incorrect port number is specified, an error occurs (error code: 222). If the

Out of Range .

o same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT4 = Array(1, 2, 3, 4)
Equivalent Softkeys Calibration > Calibrate > 4-Port SOLT Cal > Select Ports
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SCPI1.SENSe(Ch).CORRection.COLLect. METHod. TRL2

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the 2—port TRL calibration type for the calculation of
the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.
Description The array contains 2 elements:
Data(0) specifies a port for 2-port TRL calibration;
Data(1) specifies a port for 2-port TRL calibration.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod. TRL2 = Array(1, 2)

Equivalent Softkeys

Calibration > Calibrate > 2—Port TRL Cal > Select Ports
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SCPI1.SENSe(Ch).CORRection.COLLect. METHod. TRL3

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the 3—port TRL calibration type for the calculation of
the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.
Descrinti The array contains 3 elements:
escription
Data(0) specifies a port for 3-port TRL calibration;
Data(1) specifies a port for 3-port TRL calibration;
Data(2) specifies a port for 3-port TRL calibration.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.TRL3 = Array(1, 2, 3)

Equivalent Softkeys

Calibration > Calibrate > 3—Port TRL Cal > Select Ports
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SCPI1.SENSe(Ch).CORRection.COLLect. METHod. TRL4

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the port and sets the 4—port TRL calibration type for the calculation of
the calibration coefficients on completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.
The array contains 4 elements:
Description Data(0) specifies a port for 4-port TRL calibration;
Data(1) specifies a port for 4-port TRL calibration;
Data(2) specifies a port for 4-port TRL calibration;
Data(3) specifies a port for 4-port TRL calibration.
Range Port number is 1 to 4. Array elements can not contain the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod. TRL4 = Array(1, 2, 3, 4)
Equivalent Softkeys Calibration > Calibrate > 4-Port TRL Cal > Select Ports

SCPI1.SENSe(Ch).CORRection.COLLect. METHod.TYPE

Object Type Property (read only)
Data Type String
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
The calibration type selected for calculating of the calibration coefficients on
Description completion of the calibration executed by the
SCPI.SENSe(Ch).CORRection.COL Lect.SAVE method.

Version 1.2 — Oct.

17,2013 202




"RESPO" . Response (Open)

"RESPS" . Response (Short)
"RESPT" . Response (Thru)
"1PATH" . One path 2—port calibration
"SOLT1" . Full 1-port calibration
"SOLT2" . Full 2—port calibration

Range "SOLT3" . Full 3—port calibration
"SOLT4" . Full 4—port calibration
"TRL2" . 2—port TRL calibration
"TRL3" . 3—port TRL calibration
"TRL4" . 4—port TRL calibration
"NONE" : Not defined
Dim Param As String

Syntax

Param = app.SCPI1.SENSe(Ch).CORRection.COLLect. METHod.TYPE

Equivalent Softkeys

None

SCPI1.SENSe(Ch).CORRection.COLLect.SAVE

Object Type

Method

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

Calculates the calibration coefficients from the calibration standards
measurements depending on the selected calibration type.

On completion of the method, all the calibration standards measurements are
cleared and the error correction automatically turns ON.

At the attempt to execute this method before all the needed standards are
measured, an error occurs and the method is ignored.

Syntax

app.SCPI1.SENSe(Ch).CORRection.COLLect.SAVE
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Related Commands

Calibration type selection:

SCPI1.SENSe(Ch).CORRection.COLLect. METHod.RESPonse.OPEN
SCPIL.SENSe(Ch).CORRection.COLLect. METHod.RESPonse.SHORt
SCPI1.SENSe(Ch).CORRection.COLLect. METHod.RESPonse. THRU
SCPI1.SENSe(Ch).CORRection.COLLect. METHod.ERESponse
SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT1
SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT2
SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT3
SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT4
SCPI1.SENSe(Ch).CORRection.COLLect. METHod.TRL2
SCPI.SENSe(Ch).CORRection.COLLect. METHod.TRL3
SCPI1.SENSe(Ch).CORRection.COLLect. METHod. TRL4

Calibration standards measurement:

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.ISOLation
SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.LOAD
SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.OPEN
SCPI1.SENSe(Ch).CORRection.COL Lect. ACQuire.SHORt
SCPI.SENSe(Ch).CORRection.COLLect. ACQuire. THRU
SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.TRLLine
SCPI.SENSe(Ch).CORRection.COLLect. ACQuire. TRLReflect
SCPI.SENSe(Ch).CORRection.COLLect. ACQuire. TRLThru

Equivalent Softkeys

Calibration > Calibrate >
Response (Open) |
Response (Short) |
Response (Thru) |
One Path 2—Port Cal |
1-Port SOL Cal |
2-Port SOLT Cal |
3-Port SOLT Cal |
4-Port SOLT Cal |
2-Port TRL Cal |
3-Port TRL Cal |
4-Port TRL Cal |

> Apply
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SCPI1.SENSe(Ch).CORRection.COLLect.SIMPIified. SAVE

Object Type Method
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Same as SCPI.SENSe(Ch).CORRection.COLLect.SAVE method. Allows to
o accomplish 3 and 4 port calibration with non complete set of standard measurements.
Description About omissible calibration standards see user guide chapter "Simplified
calibration”.
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.SIMPIified. SAVE

Related Commands

Calibration type selection:

SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT3
SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT4
SCPI.SENSe(Ch).CORRection.COL Lect. METHod.TRL3
SCPI1.SENSe(Ch).CORRection.COLLect. METHod. TRL4

Calibration standards measurement:

SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.ISOLation
SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire. THRU
SCPI1.SENSe(Ch).CORRection.COLLect. ACQuire.TRLLine

Equivalent Softkeys

Calibration > Calibrate >
3-Port SOLT Cal |
4-Port SOLT Cal |
3-Port TRL Cal |

4-Port TRL Cal |

> Apply

SCPIL.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls)

Object Type Property (read/write)
Data Type Double
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The value of the frequency at the point number Ls for calculation of the loss for
Description the port extension function,
Ls: point number 1-2 (see Table 8 on page 283)
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Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1E9
Unit Hz (Hertz)
Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls)

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls) = 100E6

Equivalent Softkeys

Calibration > Port Extensions > Loss Port n > Freql | Freq2

Table 8. Ls: Point Number

Data Type Long

Description The point number for the loss setting in the port extension function.
Range lor2

Out of Range An error occurs. Error code: 222.

Notes If the point number is not specified, it is taken as equal to 1.
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe

Object Type Property (read/write)
Data Type Boolean
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The ON/OFF state of the loss compensation at the point number Ls to calculate
Description the loss for the port extension function,

Ls: point number 1-2 (see Table 8 on page 283)

Allowable Values

True: Loss compensation ON
False: Loss compensation OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI1.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe
app.SCP1.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe = True

Equivalent Softkeys

Calibration > Port Extensions > Loss Port n > Loss1 | Loss2

SCPIL.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC

Object Type Property (read/write)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt: port number 1-4 (see Table 2 on page 25)

Description The loss value at DC for the loss calculation of the port extension function.
Range from —200 to 200
Out of Range Sets the value of the limit, which is closer to the specified value.
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Preset Value

Unit dB (decibel)
Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC
app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC = 10

Equivalent Softkeys

Calibration > Port Extensions > Loss Port n > Loss at DC

SCPI.SENSe(Ch).CORRection.EXTension.PORT (Pt).LOSS(Ls)

Object Type Property (read/write)
Data Type Double
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The loss value at the point number Ls to calculate the loss for the port
Description extension function,
Ls: point number 1-2 (see Table 7 on page 236)
Range from —200 to 200
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit dB (decibel)
Dim Value As Double
Syntax Value = app.SCP1.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls)

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls) = 10

Equivalent Softkeys

Calibration > Port Extensions > Loss Port n > Loss1 | Loss2

SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt). TIME
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Object Type Property (read/write)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt: port number 1-4 (see Table 2 on page 25)

Description The electrical delay value for the port extension function.
Range from -10 to 10
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)

Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).CORRection.EXTension.PORT(Pt).TIME

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt). TIME = 10E-9

Equivalent Softkeys

Calibration > Port Extensions > Extension Port n

SCPI1.SENSe(Ch).CORRection.EXTension.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the port extension function.

Allowable Values

True: Port extension function ON
False: Port extension function OFF

Preset Value

False

Version 1.2 — Oct. 17, 2013 209




Syntax

Dim Status As Boolean
Status = app.SCPI1.SENSe(Ch).CORRection.EXTension.STATe
app.SCPI1.SENSe(Ch).CORRection.EXTension.STATe = True

Equivalent Softkeys

Calibration > Port Extensions > Extensions
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SCPI.SENSe(Ch).CORRection.INFormation

Object Type Property (read only)
Data Type String
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The calibration information string.

Dim Callinfo As String
Syntax

Calinfo = app.SCPI1.SENSe(Ch).CORRection.INFormation
Equivalent Softkeys none

SCPIL.SENSe(Ch).CORRection.IMPedance.INPut. MAGNitude

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The system characteristic impedance (Z0) value.
Range from 0.001 to 1000
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 50
Unit Q (Ohm)

Dim Value As Double
Syntax

Value = app.SCPI1.SENSe.CORRection.IMPedance.INPut. MAGNitude
app.SCPI1.SENSe.CORRection.IMPedance.INPut. MAGNitude = 50
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Equivalent Softkeys

Calibration > System Z0

SCPIL.SENSe(Ch).CORRection.OFFSet.CLEar

Object Type Method
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Clears the scalar mixer calibration coefficient table.
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.CLEar

Equivalent Softkeys

None
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SCPI1.SENSe(Ch).CORRection.OFFSet.COL Lect. ACQuire.LOAD

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the calibration data of the load standard of the specified port when
the frequency offset feature is on (scalar mixer cal).
Description The array contains 2 elements:
Port(0)  Measurement port number;
Port(1)  Frequency port number.
Range Port number is 1 to 4. The array elements can contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.LOAD = Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Reflection Port n
> Port n @Freq m Load

Version 1.2 — Oct. 17, 2013 213




SCPI.SENSe(Ch).CORRection.OFFSet.COL Lect. ACQuire.OPEN

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the calibration data of the open standard of the specified port when
the frequency offset feature is on (scalar mixer cal).
Description The array contains 2 elements:
Port(0)  Measurement port number;
Port(1)  Frequency port number.
Range Port number is 1 to 4. The array elements can contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.OPEN = Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Reflection Port n
> Port n @Freq m Open
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SCPI1.SENSe(Ch).CORRection.OFFSet.COL Lect. ACQuire.SHORt

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the calibration data of the short standard of the specified port when
the frequency offset feature is on (scalar mixer cal).
Description The array contains 2 elements:
Port(0)  Measurement port number;
Port(1)  Frequency port number.
Range Port number is 1 to 4. The array elements can contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.SHORt = Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Reflection Port n
> Port n @Freq m Short
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SCPI1.SENSe(Ch).CORRection.OFFSet.COL Lect. ACQuire. THRU

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the calibration data of the thru standard of the specified port when
the frequency offset feature is on (scalar mixer cal).
Description The array contains 2 elements:
Port(0)  Response port number;
Port(1)  Stimulus port number.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire. THRU = Array(1, 2)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Reflection Port n
> Portn @Freq m Thru
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SCPI1.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.PMETer

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Measures the scalar-mixer calibration data using the power meter when the
frequency offset feature is ON.
The array contains 3 elements:
Description
Port(0)  Measurement port number;
Port(1)  Frequency port number.
Port(2)  Reserved.
Range Port number is 1 to 4. The array elements can contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COL Lect. ACQuire.PMETer = Array(1, 2, 0)

Notes

The property writing starts the measurement for the channel independently of
the trigger initiation and trigger source settings. The function of the property
writing waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Power > Port n
@Freqm
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SCPI1.SENSe(Ch).CORRection.OFFSet.COL Lect.CLEar

Object Type Method

Channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

Clears the calibration measurement data when the frequency offset feature is

Descripti . . .
eseripien ON (scalar mixer calibration).
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.CLEar
Equivalent Softkeys Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Cancel

Version 1.2 — Oct. 17, 2013 218




SCPI1.SENSe(Ch).CORRection.OFFSet.COLLect. METHod.SMIX2

Object Type Property (write only)
Data Type Variant (array of long)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the ports and sets the scalar mixer calibration type when the frequency
offset feature is on for the calculation of the calibration coefficients on
completion of the calibration executed by the
o SCPI.SENSe(Ch).CORRection.OFFSet.COL Lect. SAVE method.
Description
The array contains 2 elements:
Port(0)  Port number 1;
Port(1)  Port number 2.
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
If an incorrect port number is specified, an error occurs (error code: 222). If the
Out of Range .
same port numbers are specified, an error occurs (error code: 220).
Syntax app.SCPI1.SENSe(Ch).CORRection.OFFSet.COLLect. METHod.SMIX2 = Array(2, 1)

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration
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SCPI1.SENSe(Ch).CORRection.OFFSet.COL Lect.SAVE

Object Type

Method

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description

Calculates the calibration coefficient for the selected calibration type (scalar
mixer calibration only) from the calibration data measured with the frequency
offset feature is ON.

If this command is executed before all necessary calibration data for
calculating the calibration coefficient is measured, an error occurs when
executed.

Syntax

app.SCPI1.SENSe(Ch).CORRection.OFFSet.COLLect.SAVE

Related Commands

SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. METHod.SMIX2

SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire. LOAD
SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.OPEN
SCPI1.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.SHORt
SCPI1.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire. THRU
SCPI1.SENSe(Ch).CORRection.OFFSet.COL Lect. ACQuire.PMETer

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration > Apply
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SCPI1.SENSe(Ch).CORRection.RECeiver(Pt).COLLect. ACQuire

Object Type Property (write only)
Data Type Long
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The property writing executes the receiver calibration (T — channel) for the
Descriotion specified port Pt, using the specified source port Src to the right of the equal
P sign. Then executes the receiver calibration (R — channel) for the specified port
Pt, using port Pt as source (the specified source port Src is ignored).
Range The number of the source port from 1 to 4.
Out of Range Error occurs. Error code: 222.
Syntax app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect. ACQuire = Src

Notes

The property writing triggers the channel sweep independently of its current
mode (continuous, single, hold) and trigger source setting. The function of the
property writing waits for the completion of the calibration.

Equivalent Softkeys

Calibration > Receiver Calibration > Calibrate Both
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SCPI1.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.RCHannel. ACQuire

Object Type Method

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt: port number 1-4 (see Table 2 on page 25)
- Method executes the receiver calibration (R — channel) for the specified port

Description .

Pt, using port Pt as source.
Range The number of the source port from 1 to 4.
Out of Range Error occurs. Error code: 222.
Syntax app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect. ACQuire = Src

Notes

The property writing triggers the channel sweep independently of its current
mode (continuous, single, hold) and trigger source setting. The function of the
property writing waits for the completion of the calibration.

Equivalent Softkeys

Calibration > Receiver Calibration > Calibrate Reference Receiver
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SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect. TCHannel. ACQuire

Object Type Property (write only)
Data Type Long
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The property writing executes the receiver calibration (T — channel) for the
Description specified port Pt, using the specified source port Src to the right of the equal
sign.
Range The number of the source port from 1 to 4.
Out of Range Error occurs. Error code: 222.
Syntax app.SCPI1.SENSe(Ch).CORRection.RECeiver(Pt).COLLect. ACQuire = Src
The property writing triggers the channel sweep independently of its current
Notes mode (continuous, single, hold) and trigger source setting. The function of the
property writing waits for the completion of the calibration.
Equivalent Softkeys Calibration > Receiver Calibration > Calibrate Test Receiver

SCPIL.SENSe(Ch).CORRection.RECeiver(Pt).OFFSet. AMPIlitude

Object Type Property (read/write)
Data Type Double
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The power offset value for Receiver Calibration. Receiver calibration is done at
Description the condition of <source power> + <Specified offset>, for selected channel
(Ch).
Allowable Values -200 to 200.
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Unit dB (decibel)

Preset Value 0

Dim Offset As Double
Syntax Offset = app.SCP1.SENSe(Ch).CORRection.RECeiver(Pt).OFFSet. AMPL.itude
app.SCPI1.SENSe(Ch).CORRection.RECeiver(Pt).OFFSet. AMPL.itude = -10

Equivalent Softkeys Calibration > Receiver Calibration > Power Offset
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SCPIL.SENSe(Ch).CORRection.RECeiver(Pt).STATe

Object Type Property (read/write)
Data Type Boolean
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
Description The ON/OFF state of the receiver correction for the port Pt.

Allowable Values

True: Receiver correction ON
False: Receiver correction OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).STATe
app.SCPI1.SENSe(Ch).CORRection.RECeiver(Pt).STATe = True

Equivalent Softkeys

Calibration > Receiver Calibration > Correction

SCPI.SENSe(Ch).CORRection.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the error correction.

Allowable Values

True: Error correction ON
False: Error correction OFF

Preset Value

False

Version 1.2 — Oct.

17,2013

225




Syntax

Dim Status As Boolean
Status = app.SCPI.SENSe(Ch).CORRection.STATe
app.SCPI1.SENSe(Ch).CORRection.STATe = True

Equivalent Softkeys

Calibration > Correction

SCPI.SENSe(Ch).CORRection. TYPE(Tr)

Object Type Property (read only)
Data Type Variant (Variant array)
Trace Tr of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Tr: trace number 1-16 (see Table 3 on page 36)
The information about the applied calibration type and the port numbers for the
specified trace.
The array contains 5 elements:
Data(0) calibration type (see below);
Description Data(1) the port number to which the calibration is applied:;
Data(2) the port number to which the calibration is applied.
Data(3) the port number to which the calibration is applied.
Data(4) the port number to which the calibration is applied.
Calibration type in the element Data(0):
"RESPO" . Response (Open)
"RESPS" . Response (Short)
"RESPT" . Response (Thru)
"SOLT1" . Full 1-port calibration
Range "SOLT2" . Full 2—port calibration
"SOLT3" . Full 3—port calibration
"SOLT4" . Full 4—port calibration
"1PATH" : One path 2—port calibration
"NONE" . Not defined
Dim Callnfo As Variant
symiax Calinfo = app.SCPI.SENSe(Ch).CORRection. TYPE(Tr)
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Equivalent Softkeys

None

SCPI.SENSe(Ch).DATA.CORRdata(Param)

Object Type

Property (read only)

Data Type

Variant (array of double)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Parameter

Param of String type selects S-parameter:
"S11v, "s12", "S13", "S14",
"S21", "S22", "S23", "S24",
"S31", "S32", "S33", "S34",
"S41", "S42", "S43", "S44"

Description

The corrected data array. The corrected measurements are complex numbers.
Also, see section “Measurement Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Data(2n-2) the real part of corrected measurement;
Data(2n-1) the imaginary part of corrected measurement.

The index of the array starts from 0.

Syntax

Dim Data As Variant
Data = app.SCPI.SENSe(ch).DATA.CORRdata("S11")

Equivalent Softkeys

None
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SCPI.SENSe(Ch).DATA.RAWData(Param)

Object Type

Property (read only)

Data Type

Variant (array of double)

Target

Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Parameter

Param of String type selects S-parameter:
"S11", "S12", "S13", "S14",
"S21", "S22", "S23", "S24",
"S31", "S32", "S33", "S34",
"S41", "S42", "S43", "S44"

Description

The raw data array. The raw measurements are complex numbers. Also, see
section “Measurement Data Arrays” on page 20.

The array size is 2N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Data(2n-2) the real part of corrected measurement;
Data(2n-1) the imaginary part of corrected measurement.

The index of the array starts from 0.

Syntax

Dim Data As Variant
Data = app.SCPI.SENSe(ch).DATA.RAWData("S11")

Equivalent Softkeys

None
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SCPI.SENSe(Ch).FREQuency.CENTer

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The stimulus center value of the sweep range for linear or logarithmic sweep
types.
Range from minimum to maximum frequency depend on model.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Center of frequency range depend on model.

Unit Hz (Hertz)
Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).FREQuency.CENTer

app.SCPI.SENSe(Ch).FREQuency.CENTer = 1E9

Equivalent Softkeys

Stimulus > Center

SCPI.SENSe(Ch).FREQuency.CW

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The value of the fixed frequency for the power sweep.
Range From minimum to maximum frequency depend on model.
Out of Range Sets the value of the limit, which is closer to the specified value.
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Preset Value

Frequency minimum.

Unit Hz (Hertz)
Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).FREQuency.CW

app.SCPI1.SENSe(Ch).FREQuency.CW = 1E9

Equivalent Softkeys

Stimulus > Power > CW Freq

SCPI.SENSe(Ch).FREQuency.DATA

Object Type Property (read only)
Data Type Variant (array of double)
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

The array of the measurement points frequency for linear, logarithmic or

segment sweep type.
Description The array size is N, where N is the number of measurement points.

For the n-th point, where n from 1 to N:

Data(n-1) the frequency value at the n—th measurement point.

Unit Hz (Hertz)

Dim Data As Variant
Syntax

Data = app. SCP1.SENSe(Ch).FREQuency.DATA

Equivalent Softkeys

None

SCPI.SENSe(Ch).FREQuency.SPAN

Object Type

Property (read/write)

Data Type

Double
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Channel Ch,

Target Ch:  channel number 1-16 (see Table 1 on page 25)

Description The stimulus span value of the sweep range for linear or logarithmic sweep
types.

Range from minimum to maximum frequency depend on model.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Full frequency span depend on model.

Unit

Hz (Hertz)

Syntax

Dim Value As Double
Value = app.SCPI.SENSe(Ch).FREQuency.SPAN
app.SCPI.SENSe(Ch).FREQuency.SPAN = 2E9

Equivalent Softkeys

Stimulus > Span

SCPI.SENSe(Ch).FREQuency.STARt

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The stimulus start value of the sweep range for linear or logarithmic sweep
types.
Range from minimum to maximum frequency depend on model.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Frequency minimum.
Unit Hz (Hertz)
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Syntax

Dim Value As Double
Value = app.SCPI1.SENSe(Ch).FREQuency.STARt
app.SCPI.SENSe(Ch).FREQuency.STARt = 1E6

Equivalent Softkeys

Stimulus > Start

SCPI1.SENSe(Ch).FREQuency.STOP

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The stimulus stop value of the sweep range for linear or logarithmic sweep
types.
Range from minimum to maximum frequency depend on model.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Frequency maximum.

Unit Hz (Hertz)
Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).FREQuency.STOP

app.SCPI1.SENSe(Ch).FREQuency.STOP = 1E6

Equivalent Softkeys

Stimulus > Stop
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SCPI1.SENSe(Ch).OFFSet.ADJust. CONTinuous.PERiod

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Selects the period for continuous offset adjust feature:
o 1 -3 sec;
Description
2 —10 sec;
3 —30 sec.
Range from1to3
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim Value As Long
Value = app.SCPI.SENSe(Ch).OFFSet.ADJust.PERiod
app.SCPI.SENSe(Ch).OFFSet. ADJust.PERiod = 1

Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Adjust Period
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SCPI.SENSe(Ch).OFFSet. ADJust. CONTinuous.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the continuous frequency offset adjust feature.

Allowable Values

True: continuous offset adjust feature is ON
False: continuous offset adjust feature is OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.SENSe(Ch).OFFSet. ADJust. CONTinuous.STATe
app.SCPI1.SENSe(Ch).OFFSet. ADJust. CONTinuous.STATe = True

Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Continuous Adjust
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SCPI.SENSe(Ch).OFFSet.ADJust.EXECute

Object Type Method
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
Description Executes the offset adjust when the frequency offset feature is ON.
Syntax app.SCPI.SENSe(Ch).OFFset.ADJust.EXECute

Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Adjust Immediate
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SCPI.SENSe(Ch).OFFSet. ADJust.PORT

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description Selects the port number for frequency offset adjust feature.
Range from1lto 4
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1
Unit n/a

Dim Value As Long
Syntax Value = app.SCPI1.SENSe(Ch).OFFset. ADJust.PORT

app.SCPI1.SENSe(Ch).OFFset. ADJust.PORT =2

Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Select Port
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SCPI1.SENSe(Ch).OFFSet. ADJust.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the frequency offset adjust feature.

Allowable Values

True: offset adjust feature is ON
False: offset adjust feature is OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.SENSe(Ch).OFFSet. ADJust.STATe
app.SCPI1.SENSe(Ch).OFFSet. ADJust.STATe = True

Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Offset Adjust
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SCPI1.SENSe(Ch).OFFSet.ADJust.Value

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Description The frequency offset adjust value of the offset adjust feature.
Range from —5E5 to 5E5
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit Hz

Dim Value As Double
Syntax Value = app.SCPI1.SENSe(Ch).OFFSet. ADJust.VALue

app.SCPI1.SENSe(Ch).OFFSet.ADJust.VALue = 1000

Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Adjust Value
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SCPI.SENSe(Ch).OFFSet.PORT (Pt).FREQuency.DATA

Object Type Property (read only)
Data Type Variant (array of double)
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt:  port number 1-4(see Table 2 on page 25)
Reads the frequency data for the selected port Pt when the frequency offset
feature is ON, for the selected channel Ch.
Description The array size is N, where N is the number of measurement points.
For the n-th point, where n from 1 to N:
Data(n-1) the frequency value at the n—th measurement point.
Dim Data As Variant
Syntax

Data = app.SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency.DATA

Equivalent Softkeys

None
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SCPI.SENSe(Ch).OFFSet.PORT (Pt).FREQuency.DIVisor

Object Type Property (read/write)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt:  port number 1-4 (see Table 2 on page 25)

Description The basic frequency range divisor when the frequency offset feature is ON.
Range from 1 to 100
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim Value As Double
Value = app.SCPI.SENSe(Ch).OFFset.PORT (Pt).FREQuency.DIVisor
app.SCPI1.SENSe(Ch).OFFset.PORT(Pt).FREQuency.DIVisor = 2

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Divider
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SCPIL.SENSe(Ch).OFFSet.PORT (Pt).FREQuency. MUL Tiplier

Object Type Property (read/write)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt:  port number 1-4 (see Table 2 on page 25)

Description The basic range frequency multiplier when the frequency offset feature is ON.
Range from —100 to 100
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Syntax

Dim Value As Double
Value = app.SCPI.SENSe(Ch).OFFset.PORT (Pt).FREQuency.MULTiplier
app.SCPI1.SENSe(Ch).OFFset.PORT(Pt).FREQuency.MULTiplier = 2

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Multiplier
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SCPI1.SENSe(Ch).OFFSet.PORT (Pt).FREQuency.OFFSet

Object Type Property (read/write)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt:  port number 1-4 (see Table 2 on page 25)

Description The basic frequency range offset when the frequency offset feature is ON.
Range from —1e—-12 to 1lel2
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit Hz

Dim Value As Double
Syntax Value = app.SCPI.SENSe(Ch).OFFset.PORT (Pt).FREQuency.OFFSet

app.SCPI.SENSe(Ch).OFFset.PORT(Pt).FREQuency.OFFSet = 1e9

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Offset
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SCPI1.SENSe(Ch).OFFSet.PORT(Pt).FREQuency. STARt

Object Type Property (read only)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt:  port number 1-4 (see Table 2 on page 25)

Description The frequency sweep start when the frequency offset feature is ON.
Unit Hz

Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).OFFset.PORT(Pt).FREQuency.STARt

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Start
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SCPI1.SENSe(Ch).OFFSet.PORT(Pt).FREQuency. STOP

Object Type Property (read only)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt:  port number 1-4 (see Table 2 on page 25)

Description The frequency sweep stop when the frequency offset feature is ON.
Unit Hz

Dim Value As Double
Syntax

Value = app.SCPI1.SENSe(Ch).OFFset.PORT(Pt).FREQuency.STOP

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Stop
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SCPI.SENSe(Ch).OFFSet.STATe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the frequency offset feature.

Allowable Values

True: frequency offset feature is ON
False: frequency offset feature is OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCPI.SENSe(Ch).OFFSet.STATe
app.SCPI1.SENSe(Ch).OFFSet.STATe = True

Equivalent Softkeys

Stimulus > Frequency Offset > Frequency Offset

SCPI.SENSe(Ch).ROSCillator.SOURce

Object Type Property (read/write)
Data Type String
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Selects the internal or external source of the reference frequency of 10 MHz.
"INTernal" : Internal source of the reference frequency
Range

"EXTernal" : External source of the reference frequency
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Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

An error occurs. Error code: 224.

Preset Value

"INT™

Syntax

Dim Param As String
Param = app.SCPI.SENSe(Ch).ROSCillator.SOURCce
app.SCPI.SENSe(Ch).ROSCillator.SOURce = "EXT"

Equivalent Softkeys

System > Misc Setup > Ref Source

SCPI.SENSe(Ch).SEGMent.DATA

Object Type Property (read/write)
Data Type Variant (array of double)
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
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The array of the segment sweep table.
The array has the following format:

{ <Buf>, <Flagl>, <Flag2>, <Flag3>, <Flag4>, <Flag5>, <N>,
<Start(1)>, <Stop(1)>, <NOP(1)> [,<IFBW(1)>] [,<Pow(1)>] [,<Del(1)>] [,<Time(1)>],
<Start(2)>, <Stop(2)>, <NOP(2)> [,<IFBW(2)>] [,<Pow(2)>] [,<Del(2)>] [,.<Time(2)>],

<Start(N)>, <Stop(N)>, <NOP(N)> [,<IFBW(N)>] [,<Pow(N)>] [,<Del(N)>] [,<Time(N)>]

}

<Buf> . Always 5,

<Flagl> : Stimulus start setting (O — start/stop, 1 — center/span),
Description <Flag2> : Setting of the <IFBW> field (0 — disabled, 1 — enabled),

<Flag3> : Setting of the <Pow> field (0 — disabled, 1 — enabled),
<Flag4> : Setting of the <Del> field (0 — disabled, 1 — enabled),
<Flag5> : Setting of the <Time> field (0 — disabled, 1 — enabled),
<N> : Number of segments,

<Startn> : Start value of the n—th segment,

<Stop n> : Stop value of the n—th segment,

<NOP n> : Number of points of the n—th segment,

<IFBW n> : IF bandwidth of the n—th segment (if enabled),
<Pown> : Power of the n—th segment (if enabled),

<Deln> : Measurement delay of the n—th segment (if enabled),

<Time N> : Reserved for future use (if enabled).

Dim Data As Variant
Syntax Data = app.SCP1.SENSe(Ch).SEGMent.DATA
app.SCP1.SENSe(Ch).SEGMent.DATA = Data

Equivalent Softkeys Stimulus / Segment Table

SCPIL.SENSe(Ch).SWEep.POINt. TIME

Object Type Property (read/write)
Data Type Double
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Description The value of the delay before measurement in each measurement point.
Range from0to0 0.3
Resolution 5E-6
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Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)
Dim Value As Double
Syntax

Value = app.SCPI.SENSe(Ch).SWEep.POINt.TIME
app.SCP1.SENSe(Ch).SWEep.POINt.TIME = 5E-6

Equivalent Softkeys

Stimulus > Meas Delay

SCPI.SENSe(Ch).SWEep.POINts

Object Type Property (read/write)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The number of measurement points.
Range 2 to 500001
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

201

Syntax

Dim Value As Long
Value = app.SCPI.SENSe(Ch).SWEep.POINts
app.SCPI1.SENSe(Ch).SWEep.POINts = 1001

Equivalent Softkeys

Stimulus > Points

SCPI.SENSe(Ch).SWEep.TYPE

Object Type

Property (read/write)
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Data Type String
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description Sets the sweep type.
"LINear" . Linear frequency sweep
"LOGarithmic" : Logarithmic frequency sweep
R
ange "SEGMent" . Segment frequency sweep
"POWer " . Power sweep
The short format of the parameter is indicated by upper case letters. There is no
Notes distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.
Out of Range An error occurs. Error code: 206.
Preset Value "LIN"
Dim Param As String
Syntax Param = app.SCPI1.SENSe(Ch).SWEep.TYPE
app.SCP1.SENSe(Ch).SWEep.TYPE = "LOG"
Equivalent Softkeys Stimulus > Sweep Type

SCPI1.SERVice.CHANnNel. ACTive

Object Type Property (read only)
Data Type Long
Target Instrument
Description The number of the active channel.
Syntax Dim Value As Long
Value = app.SCPI.SERVice. CHANnel.ACTive
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Equivalent Softkeys

None

SCPI1.SERVice.CHANnNel. COUNt

Object Type Property (read only)

Data Type Long

Target Instrument

Description The maximum number of the channels.
Syntax Dim Value As Long

Value = app.SCPI.SERVice.CHANnel. COUNt

Equivalent Softkeys

None

SCPI.SERVice.CHANnNel(Ch). TRACe.ACTive

Object Type Property (read only)
Data Type Long
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The active trace number of the channel.
syntax Dim Value As Long

Value = app.SCPI1.SERVice.CHANnel(Ch).TRACe.ACTive

Equivalent Softkeys

None

SCPI.SERVice.CHANnNel. TRACe.COUNt
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Object Type Property (read only)

Data Type Long

Target Instrument

Description The maximum number of the traces in the channel.
Syntax Dim Value As Long

Value = app.SCPI1.SERVice.CHANnel. TRACe.COUNt

Equivalent Softkeys

None

SCPI.SERVice.PORT.COUNt

Object Type Property (read only)

Data Type Long

Target Instrument

Description The number of the ports.
Syntax Dim Value As Long

Value = app.SCPI.SERVice.PORT.COUNt

Equivalent Softkeys

None

SCPI1.SERVice.SWEep.FREQency.MAXimum

Object Type Property (read only)

Data Type Double

Target Instrument

Description The upper limit of the measurement frequency.
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Syntax

Dim Value As Double
Value = app.SCPI.SERVice.SWEep.FREQency.MAXimum

Equivalent Softkeys

None

SCPIL.SERVice.SWEep.FREQency.MINimum

Object Type Property (read only)

Data Type Double

Target Instrument

Description The lower limit of the measurement frequency.
Syntax Dim Value As Double

Value = app.SCPI.SERVice.SWEep.FREQency.MINimum

Equivalent Softkeys

None

SCPIL.SERVice.SWEep.POINts

Object Type Property (read only)

Data Type Double

Target Instrument

Description The maximum number of the measurement points.
Syntax Dim Value As Long

Value = app.SCPI1.SERVice.SWEep.POINts

Equivalent Softkeys

None
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SCPI1.SOURce(Ch).POWer.CENTer

Object Type Property (read/write)
Data Type Double
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Description The center value of the power sweep range.

Range from —60 to 10

Resolution 0.025

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value -25

Unit dBm (decibels above 1 milliwatt)

Dim Value As Double
Syntax Value = app.SCPI.SOURce(Ch).POWer.CENTer
app.SCP1.SOURce(Ch).POWer.CENTer =5

Equivalent Softkeys Stimulus > Center

SCPI1.SOURce(Ch).POWer.LEVel.IMMediate. AMPL.itude

Object Type Property (read/write)
Data Type Double
Target Channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Description The power level for the frequency sweep.
Range from —60 to 10
Resolution 0.05
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Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCP1.SOURce(Ch).POWer.LEVel.IMMediate. AMPLitude

app.SCP1.SOURce(Ch).POWer.LEVel.IMMediate. AMPL.itude = 10

Equivalent Softkeys

Stimulus > Power > Power

SCPI1.SOURCce(Ch).POWer.LEVel.SLOPe.DATA

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The power slope value for the frequency sweep.
Range from-21t0 2
Resolution 0.1
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dB/GHz (decibel/gigahertz)
Dim Value As Double
Syntax Value = app.SCPI.SOURce(Ch).POWer.LEVel.SLOPe.DATA

app.SCPI.SOURce(Ch).POWer.LEVel.SLOPe.DATA = 0.2

Equivalent Softkeys

Stimulus > Power > Slope [dB/GHz]
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SCPI1.SOURce(Ch).POWer.LEVel.SLOPe.STATe

Object Type Property (read/write)
Data Type Boolean

Channel Ch,
Target

Ch:  channel number 1-16 (see Table 1 on page 25)

Description The ON/OFF state of the power slope for the frequency sweep.

True: Power slope ON

Allowable Values
False: Power slope OFF

Preset Value False

Dim Status As Boolean
Syntax Status = app.SCPI.SOURce(Ch).POWer.LEVel.SLOPe.STATe
app.SCP1.SOURce(Ch).POWer.LEVel.SLOPe.STATe = True

Equivalent Softkeys Stimulus > Power > Slope [ON/OFF]

SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire

Object Type Method

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)

Measures the power calibration data for the specified port using the power
meter controlled via USB or USB/GPIB. Calculates calibration coefficients on

Description ! .
w completion of the measurement, and turns ON the power correction for the
port.
Syntax app.SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire
Equivalent Softkeys Calibration > Power Calibration > Calibrate

SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.
LOSS.DATA
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Object Type Property (read/write)
Data Type Variant (array of double)
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The loss compensation table used during the power calibration.
The array size is 1+2N, where N is the number of the table rows.
For the n—th point, where n from 1 to N:
Descripti .
eseription Data(0) the number of the table rows N integer from 0 to 100;
Data(2n-1) the frequency of the n—th row of the table from 300 kHz
to 8.0 GHz;
Data(2n) the loss value of the n-th table row in dB.
Dim Data As Variant
Data =
Syntax
app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.DATA
app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.DATA = Data
Related Commands SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire
Equivalent Softkeys Calibration > Power Calibration > Loss Compen

SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.

LOSS.STATe
Object Type Property (read/write)
Data Type Boolean
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
Descrioti The ON/OFF state of the loss compensation function used during the power
escription . .
calibration.
True: Loss compensation ON
llowable Val -
Allowable Values False: Loss compensation OFF
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Preset Value

False

Syntax

Dim Status As Boolean

Status = app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.
LOSS.STATe

app.SCP1.SOURCce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.STATe =
True

Related Commands

SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.DATA

Equivalent Softkeys

Calibration > Power Calibration > Loss Compen > Compensation

SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.DATA

Object Type Property (read/write)
Data Type Variant (array of double)
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
The power correction table.
The array size is 1+2N, where N is the number of the table rows.
For the n-th point, where n from 1 to N:
Description Data(0) the number of the table rows N integer from 0 to 10001,
Data(2n-1) the frequency of the n—th row of the table from 100 kHz
to 8.0 GHz;
Data(2n) power correction value of the n—th row of the table from
-10to +10 dB.
Dim Data As Variant
Syntax Data = app.SCPI1.SOURCce(Ch).POWer.PORT(Pt).CORRection.DATA

app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.DATA = Data

Related Commands

SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire

Equivalent Softkeys

None

SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe
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Object Type Property (read/write)
Data Type Boolean
Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)
Pt: port number 1-4 (see Table 2 on page 25)
Description The ON/OFF state of the power correction function.

Allowable Values

True: Power correction ON
False: Power correction OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe
app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe = True

Related Commands

SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire

Equivalent Softkeys

Calibration > Power Calibration > Correction
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SCPI1.SOURce(Ch).POWer.PORT(Pt).LEVel.IMMediate. AMPL.itude

Object Type Property (read/write)
Data Type Double

Port Pt of channel Ch,
Target Ch:  channel number 1-16 (see Table 1 on page 25)

Pt: port number 1-4 (see Table 2 on page 25)

Description The individual power level of specified port (Pt) for the frequency sweep.
Range from —60 to 10
Resolution 0.05
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dBm (decibels above 1 milliwatt)
Dim Value As Double
Value =

Syntax

app.SCPI1.SOURce(Ch).POWer.PORT (Pt).LEVel.IMMediate. AMPL.itude
app.SCP1.SOURce(Ch).POWer.PORT(Pt).LEVel.IMMediate. AMPL.itude = 10

Equivalent Softkeys

Stimulus > Power > Port Power > Port x
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SCPI1.SOURce(Ch).POWer.PORT.COUPIe

Object Type Property (read/write)
Data Type Boolean
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The ON/OFF state of the port power couple function.

Allowable Values

True: port power couple ON
False: port power couple OFF

Preset Value

False

Syntax

Dim Status As Boolean
Status = app.SCP1.SOURce(Ch).POWer.PORT.COUPIe
app.SCP1.SOURce(Ch).POWer.PORT.COUPIe = True

Related Commands

SCP1.SOURCce(Ch).POWer.PORT (Pt).LEVel.IMMediate. AMPLitude

Equivalent Softkeys

Stimulus > Power > Port Couple

SCP1.SOURce(Ch).POWer.SPAN

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The power span for the power sweep.
Range from 0 to 70.
Resolution 0.05
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Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 70
Unit dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.SOURce(Ch).POWer.SPAN

app.SCP1.SOURce(Ch).POWer.SPAN = 50

Equivalent Softkeys

Stimulus > Span

SCPI1.SOURce(Ch).POWer.STARt

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The power sweep start for the power sweep.
Range from —60 to 10
Resolution 0.05
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

—60

Unit dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.SOURce(Ch).POWer.STARt

app.SCP1.SOURce(Ch).POWer.STARt =5

Equivalent Softkeys

Stimulus > Start
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SCP1.SOURce(Ch).POWer.STOP

Object Type Property (read/write)
Data Type Double
Target Channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Description The power sweep stop for the power sweep.
Range from —60 to 10
Resolution 0.05
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

10

Unit dBm (decibels above 1 milliwatt)
Dim Value As Double
Syntax Value = app.SCPI.SOURce(Ch).POWer.STOP

app.SCP1.SOURce(Ch).POWer.STOP =5

Equivalent Softkeys

Stimulus > Stop

SCPIL.STATus.OPERation.CONDition

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Operation Status Condition Register.
Dim Value As Long
Syntax

Value = app.SCPI1.STATus.OPERation.CONDition

Equivalent Softkeys

None
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SCPI.STATus.OPERation.ENABIe

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)
Description Operation Status Enable Register.

Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPI1.STATus.OPERation.ENABIe
app.SCPI1.STATus.OPERation.ENABIe = Value

Equivalent Softkeys

None

SCPIL.STATus.OPERation.EVENTt

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Operation Status Event Register.
Dim Value As Long
Syntax

Value = app.SCPI1.STATus.OPERation.EVENt

Equivalent Softkeys

None

SCPI.STATus.OPERation.NTRansition

Object Type

Property (read/write)
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Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Negative Transition Filter of the Operation Status Register.
Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPI.STATus.OPERation.NTRansition
app.SCPI1.STATus.OPERation.NTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.OPERation.PTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Positive Transition Filter of the Operation Status Register.
Range from 0 to 65535

Preset Value 65535

Syntax

Dim Value As Long
Value = app.SCPI.STATus.OPERation.PTRansition
app.SCPIL.STATus.OPERation.PTRansition = Value

Equivalent Softkeys

None

SCPIL.STATus.PRESet

Object Type

Method
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Target IEE488.2 Status Reporting System (Appendix 1)
Description Initialization of all registers.
Syntax app.SCPI1.STATus.PRESet

Equivalent Softkeys

None

SCPI.STATus.QUEStionable. CONDition

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Status Condition Register.
Dim Value As Long
Syntax

Value = app.SCPI.STATus.QUEStionable. CONDition

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.ENABIe

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Status Enable Register.

Range from 0O to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable. ENABIe
app.SCPIL.STATus.QUEStionable.ENABIe = Value
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Equivalent Softkeys

None

SCPI.STATus.QUEStionable. EVENt

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Status Event Register.
Dim Value As Long
Syntax

Value = app.SCPI.STATus.QUEStionable. EVENt

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.LIMit. CHANnNel(Ch).CONDition

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Descriotion Questionable Limit Channel Status Condition Register for channel Ch,
P Ch:  channel number 1-16 (see Table 1 on page 25)
Dim Value As Long
Syntax

Value = app.SCPI.STATus.QUEStionable.LIMit. CHANnel(Ch).CONDition

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.LIMit. CHANnel(Ch).ENABIe

Object Type

Property (read/write)

Data Type

Long
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Target IEE488.2 Status Reporting System (Appendix 1)

Description Questionable Limit Channel Status Enable Register for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Range from 0 to 65535

Preset Value

Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.LIMit. CHANnel(Ch).ENABIe
app.SCPIL.STATus.QUEStionable.LIMit. CHANnel(Ch).ENABIe = Value

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.LIMit. CHANnel(Ch).EVENt

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Limit Channel Status Event Register for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Dim Value As Long
Syntax
Value = app. SCP1.STATus.QUEStionable.LIMit. CHANnel(Ch).EVENt
Equivalent Softkeys None

SCPI.STATus.QUEStionable.LIMit. CHANnel(Ch).NTRansition

Object Type Property (read/write)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
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Negative Transition Filter of the Questionable Limit Channel Status Register

Description for channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)
Range from 0 to 65535
Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPIL.STATus.QUEStionable.LIMit. CHANnel(Ch).NTRansition
app.SCPIL.STATus.QUEStionable.LIMit. CHANnel(Ch).NTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.LIMit. CHANnel(Ch).PTRansition

Object Type Property (read/write)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)

Positive Transition Filter of the Questionable Limit Channel Status Register for
Description channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Range from 0 to 65535
Preset Value 65535

Syntax

Dim Value As Long
Value = app.SCPI.STATus.QUEStionable.LIMit. CHANnel(Ch).PTRansition
app.SCPI.STATus.QUEStionable.LIMit. CHANnel(Ch).PTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.LIMit.CONDition

Object Type

Property (read only)
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Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1).

Description Questionable Limit Status Condition Register.
Dim Value As Long

Syntax

Value = app.SCPIL.STATus.QUEStionable.LIMit.CONDition

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.LIMit.ENABIe

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Limit Status Enable Register.

Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.LIMit. ENABIle
app.SCPIL.STATus.QUEStionable.LIMit.ENABIe = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.LIMit.EVENt

Object Type Property (read only)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Limit Status Event Register.
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Syntax

Dim Value As Long
Value = app.SCPI.STATus.QUEStionable.LIMit.EVENt

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.LIMit.NTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Negative Transition Filter of the Questionable Limit Status Register.
Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPIL.STATus.QUEStionable.LIMit.NTRansition
app.SCPIL.STATus.QUEStionable.LIMit.NTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.LIMit.PTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Positive Transition Filter of the Questionable Limit Status Register.
Range from 0 to 65535

Preset Value 65535
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Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.LIMit.PTRansition
app.SCPIL.STATus.QUEStionable.LIMit.PTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.NTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Negative Transition Filter of the Questionable Status Register.
Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPI.STATus.QUEStionable.NTRansition
app.SCPIL.STATus.QUEStionable.NTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.PTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Positive Transition Filter of the Questionable Status Register.
Range from 0 to 65535

Preset Value 65535
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Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.PTRansition
app.SCPIL.STATus.QUEStionable.PTRansition = Value

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.RLIMit. CHANnNel(Ch).CONDition

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Ripple Limit Channel Status Condition Register for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Dim Value As Long
Syntax
Value = app.SCPI.STATus.QUEStionable.RLIMit. CHANnel(Ch).CONDition
Equivalent Softkeys None

SCPIL.STATus.QUEStionable.RLIMit. CHANnel(Ch).ENABIe

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Questionable Ripple Limit Channel Status Enable Register for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)

Range from 0 to 65535

Preset Value 0
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Syntax

Dim Value As Long
Value = app.SCPI.STATus.QUEStionable.RLIMit. CHANnNel(Ch).ENABIe
app.SCPI.STATus.QUEStionable.RLIMit. CHANnel(Ch).ENABIe = Value

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.RLIMit.CHANnNel(Ch).EVENt

Object Type Property (read only)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Ripple Limit Channel Status Event Register for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Dim Value As Long
Syntax
Value = app.SCPI.STATus.QUEStionable.RLIMit. CHANnel(Ch).EVENTt
Equivalent Softkeys None

SCPIL.STATus.QUEStionable.RLIMit.CHANnNel(Ch).NTRansition

Object Type Property (read/write)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)
Negative Transition Filter of the Questionable Ripple Limit Channel Status
Description Register for channel Ch,
Ch:  channel number 1-16 (see Table 1 on page 25)
Range from 0 to 65535
Preset Value 0
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Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.RLIMit. CHANnel(Ch).NTRansition
app.SCPI.STATus.QUEStionable.RLIMit. CHANnNel(Ch).NTRansition = Value

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.RLIMit.CHANnNel(Ch).PTRansition

Object Type Property (read/write)
Data Type Long
Target IEE488.2 Status Reporting System (Appendix 1)

Positive Transition Filter of the Questionable Ripple Limit Channel Status
Description Register for channel Ch,

Ch:  channel number 1-16 (see Table 1 on page 25)

Range from 0 to 65535
Preset Value 65535

Syntax

Dim Value As Long
Value = app.SCPI.STATus.QUEStionable.RLIMit. CHANnel(Ch).PTRansition
app.SCPI1.STATus.QUEStionable.RLIMit. CHANnNel(Ch).PTRansition = Value

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.RLIMit. CONDition

Object Type Property (read only)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Ripple Limit Status Condition Register.
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Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.RLIMit. CONDition

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.RLIMIit.ENABIe

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)
Description Questionable Ripple Limit Status Enable Register.
Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPIL.STATus.QUEStionable.RLIMit.ENABIe
app.SCPI1.STATus.QUEStionable.RLIMit.ENABIe = Value

Equivalent Softkeys

None

SCPIL.STATus.QUEStionable.RLIMit.EVENt

Object Type Property (read only)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Questionable Ripple Limit Status Event Register.
Dim Value As Long

Syntax

Value = app.SCPI1.STATus.QUEStionable.RLIMit.EVENt

Equivalent Softkeys

None
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SCPI.STATus.QUEStionable.RLIMit.NTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Negative Transition Filter of the Questionable Ripple Limit Status Register.
Range from 0 to 65535

Preset Value 0

Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.RLIMit.NTRansition
app.SCPIL.STATus.QUEStionable.RLIMit.NTRansition = Value

Equivalent Softkeys

None

SCPI.STATus.QUEStionable.RLIMIit.PTRansition

Object Type Property (read/write)

Data Type Long

Target IEE488.2 Status Reporting System (Appendix 1)

Description Positive Transition Filter of the Questionable Ripple Limit Status Register.
Range from 0 to 65535

Preset Value 65535

Syntax

Dim Value As Long
Value = app.SCPI1.STATus.QUEStionable.RLIMit.PTRansition
app.SCPIL.STATus.QUEStionable.RLIMit.PTRansition = Value

Equivalent Softkeys

None
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SCPI1.SYSTem.BEEPer.COMPIlete.IMMediate

Object Type Method

Target Instrument

Description Generates a beep to notify of the completion of the operation.
Syntax app.SCPI.SYSTem.BEEPer.COMPlete.IMMediate

Equivalent Softkeys

System > Misc Setup > Beeper > Test Beep Complete

SCPI1.SYSTem.BEEPer.COMPIlete.STATe

Object Type Property (read/write)

Data Type Boolean

Target Instrument

Description The ON/OFF state of the beeper notifying of the completion of the operation.

Allowable Values

True: Completion beeper ON
False: Completion beeper OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCPI.SYSTem.BEEPer.COMPIlete.STATe
app.SCPI1.SYSTem.BEEPer.COMPlete.STATe = False

Equivalent Softkeys

System > Misc Setup > Beeper > Beep complete

SCPI1.SYSTem.BEEPer. WARNing.IMMediate

Object Type

Method

Target

Instrument
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Description Generates a beep to notify of warning.

Syntax app.SCPI.SYSTem.BEEPer WARNIng.IMMediate

Equivalent Softkeys System > Misc Setup > Beeper > Test Beep Warning

SCPL.SYSTem.BEEPer WARNINg.STATe

Object Type Property (read/write)

Data Type Boolean

Target Instrument

Description The ON/OFF state of the beeper notifying of warning.

True: Warning beeper ON
False: Warning beeper OFF

Allowable Values

Preset Value True

Dim Status As Boolean
Syntax Status = app.SCP1.SYSTem.BEEPer. WARNIing.STATe
app.SCPI.SYSTem.BEEPer. WARNIing.STATe = False

Equivalent Softkeys System > Misc Setup > Beeper > Beep Warning

SCPL.SYSTem.COMMunicate.ECAL. TEMPerature.SENSor

Object Type Property (read only)

Data Type Double

Target AutoCal module

Description Reads out the temperature of the AutoCal module connected to the instrument.
Unit °C (Celsius)
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Syntax

Dim Value As Double
Value = app.SCPIL.SYSTem.COMMunicate. ECAL. TEMPerature.SENSor

Equivalent Softkeys

None
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SCPI1.SYSTem.COMMunicate. ECAL.IMPedance(Pt)

Object Type Property (read/write)
Data Type String
Target AutoCal module
- Sets or reads out the impedance state of the specified port (Pt) of AutoCal
Description .
module connected to the instrument.
"OPEN" : OPEN impedance state
Range "SHORt" : SHORT impedance state

"LOAD" : LOAD impedance state

Preset Value

n LOADII

Syntax

Dim Param As String
Param = app.SCPL.SYSTem.COMMunicate. ECAL.IMPedance(Pt)
app.SCPIL.SYSTem.COMMunicate. ECAL.IMPedance(Pt) = "OPEN"

Equivalent Softkeys

None

SCPL.SYSTem.COMMunicate. ECAL. THRU(Pt1, Pt2)

Object Type Method

Target AutoCal module

Descriotion Sets the thru state between the specified 2 ports (Pt1, Ptr2) of AutoCal module
P connected to the instrument.

Syntax app.SCPI.SYSTem.COMMunicate. ECAL.THRU(1, 2)

Equivalent Softkeys None
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SCPI1.SYSTem.CORRection.STATe

Object Type Property (read/write)

Data Type Boolean

Target Instrument

Description The ON/OFF state of the system error correction.

Allowable Values

True: System error correction ON
False: System error correction OFF

Preset Value

True

Syntax

Dim Status As Boolean
Status = app.SCP1.SYSTem.CORRection.STATe
app.SCPIL.SYSTem.CORRection.STATe = False

Equivalent Softkeys

System > Misc Setup > System Correction

SCPL.SYSTem.DATE

Object Type Property (read/write)
Data Type Variant (array of long)
Target Instrument
The current date.
The array consists of three elements:
Description Data(0) year from 1900 to 2100;
Data(1) month from 1 to 12;
Data(2) day from 1 to 31.
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Syntax

Dim Data As Variant
Data = app.SCP1.SYSTem.DATE
app. app.SCPL.SYSTem.DATE = Array(2009, 9, 9)

Equivalent Softkeys None
SCP1.SYSTem.HIDE
Object Type Method
Target Instrument GUI
Description Hides the instrument GUI.
Syntax app.SCPL.SYSTem.HIDE

Related Commands

SCPI.SYSTem.SHOW

Equivalent Softkeys

None
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SCPI1.SYSTem.LOCal

Object Type Method

Target Instrument

Description Sets the instrument to the local operation mode, when all the keys on the front
panel, mouse and the touch screen are active.

Syntax app.SCPI.SYSTem.LOCal

Related Commands

SCPI.SYSTem.REMote
SCP1.SYSTem.RWLock

Equivalent Softkeys None
SCPIL.SYSTem.PRESet
Object Type Method
Target Instrument
Resets the instrument to the factory settings. The difference from the
Description SCPI.IEEE4882.RST: method is that the trigger is set to the Continuous trigger
mode.
Syntax app.SCP1.SYSTem.PRESet

Equivalent Softkeys

System > Preset > OK
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SCPI1.SYSTem.REMote

Object Type Method
Target Instrument
Sets the instrument to the remote operation mode, when all the keys on the
- front panel, mouse and the touch screen are not active, except for one key
Description . . . .
labeled Return to Local. Pushing this button will reset the instrument to the
local operation mode.
Syntax app.SCPI1.SYSTem.REMote

Related Commands

SCPI1.SYSTem.LOCal
SCPI1.SYSTem.RWLock

Equivalent Softkeys None
SCPIL.SYSTem.RWLock
Object Type Method
Target Instrument
Sets the instrument to the remote operation mode, when all the keys on the
Description front panel, mouse and the touch screen are not active. Only
SCPI1.SYSTem.LOCal or SCP1.SYSTem.REMote command can release this remote
operation mode.
Syntax app.SCPL.SYSTem.RWLock

Related Commands

SCP1.SYSTem.LOCal
SCPI1.SYSTem.REMote

Equivalent Softkeys

None
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SCPIL.SYSTem.SHOW

Object Type Method

Target Instrument GUI

Description Shows the instrument GUI hidden by the SCP1.SYSTem.HIDE command.
Syntax app.SCPL.SYSTem.SHOW

Related Commands

SCPI.SYSTem.HIDE

Equivalent Softkeys

None

SCPL.SYSTem. TEMPerature.SENSor(l1dx)

Object Type Property (read only)
Data Type Double
Target Instrument
Description Reads out the specified sensor (Idx) temperature inside the instrument.
Unit °C (Celsius)
Dim Value As Double
Syntax

Value = app.SCPIL.SYSTem.TEMPerature.SENSor(1)

Equivalent Softkeys

None
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SCPI1.SYSTem. TERMinate

Object Type Method

Target Instrument GUI

Description Terminates the application.
Syntax app.SCPI.SYSTem. TERMinate

Equivalent Softkeys None
SCPL.SYSTem. TIME
Object Type Property (read/write)
Data Type Variant (array of long)
Target Instrument
The current time.
The array consists of three elements:
Description Data(0) hours from 0 to 23;
Data(1) minutes from 0 to 59;
Data(2) seconds from 0 to 59.
Dim Data As Variant
Syntax Data =app.SCPL.SYSTem.TIME

app. app.SCPL.SYSTem.TIME = Array(15, 20, 30)

Equivalent Softkeys

None

SCPIL. TRIGger.SEQuence.IMMediate

Object Type

Method
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Target Instrument
Generates a trigger, independently of the trigger source setting (except for the
External). If the trigger source is set to External, an error occurs (error code
221) and the command is ignored.

Description If the instrument is not in the waiting for a trigger state (sweep is in progress or
all the channels are set to Hold), an error occurs (error code 211) and the
command is ignored.

The method returns control before the end of the sweep.

Syntax app.SCPI.TRIGger.SEQuence.IMMediate

Related Commands

SCPIL.TRIGger.SEQuence.SOURce
SCPLINITiate(Ch).CONTinuous
SCPLINITiate(Ch).IMMediate

Equivalent Softkeys

None
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SCPIL.TRIGger.SEQuence.SINGle

Object Type Method

Target Instrument
Generates a trigger, independently of the trigger source setting (except for the
External). If the trigger source is set to External, an error occurs (error code
221) and the command is ignored.

o If the instrument is not in the waiting for a trigger state (sweep is in progress or

Description all the channels are set to Hold), an error occurs (error code 211) and the
command is ignored.
The method does not return control before the end of the sweep (waiting for the
completion of the sweep of all the channels).

Syntax app.SCPL.TRIGger.SEQuence.SINGle

Related Commands

SCPIL.TRIGger.SEQuence.SOURCce
SCPI.INITiate(Ch).CONTinuous
SCPLINITiate(Ch).IMMediate

Equivalent Softkeys

None

SCPIL.TRIGger.SEQuence.SOURce

Object Type Property (read/write)

Data Type String

Target Instrument

Description Selects the sweep trigger source.
"INTernal" : Internal
"EXTernal" : External

R

ange "MANual" : Manual
"BUS" . Bus
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Notes

The short format of the parameter is indicated by upper case letters. There is no
distinction between upper and lower case letters when the property is written.
When the property is read out, the short format is indicated by upper case
letters.

Out of Range

An error occurs. Error code: 205.

Preset Value

"INT™

Syntax

Dim Param As String
Param = app.SCPI.TRIGger.SEQuence.SOURce
app.SCPIL.TRIGger.SEQuence.SOURce = "BUS"

Related Commands

SCPI.TRIGger.SEQuence.IMMediate
SCPI.TRIGger.SEQuence.SINGle
SCPI.IEEE4882.TRG

Equivalent Softkeys

Stimulus > Trigger > Trigger Source > Internal | External | Manual | Bus
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Questionable Status Enable Register
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Appendix 1. IEE488.2 Status Reporting System

T14

TlS

le

Tll

T10

Tg

Ts

T7

TG

Ts

T4

Ta

Tz

Tl

Chan14 | Chan13 | Chan12 | Chan11l | Chan 10 Chan 9 Chan 8 Chan7 Chan 6 Chan 5 Chan 4 Chan 3 Chan 2 Chan 1
Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple
Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL

16384

&

Questionable Ripple Limit Status Enable
Register
STAT:QUES:RLIM:ENAB

Questionable Ripple Limit Status Event
Register
STAT:QUES:RLIM?

Positive Transition Filter
STAT:QUES:RLIM:PTR

Negative Transition Filter
STAT:QUES:RLIM:NTR

Questionable Ripple Limit Status
Condition Register
STAT:QUES:RLIM:COND?



Tls T14

TlB

le

Tll

TlO

Tg

Ts

T7

Te

Ts

T4

Ts

Tz

Tl

Trace 14 | Trace 13 | Trace 12 | Trace 11 | Trace 10 | Trace 9 Trace 8 Trace 7 Trace 6 Trace 5 Trace 4 Trace 3 Trace 2 Trace 1
Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple
Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL

16384 8192 4096 2048 1024 512 256 128 64 32 16 8 4 2

Tls T14

Tl3

le

Tll

T1o

Tg

Ts

T7

Ts

Ts

T4

Ta

Tz

Tl

Trace 14 | Trace 13 | Trace 12 | Trace 11 | Trace 10 | Trace 9 Trace 8 Trace 7 Trace 6 Trace 5 Trace 4 Trace 3 Trace 2 Trace 1
Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple Ripple
Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL | Test FAIL

16384 8192 4096 2048 1024 512 256 128 64 32 16 8 4 2

Appendix 1. IEE488.2 Status Reporting System

Questionable Ripple Limit Channel 1
Status Enable Register
STAT:QUES:RLIM:CHAN1:ENAB

Questionable Ripple Limit Channel 1
Status Event Register
STAT:QUES:CHAN1:RLIM?

Positive Transition Filter
STAT:QUES:RLIM:CHAN1:PTR

Negative Transition Filter
STAT:QUES:RLIM:CHAN1:NTR

Questionable Ripple Limit Channel 1
Status Condition Register
STAT:QUES:RLIM:CHAN1:COND?

Questionable Ripple Limit Channel 14
Status Enable Register
STAT:QUES:RLIM:CHAN14:ENAB

Questionable Ripple Limit Channel 14
Status Event Register
STAT:QUES:CHAN14:RLIM:?

Positive Transition Filter
STAT:QUES:RLIM:CHAN14:PTR

Negative Transition Filter
STAT:QUES:RLIM:CHAN14:NTR

Questionable Ripple Limit Channel 14
Status Condition Register
STAT:QUES:RLIM:CHAN14:COND?



Appendix 2. Error Codes

114 "Header suffix out of range"
200 "Execution error"

211 "Trigger ignored"

213 "Init ignored"

220 "Parameter Error"

222 "Data out of range™

224 "lllegal parameter value™

201 "Invalid channel index"

202 "Invalid trace index"

203 "Invalid marker index"

204 "Marker is not active”

205 "Invalid save type specifier"”
206 "Invalid sweep type specifier”
207 "Invalid trigger source specifier"
208 "Invalid measurement parameter specifier"
209 "Invalid format specifier"”

210 "Invalid data math specifier"
214 "Invalid limit data"

215 "Invalid segment data"

216 "Invalid standard type specifier"
217 "Invalid conversion specifier"
218 "Invalid gating shape specifier"
219 "Invalid gating type specifier"”
300 "Device-specific error"

302 ""Status reporting system error"
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Appendix 3. Programming Examples

Example 1. Instrument Information String Readout

The following program reads out and displays on the screen the instrument information
string — the Name property of the COM object. The string contains the following fields:

Manufacturer, Model, Serial Number, Software Version/Firmware Version
For example:
CMT, S8081, 09381020, 1.01/01

Dim app As Object

Sub Examplel()

Set app = CreateObject("S8081.Application")
ID = app.Name

MsgBox (*Information string read out: " + ID)
End Sub

297



Example 2. Checking the Instrument Ready State

Normally, the user control program starts when the analyzer executable module is
running, the instrument booting is completed, and the instrument is ready for use. In
some cases, it is recommended to check if the instrument is ready for use. The instrument
may be not ready for use if it is not connected to PC via USB cable. Moreover, if the
analyzer executable module has not been started in advance, the CreateObject function
will automatically start the application and then within about 10 seconds the instrument
booting will be in progress. The instrument will not be ready for use until the booting is
completed. The Ready property is used to check if the instrument is ready for use.

The following program checks the Ready property right after a COM object has been
created. If the analyzer executable module has been started in advance and the booting is
completed, “Analyzer is ready” will be displayed. If the Ready property value is False,
10 second delay is activated for the case the analyzer executable module has been started
by the COM object creation. In 10 seconds the program rechecks the Ready property. If
the value is True, “Analyzer is ready” will be displayed, if otherwise, “Analyzer is not
ready” will be displayed, what means the instrument is not turned on or it is not
connected to PC via USB cable.

Dim app As Object
Sub Example2()
Set app = CreateObject("S8081.Application™)
If app.READYy = False Then
Application.Wait (Now + TimeValue("'0:00:10"))
If app.READy = False Then
MsgBox (*Analyzer is not ready")
Exit Sub
End If
End If
MsgBox ("Analyzer is ready")
End Sub
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Example 3. Setting the Measurement Parameters

The following program shows the setting of some measurement parameters. First, the
instrument is reset to the factory settings. Then the following parameters are set:

e Two channel windows are opened and allocated one above the other.

e The number of traces is set to 2 in the first channel window, the traces are allocated in
different graphs in the channel window.

e For the first channel the stimulus parameters are set as follows: the frequency range
from 1 MHz to 2 GHz, the number of measurement points 401.

e For the second channel the stimulus parameters are set as follows: the frequency range
from 800 MHz to 900 MHz, the number of points 51, IF bandwidth 100 Hz, stimulus
power —10 dBm.

e |n the first channel window: S11 measurement is set for the trace 1, S22 measurement
is set for the trace 2. The Smith chart format is set for the both traces.

e In the second channel window: S21 measurement and logarithmic magnitude format
are set for the single trace. Then the auto scale function is called for this trace.

Dim app As Object

Public Sub Example3()
Set app = CreateObject("S8081.Application™)

app.SCPI.SYSTem.PRESet

app.SCPI.DISPlay.Split = 2
app.SCPI.Calculate(1).Parameter.Count = 2
app.SCPI.DISPlay.Window(1).Split = 3

app.SCPI.SENSe(1).Frequency.Start = 100000
app.SCPI.SENSe(1).Frequency.STOP = 2000000000
app.SCPI.SENSe(1).SWEep.Points = 401

app.SCPI.SENSe(2).Frequency.Start = 800000000
app.SCPI.SENSe(2).Frequency.STOP = 900000000
app.SCPI.SENSe(2).SWEep.Points = 51
app.SCPI.SENSe(2).BANDwidth.RESolution = 100
app.SCPI.Source(2).Power.LEVel.IMMediate. AMPlitude = -10

app.SCPI.Calculate(1).Parameter(1).DEFine = "S11"
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app.SCPI.Calculate(1).Parameter(2).DEFine = "S22"
app.SCPI.Calculate(1).Parameter(1).Select
app.SCPI.Calculate(1).Selected.Format = "SMIT"
app.SCPI.Calculate(1).Parameter(2).Select
app.SCPI.Calculate(1).Selected.Format = "SMIT"

app.SCPI.Calculate(2).Parameter(1).DEFine = "S21*"
app.SCPI.Calculate(2).Parameter(1).Select
app.SCPI.Calculate(2).Selected.Format = "MLOG"

app.SCPI.DISPlay.Window(2). TRACe(1).Y.SCALe.AUTO

End Sub
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Example 4. Measurement Data Acquisition

The following program shows data array acquisition with further writing into a file. The
program also shows the method of a sweep triggering and waiting for the sweep
completion.

Three variables F, M, P are declared in the second string of the code. They are used for
arrays of frequency values (Hz), magnitude values (dB), and phase values (degree)
respectively.

After the instrument has been reset to the factory settings, two operators are used for the
sweep triggering and waiting for the sweep completion:

app.SCPIL.TRIGger.SEQuence.Source = "bus"
app.SCPIL.TRIGger.SEQuence.Single

The first operator sets the GPIB/LAN bus command or the COM/DCOM interface
command as a trigger source. It aborts the sweep and switches the instrument to waiting
for a trigger. The second operator is used for a new sweep triggering and waiting for the
sweep completion.

Note Unlike  the  SCPLTRIGger.SEQuence.IMMediate  and
SCPILIEEE4882.TRG commands, which are completed
immediately after a trigger generation, the
SCPL.TRIGger.SEQuence.Single command is not completed
until  the  end of the  sweep. Using  the
SCPL.TRIGger.SEQuence.Single command is the simplest way
to set the waiting for the sweep completion.

On completion of the sweep, three arrays are read out: frequency values, magnitude
values and phase values. Before the magnitude and phase arrays are read out, the
corresponding trace format is set.

The array size of frequency F is equal to the number of measurement points, and the
array size of magnitude M and phase P is equal to the double number of measurement
points (see section 11 “Measurement Data Arrays”). In rectangular formats (for
magnitude and phase) the measurement data are real numbers located in even cells of the
array. Odd cells of the array contain 0.

On completion of the program, the frequency, magnitude and phase values for each
measurement point are written string by string into the file named TESTFILE.
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Dim app As Object
Dim app As Object
DimF, M, P

Public Sub Example4()
Set app = CreateObject("S8081.Application")

app.SCP1.SYSTem.PRESet

app.SCPI.TRIGger.SEQuence.Source = "bus"
app.SCPI.TRIGger.SEQuence.Single

F = app.SCPI1.SENSe.Frequency.Data

app.SCPI.Calculate.Selected.Format = "MLOG"
M = app.SCPI.Calculate.Selected.Data.FDATa

app.SCPI.Calculate.Selected.Format = "PHASe"
P = app.SCPI.Calculate.Selected.Data.FDATa

Open "TESTFILE" For Output As #1
For i = LBound(F) To UBound(F)
Print #1, F(i), M(i * 2), P(i * 2)

Next i

Close #1
End Sub
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Example 5. Program Written in C++

The following C++ program represents an example of the measurement parameter
setting, as well as acquisition and display of the measurement data array. The program

also shows a method of the sweep triggering and waiting for the sweep completion.

Il
/I Simple example of using COM object of S8081.exe application.

I

/I This example is console application. GUI is not used in this example to
/I simplify the program. Error proccessing is very restricted too.

I

#include "stdafx.h"

1l
/I Generate description of COM object of S8081.exe application.
#import "S8081.exe" no_namespace

I
int _tmain(int argc, _TCHAR™* argv[])
{

1S8081Ptr pNWA,; /I Pointer to COM object of S8081.exe
CComVariant Data; /I Variable for measurement data

/I Init COM subsystem
HRESULT hr = Colnitialize(NULL);
if(hr 1= S_OK) return -1;

/I Create COM object
hr = pNWA.Createlnstance(__uuidof(S8081));
if(hr 1= S_OK) return -1;

/I Preset network analyzer

pNWA->SCPI->SYSTem->PRESet();

/I Set frequency start to 1 GHz
pPNWA->SCPI->GetSENSe(1)->FREQuency->STARt = 1e9;

/I Set frequency stop to 2 GHz
pPNWA->SCPI->GetSENSe(1)->FREQuency->STOP = 2¢e9;

/I Set number of measurement points to 51
pNWA->SCPI->GetSENSe(1)->SWEep->POINts = 51;

/I Set measured parameter to S21

pNWA->SCPI->GetCAL Culate(1)->GetPARameter(1)->DEFine = "S21";
/I Set trigger source to GPIB/LAN bus or COM interface
pNWA->SCPI->TRIGger->SEQuence->SOURce = "bus";

/I Trigger measurement and wait
pNWA->SCPI->TRIGger->SEQuence->SINGle();

/I Get measurement data (array of complex numbers)

Data = pPNWA->SCPI->GetCALCulate(1)->SELected->DATA->FDATg;

/I Display measurement data.
/I Data is array of NOP * 2 (number of measurement points).
/I Where n is an integer between 0 and NOP - 1.

/I Data(n*2) : Primary value at the n-th measurement point.
/I Data(n*2+1) : Secondary value at the n-th measurement point. Always 0
1l when the data format is not the Smith chart or the polar.

CComSafeArray<double> mSafeArray;
if (mSafeArray.Attach(Data.parray) == S_OK)

for (unsigned int n = 0; n < mSafeArray.GetCount() / 2; ++n)

{
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Example 6. Program Written in LabView

The following LabView program represents an example of the measurement
parameter setting, as well as acquisition and display of the measurement data array.
The program also shows a method of the sweep triggering and waiting for the
sweep completion.

Below see the block diagram of the program and the front panel of the program
with the program execution result.

The front panel contains the entry field for the instrument network name or IP
address. This field is used to control the instrument with DCOM technology from a
remote PC, on which the LabView package is executed. This example can also be
used on a single PC running the instrument program In this case leave this field
empty.

The user must enter the instrument name in the entry field and click the “Run”
button. As the result of the program, the instrument information string will be
displayed and the measurement trace of transmission coefficient will be plotted.
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B Example6.vi Front Panel *
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